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Implementation Tools:
Implementation Project
SAP Business One Version 9.3

PUBLIC

▪ This topic covers the implementation project for a new SAP Business One installation.
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Objectives

Objectives:
▪

Explain the advantages of a project methodology

▪

List the key activities in an implementation project

▪

Describe the tools and templates provided with SAP’s AIP methodology

▪

Use and customize the embedded project plans in SAP Business One
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On completion of this topic, you will be able to:
▪

Explain the advantages of a project methodology

▪

List the key activities in an implementation project

▪

Describe the tools and templates provided with SAP’s AIP methodology

▪

Use and customize the embedded project plans in SAP Business One
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Business Example
It’s more than just installing the software. . .
A successful SAP Business One
implementation involves careful planning and
execution
How do you move from a sales contract with a
list of customer requirements to a success
story?
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▪ It’s more than just installing the software. . . In fact that part is usually the easiest part of the
implementation.
▪ As an implementation consultant, you usually get involved at the closure
of the sales cycle. Therefore it is important that you get a thorough background to the customer
from the sales team, including the customer’s goals, concerns and overall business processes.
▪ SAP provides many resources to help you, including a structured methodology for implementations.
This methodology is based on the practical experiences of SAP and many implementation partners.
Within this methodology, you will find project plans, as well as tools and documents to help you be
successful.
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Quiz
What strategies can you use to be successful in an implementation project? Review the list and identify one or
more strategies that you would use to increase your chances of success.
 Leverage SAP’s experience
 Leverage the expertise of other partners
 Use a detailed project plan to ensure all necessary tasks are completed
 Set and manage the customer expectations
 Thoroughly understand the requirements and scope of the project
 Have a change management process
 Involve the customer in major project decisions
 Assess and mitigate risk continually during the project

6
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What strategies can you use to be successful in an implementation project?
Take a few moments to review the list and identify one or more strategies that you would use to
increase your chances of success.
Would you:
 Leverage SAP’s experience?
 Leverage the expertize of other partners?
 Use a detailed project plan to ensure all necessary tasks are completed?
 Set and manage the customer expectations?
 Thoroughly understand the requirements and scope of the project?
 Have a change management process?
 Involve the customer in major project decisions?
 Assess and mitigate risk continually during the project?
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Quiz
What strategies can you use to be successful in an implementation project?
 Leverage SAP’s experience
 Leverage the expertise of other partners
 Use a detailed project plan to ensure all necessary tasks are completed
 Set and manage the customer expectations
 Thoroughly understand the requirements and scope of the project
 Have a change management process
 Involve the customer in major project decisions
 Assess and mitigate risk continually during the project
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▪ All the strategies marked will increase the success of an implementation project.
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Implementation Consultant Role - Responsibilities

Project
Management

Business Process

Technical

▪ Build relationship with customer
▪ Manage expectations and scope during
implementation
▪ Train end users
▪ Analysis of customer’s existing business
processes
▪ Map/fit to SAP Business One configuration
▪ Identify and scope custom software and reports

▪ Identify and migrate legacy data
▪ Install SAP Business One in system landscape
▪ Setting up business processes and configuration in
SAP Business One
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An implementation project requires a diverse range of skills in addition to product knowledge:
• Project management and managing customer relationships and expectations
• Training for end users
• Analyzing and mapping the customer’s business processes to a solution
• Identification and scoping of customer software and reports
• Technical skills such as migrating legacy data, and installing SAP Business One in the system
landscape
• Setting up the business processes (sales, purchasing, logistics, finance, reporting, etc.) and
configuration in SAP Business One
What do you consider is the most difficult part of the implementation consultant job?
Existing partners tell us that the most difficult tasks in the implementation are concerned with
analyzing the customer’s business processes and mapping them to an SAP Business One
configuration.
Partners also find that data migration is often a difficult task, since a knowledge of the database tables
is required and often the customer’s data does not map easily to SAP Business One. Data migration
often takes longer than expected.
Do not underestimate the time needed to collect and analyze customer business requirements. Allow
sufficient time during the sales process and during the implementation for these tasks.

Resources
Partner-specific Resources

General Information Sources

SAP PartnerEdge
▪

Information, training,
and assets for pre-sales,
sales, implementation,
and support

▪

S-user required

Learning Hub

Country-level support
and training

▪

Localization aspects

Learning Journeys (selfpaced learning for you and
your customers)

▪

No S-user required

SAP Community

Local Product Experts
▪

▪

▪

Forums for
implementation questions

▪

Blogs

▪

No S-user required

Partner Services Advisor
Support Launchpad
▪

Primary interface for
supporting customers

▪

Software download

▪

License request

▪

Point of contact for
contractual partnership with
SAP and onboarding

▪

Expert sessions

Help Portal
▪

How to guides and
product roadmaps

▪

No S-user required
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SAP provides various resources to help you. Going anti-clockwise they include:
•

The PartnerEdge portal (at https://partneredge.sap.com/en/products/business-one/implement.html)
is an information source for consultants. You need a user ID (the S-number), which authorizes you
to use most of the services on the portal. Every consultant should get a personal user ID. If you are
a new partner to SAP, and your organization has signed SAP’s partner agreement, you can request
a user ID on PartnerEdge.

•

Most countries have a country Local Product Expert who is an expert in the SAP Business One
product and the requirements of your localization. The LPE can assist with localization issues.

•

The support launchpad (https://launchpad.support.sap.com/) is your primary interface for supporting
customers after they have gone live. You can also download the software from this site, and request
license keys for users. You can also access the launchpad from PartnerEdge.

•

A Partner Service Advisory (PSA) organization provides you with a single point of contact for
contractual and partnership-related questions and for onboarding. The PSA also facilitates live and
recorded enablement sessions on a variety of topics.

•

The help portal is a single source for documentation such as how to guides, what’s new, product
roadmaps, license charts, etc. Visit help.sap.com and search for SAP Business One. This site is
also available to your customers.

•

The SAP Community (https://www.sap.com/community) is a source for blogs and Q&A on
implementation and technical topics. You can also ask a question or write a blog.

•

The Learning Hub publishes self-paced training (with case studies, simulations and assessments)
on SAP Business One. Both you and your customers can access the training for free. Registration
is required. To register or login, go to https://training.sap.com/businessone.

Project Team Roles and responsibilities

Project
Manager
(customer side)

Project Manger
(partner side)
Project management

Business
Consultant
(partner side)
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Technical
Consultant
(partner side)

Functional
Leads
(customer)

Super User
(customer)

System
Administrator
(customer, on
premise)

10

A typical small business project requires both a project manager from the partner side and a project
manager from the customer side.
Also from the partner side the tasks might be split between a business consultant and a technical
consultant:
• The business consultant runs the business process workshops and produces the Business
Blueprint
• The technical consultant installs and configures the system per the Business Blueprint
• The two roles might be performed by one person, or by multiple people
On the customer side, in addition to the project manager, the following roles are required for the
project:
• A functional lead representing each area, such as sales, purchasing, accounting, warehouse, etc.
The functional leads must attend the business process workshops and also perform the testing of
the business processes that they control
• A super user should be appointed from the customer. This person will be trained to perform
administrative functions on the new system in production, such as creating users, setting
authorizations. This person will receive training in all areas of SAP Business One.
• A technical person from the customer should be part of the project team (for on premise
systems).

Methodology
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Implementation Methodology
Business Value:
Project Phases and Milestones

▪

Proven project structure with
formal phases and milestones

▪

Adds change management and
project management controls

AIP methodology:

Project Plan
Project and change
management controls

▪

Recommended for SAP Business
One implementations as it is
based on the practical
experiences of SAP and many
partners

▪

Provides tools and templates for
business process analysis,
business blueprint, data
migration, etc.

▪

Download from PartnerEdge

SAP Best Practices, tools
and templates
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A methodology is more than just a project plan. It applies structure to a project by adding formal
phases, with milestones that must be achieved before the project can progress. It applies project
management and change management controls to a project.
Your partner organization may have its own methodology. If so, you should learn the methodology and
tools in use at your company.
SAP recommends the Accelerated Implementation Program (AIP) for SAP Business One
implementations, as it is specifically designed for small business installations (on premise and in the
cloud) and is based on the practical experiences of SAP and many partners.
The AIP methodology contains best practices, guides, tools and templates. The methodology and
materials are available for you to download from SAP PartnerEdge. All the tools and templates are
provided in Microsoft Word or Excel format and you can modify to your own requirements. The
flexibility to use all, or some of the methodology is up to you.
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AIP Implementation Methodology Phases
▪

Specifically designed for SAP Business One implementations

▪

Divides an implementation into five phases:

Project Phases
End of sales
cycle

Project
Preparation

Business
Blueprint

Project
Realization

Final
Preparation

Go-Live and
Support

Handover to
partner support

13
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▪ The AIP methodology divides an implementation project into five phases. These phases cover the
period starting with the handover from the sales team to right before the handover to the partner
support organization. The phases are:
1. Project Preparation. Get ready for the implementation project with the initial planning with the
sales team.
2. Business Blueprint. Business process analysis and mapping.
3. Project Realization. Configuration and customization of the customer’s company database.
4. Final Preparation. Get ready for the go-live.
5. Go-Live and Support. Make sure the customer’s new system is functioning as planned for a
predefined period before handing over the customer to your support team.
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At a Glance Key Activities Per Phase
Business
Blueprint

Project
Preparation
Handover from
sales

Review project plan

Create project plan

Gather business
requirements

Conduct kick-off
meeting

Perform fit/gap
analysis

Deliver and install
software

Create Business
Blueprint

Review project
phase

Review project
phase

Project
Realization
Plan organizational
change, training, data
migration
Install and configure
production system
Migrate data
Validation and system
testing
Plan for Go-Live
Review project phase

Final
Preparation
Finalize cutover plan

Go-Live and
Support
GoLive

Conduct user and
administrator
training

Resolve critical issues
post go-live
Handover
administration to
customer

Conduct system
readiness and GoLive check

Handover system to
SAP and partner
support

Cutover activities
and final balances

Project end

Review project
phase

Implement continuous
Improvement

Phase Sign-off
Change Management

GoLive

Project Management
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The methodology blends the key activities in a phase with change and project management.
•

•

•

•

•

Project Preparation: the focus is on providing a smooth transition from the sales cycle. The
implementation team may not have participated in the sales cycle, so it is important to have a
detailed handover from sales. The other focus is building a relationship with the customer. The
major deliverable is the software – the SAP Business One software is delivered and installed,
marking the contractual start of the project.
Business Blueprint: the focus is on mapping a solution to run the customer’s business processes.
Business process mapping might seem strange to have here (wasn’t that done during the sales
cycle?). What takes place in this phase is a detailed analysis of each of the customer’s business
processes and how they will be configured in the new system. This might require customization to
meet any gaps. The major deliverable is the Business Blueprint – the roadmap for the next phase.
The Business Blueprint documents the system configuration to support the business processes.
Project Realization: the system is configured and the data from the customer’s legacy system is
migrated over. This enables testing and validation using the customer’s own data. During this
stage you need to plan for the next stage: analyzing the need for training, and assessing how
ready the customer is for production deployment.
Final Preparation: the end users are trained and a decision is made to go-live. A readiness check
should contain a list of criteria that must be met before go-live. The end users should be fully
trained, the hardware and infrastructure in place, and operational procedures documented, and so
on. Right before the switch to production, final data is migrated over including the current balances
for the general ledger and the outstanding customer and vendor balances.
Go-live and Support: you monitor the new system and resolve any critical issues related to the
implementation, before officially “handing over” the customer to your support team.

Project Preparation Phase Milestones
Project
Preparation
Handover from
sales
Create project plan
Conduct kick-off
meeting
Deliver and install
software

Milestones:
 Project plan reviewed and agreed by
customer

Tools and Templates:

 Software installed at customer
(ideally with the demo database)
 Official sign-off for phase by
customer

Review project
phase

Best Practices:

Start

Project
kick-off
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GoLive
Time
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Let’s look at the individual phases in more detail.

In Project Preparation, key activities for an implementation consultant are to:
• Conduct a handover with the sales team
• Create an implementation project plan
• Attend the kick-off meeting (which should be organized by the sales team).
• Install the SAP Business One software (ideally with the demo database)
Note: The customer project manager and other key team members should have been appointed during
the sales cycle. The sales team has responsibility to ensure that the customer has staffed the project
team and that the project is supported by the company owner or sponsor.

The milestones which you can use to measure the success of this phase are:
▪ Project plan reviewed and agreed by customer
▪ Software installed at customer
▪ Official sign-off for this phase by the customer. This sign-off signifies that the customer agrees wit
the project plan and schedule.

Project Preparation Phase Best Practices, Tools and Templates
Project
Preparation
Milestones:
Handover from
sales

Tools and Templates:
•

Handover from Sales

Create project plan

•

Pre-Sales Business Analysis

Conduct kick-off
meeting

•

Software Delivery Receipt

•

Project Phase Analysis and Risk

•

Phase Sign-off

Deliver and install
software
Review project
phase

Best Practices:
•

Meet with sales team

•

Assess hardware and
infrastructure

•

Demo SAP Business One

•

Communicate time and effort:
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The recommended SAP best practices for this phase are:
▪

Meet with sales team before the kick-off meeting to understand the customer processes, goals, pain
points, unique requirements, risks or constraints (including major changes in the future or an
upcoming busy season that could jeopardize the project). You should ensure that customer
expectations set during the sales process are feasible and that product capabilities have not been
miscommunicated or oversold.
▪ Assess the hardware and infrastructure at the customer: this includes the server (for on premise)
and the network and desktop infrastructure. Doing this early allows time for upgrades to be ordered.
▪ Demo SAP Business One at the kick-off meeting, using the demo database: it is a good idea to
introduce the customer to SAP Business One as early as possible. You can even create master
data and documents in the demo database using the customer’s own business partners and
products. By demoing the product you give the customer team a visual understanding and the
opportunity to ask any nagging early questions.
▪ Clearly communicate the time and effort you require from the customer team. Often small
businesses have a hard time releasing staff to work on projects, but this is necessary for the
success of the project so should be addressed at the kick-off meeting. A functional lead should be
nominated from each business area (sales, purchasing, accounting, etc.).

Tools and templates you can leverage in this phase include:
▪

Handover from Sales Checklist and Pre-Sales Business Analysis for documenting the customer
goals and requirements
▪ Software Delivery Receipt to document the delivery of the software
▪ Phase Sign-off to acknowledge the completion of the phase
▪ Project Phase Analysis and Risk spreadsheet to assess and estimate project risk, based on a series

of answers that you supply.
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Business Blueprint Phase Milestones
Business
Blueprint

Milestones:
 Workshops completed and each business
process documented in the Business
Blueprint
 Project plan revised (if necessary) and
agreed with customer
 Official sign-off for this phase by the
customer.

Review project plan
Gather business
requirements
Perform fit/gap
analysis

Tools and Templates:

Create Business
Blueprint
Review project
phase

Best Practices:

Start

Project
kick-off

Business
process
analysis

GoLive
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Business Blueprint focuses on a detailed analysis of the customer’s business processes and
requirements. Your activities are to:
• Conduct business process requirements gathering workshops
• Map the processes to a solution and identify any gaps
• Complete a business blueprint, which documents how the system will be configured
SAP recommends you conduct requirements gathering workshop by process, for example:
• Sales
• Purchasing
• Inventory management
• Production and MRP
• Financials and accounting
• Service
• Banking
Since each customer is different, you may want to organize the workshops in other ways. Remember
to include master data and reporting in each workshop. The functional lead from the business area
should attend the relevant workshop, also someone from accounting. In the workshop you should ask
the functional leads to describe their existing process and operations. You can then demonstrate these
processes in the system. The milestones for this phase are:
•
•
•

Business process workshops completed and documented in the Business Blueprint
Project plan revised (if necessary) and agreed with customer
Official sign-off for this phase by the customer.

Business Blueprint Phase Best Practices, Tools and Templates
Business
Blueprint
Milestones:
Review project plan
Gather business
requirements
Perform fit/gap
analysis

Tools and Templates:
▪ Blueprint Process Questions

Create Business
Blueprint
Review project
phase

Start

Project
kick-off

Best Practices:

▪ Blueprint Configuration

•

Involve functional leads in business
requirements workshops

▪ Data Migration Assessment

•

Plan for overlaps and dependencies between
departments

▪ Project Phase Analysis and Risk

•

Identify the sources and volume of legacy data

•

Demo how business requirements can be met

•

Document all requirements

Business
process
analysis
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▪ Data Migration Guide
▪ Phase Sign-off

GoLive
Time
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The recommended SAP best practices for this phase are:
•

•
•

•
•

Conduct workshops with the customer functional leads from each business area or department. In
these workshops, you should analyze the detailed steps in each of the customers processes. In
addition to major processes such as sales, purchasing, and service, you should cover reporting and
financial processes.
When scheduling the different workshops, plan for overlaps and dependencies between
departments.
During the workshops, you should identify the sources and volume of the legacy data that needs to
be migrated.
Use SAP Business One during the workshops to demonstrate how business requirements can be
addressed by the system
Document all requirements in the Business Blueprint and make sure the customer understands that
this is the scope of the project

Tools and templates you can leverage in this phase include:
•

Blueprint Process Questions

•

Blueprint Configuration

•

Data Migration Assessment

•

Data Migration Guide

•

Phase Sign-off

•

Project Phase Analysis and Risk to review the phase and assess how well the project is going and if
any risks have materialized

Blueprint Process Questions

Blueprint Configuration

▪ List of generic questions for each business
process
▪ Use during requirements gathering workshops
to ascertain the details of each customer
business process

▪ Master document for the setup and
configuration changes needed in SAP
Business One to implement each business
process
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The Blueprint Process Questions and the Blueprint Configuration are key implementation documents
for SAP Business One.
Like all AIP documents they are provided as templates, and you can edit, extend and configure them
for your use.
These two documents work hand-in hand:
•
Use the business process questions during the requirements gathering workshops to ascertain
the details of each customer process. Be sure to add additional questions to cover extended
processes not covered in the list.
•
Use the information gathered from the detailed questions to document the required system
configuration and settings in the blueprint configuration document. capture the required setup and
configuration changes needed to implement the business process. You can use the blueprint
document as a checklist when making the setup and configuration changes in the company
database. At the end of the project, provide a copy of this completed document to your support
organization.
Questions are listed for each business process. try to use the customer’s terminology, not SAP
Business One terminology.
You should record the setup and configuration changes needed for each process.
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Project Realization Phase Milestones
Project
Realization

Milestones:
 Production system configured and
customized to run business processes

Tools and Templates:

 Legacy data migrated

Plan organizational
change, training, data
migration

 Customer completes validation of system
 No outstanding issues from testing

Install and configure
production system

 Training plan with timing and resources
agreed by customer

Migrate data
Validation and system
testing
Plan for Go-Live
Review project phase

Start

Project
kick-off

Best Practices:

Business
process
analysis

Configure
company

Test and
validation

GoLive
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Project Realization is the heart of the project. The milestones for this phase are:
•

Production system configured and customized to run business processes. After the configuration is
complete you should make a copy of the production database that can be used for testing and
training.

•

Legacy data migrated

•

Customer completes validation of system. You should carefully plan the test cases with the
customer. Test cases should cover not just the business process within SAP Business One but the
end to end process including external system interfaces. The customer should ensure that test
plans cover all test cases. The test cases supplied with the AIP can be used as a base for
developing procedures for system testing.

•

No outstanding issues from testing

•

Training plan with timing and resources agreed by customer. During this phase the consultant
should plan the training of end users. The training will occur in the next phase, but you should get a
commitment from the customer now for users’ time to attend training. The training might be
delivered by the consultant, or by the customer, depending on the contract. The Training Guide in
the AIP materials provides tips and guidelines for end user training.

Note: There may be a need for change management during this phase, since many users will be using
the system for the first time and there could be a reassignment of roles or duties.

Project Realization Phase Best Practices, Tools and Templates
Project
Realization
Milestones:

Tools and Templates:

Plan organizational
change, training, data
migration
Install and configure
production system
Migrate data
Validation and system
testing
Plan for Go-Live

Best Practices:

Tools and Templates:
▪ Blueprint Configuration

•

Early on, encourage end users to use the new
system to get comfortable and involve functional
leads during system configuration

•

Address data quality issues before migration

▪ Issue Log

•

Make a copy of the newly-built production database
for testing and training purposes

▪ Change Request Form

•

Encourage customer to write operational procedures

▪ Project Phase Analysis and Risk

•

Print output documents from testing

▪ Phase Sign-off

•

Control changes and scope creep

Review project phase

▪ Data Migration Guide
▪ Test cases

▪ Training Guide
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The best practices are:
•

Early on, encourage end users to log into the new system and practice their own work to get a
comfort level. Involve customer functional leads during the configuration of the new system in order
to make them feel part of the process.

•

Address the issue of data quality and integrity with the customer. Unless otherwise agreed, it is
normally the customer’s responsibility to “clean up” the legacy data before migration, and the
consultant is only responsible for the actual migration.

•

After you have configured the production system, make a copy of the database, and use this copy
for system validation and system testing and for training.

•

Encourage the customer to create operational procedures now. It is much easier to create these at
the same time that the business processes are being validated. And they can also be used and
proofed during system testing.

•

Print a copy of all output documents, i.e., invoices, purchase orders, reports, etc., and financial
statements and have the customer sign off upon acceptance

•

During the customer validation there is the possibility of changes to scope. Make sure you
document all requested changes and discuss with the customer any impact on the project scope
and costs. The project plan should be updated to reflect any change of scope or timeline.

Tools and templates you can leverage in this phase include:
•
•
•
•
•
•

Blueprint Configuration and Data Migration Guide from the previous phase
Test Cases
Issue Log
Change Request Form
Training Guide
Phase Sign-off and Project Phase Analysis and Risk

Data Migration Guide

▪

Structured approach to data migration
during an implementation project and
step-by-step instructions for opening
balances

Project Phase Analysis and Risk

▪

Questions to assess and evaluate
project risk
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The Data Migration Guide gives you a step-by-step approach to importing legacy data including a
recommended order for data migration and opening balances.
The Project Phase Analysis and Risk spreadsheet contains questions to assess project risk during
each phase of the implementation project. You can evaluate overall risk by entering the likely risk for
each question.
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Final Preparation Phase Milestones
Final
Preparation
Milestones:

Tools and Templates:

 End users trained and able to use the
system to perform their jobs

Finalize cutover plan

 System readiness for “go-live” confirmed

Conduct user and
administrator
training

 Cutover activities completed
 Phase sign-off

Conduct system
readiness and GoLive check
Cutover activities
and final balances
Review project
phase

Start

Project
kick-off

Best Practices:

Business
process
analysis
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Configure
company

Test and
validation

End user
training

Cutover

GoLive
Time
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The goal of Final Preparation is to bring the newly configured system, along with the infrastructure and
the users, to the point where it can be switched to production use. This phase ends with the switch to
production from the legacy system to SAP Business One.
The milestones are:
• End users trained and able to use the system to perform their jobs
• System readiness for “go-live” is confirmed and a go-live data agreed with customer. The readiness
check should include criteria that must be met before go-live. All remaining critical open issues must
be resolved, the hardware and infrastructure must be in place, and operational procedures
documented.
• Cutover activities completed before the switch to production, The cutover period happens just
before go-live, when many activities must take place in the correct sequence and in a very short
timeframe, so that the new system can fully run the production workload. Activities include:
• Freezing the legacy system
• Migrating last-minute master data, final item quantities from stock count, open transactions such
as purchase and sales orders, and balance sheet accounts. See the Opening Balances topic in
this training for more details.
• Reconciliation of accounting between the legacy system and the new system
• Phase sign-off by customer

Final Preparation Phase Best Practices, Tools and Templates
Final
Preparation
Milestones:
Finalize cutover plan
Conduct user and
administrator
training

Best Practices:

Tools and Templates:
▪ Data Migration Guide

Conduct system
readiness and GoLive check

▪

Adapt SAP provided slides for user training

▪

Allow each user hands-on access during training

▪ Project Phase Analysis and Risk

Cutover activities
and final balances

▪

Reference the AIP project plan and other AIP
materials for cutover activities, system readiness
criteria and opening balance migration steps

▪ Phase Sign-off

▪

Conduct cutover activities over weekend

▪

Make sure customer signs off on phase

Review project
phase

▪ Training Guide
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The best practices are:
▪ Use and adapt SAP provided slides for end user training (slides are provided for download from
PartnerEdge).
▪ During training, allow each user to work on the SAP Business One system individually. It is
imperative that end users are fully prepared to use the new system. Even if you do not conduct the
training, you need to assess that the users are ready.
▪ Cutover activities are documented in the AIP project plan.
▪ Suggestions for the system readiness check are documented in the project analysis and risk
spreadsheet in the AIP materials.
▪ Reference the data migration guide for step-by-step instructions for opening balance migration.
▪ Schedule cutover activities over a weekend or other quiet time.
▪ Make sure the customer signs off on this important phase – the sign off commits the customer to
the go-live date.
Tools and templates you can leverage are:
▪ Data Migration Guide
▪ Training Guide
▪ Phase Sign-off

▪ Project Phase Analysis and Risk

Go-Live and Support Phase Milestones, Best Practices, Tools and Templates
Go-Live and
Support
Milestones:

Tools and Templates:

Resolve critical issues
post go-live
Handover
administration to
customer
Handover system to
SAP and partner
support
Project end
Implement continuous
Improvement

Start

Project
kick-off

Best Practices:

Business
process
analysis

Configure
company

Test and
validation

End user
training

Cutover

GoLive
Time
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▪ Go-Live and Support is the final phase in the project. As the name suggests, the newly-built
system is now running in production. Support in this context means that you resolve any issues
related to the new system, for a period of time which should be specified in the contract.
▪ When all critical issues are resolved, the implementation team “hands over” the system to the
customer team and to the partner’s support team, and to SAP. Make sure that the customer’s IT
administrator is fully trained and able to support the system in operations. Also your own support
department should be prepared to support the new customer.
▪ As far as the AIP is concerned, this is the closure of the project. The customer accepts the system
in production by signing the phase sign-off form.
Best practices include:
▪
Provide your support staff with the documented Business Blueprint and any other project
documentation.
▪
Involve the SAP Business One account manager as well as the customer’s steering committee
(if applicable) in project closing.
▪
Schedule a “Review and Optimization Conference four to six week after the project closing
meeting. This gives you the opportunity to assess how well the system is performing and also
allows you to plan additional enhancements.
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AIP Tools and Templates Summary
Pre sales / Project
Preparation

Business Process
Analysis

Business
Blueprint

Project Realization

▪ Pre-Sales Analysis
▪ Handover from Sales

▪ Blueprint Process
questions
▪ BPML tool
▪ BPML User guide

▪ Data Migration guide

▪ Software Delivery receipt

▪ Blueprint Configuration
▪ Data Migration
Assessment
▪ Data Migration guide

▪
▪
▪
▪
▪

Blueprint Configuration
Migration Object list
BPML tool
Test Strategy guide
Test Cases

▪ Kickoff Meeting presentation
▪ Service Level Agreement

▪ Training guide
▪ Change Request form

▪
▪
▪
▪

Change Request form
Training Plan by Role
Training guide
Issue and Change log

Configuration /
Infrastructure /
Testing

Project
Management

Final
Preparation

Go Live &
Support

▪ Data Migration guide

▪ Training Plan by Role

▪ Project Plan
▪ Meeting Agenda
▪ Meeting Minutes
▪ Phase and Risk Analysis tool
▪ Phase Sign-off
26
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▪ The AIP materials are shown here organized according to each phase and by purpose:
▪ Business Process Analysis tools and templates are provided for pre-implementation scoping
and fact finding, for gathering detailed business process requirements, and for gathering data
migration requirements. A Data Migration Guide provides a step-by-step approach to data
migration and is a good reference for entering opening balances.
▪ Configuration, Infrastructure and Testing tools and templates are provided to record the
handover of software to the customer, and to document the setup and configuration. A tracking
spreadsheet tool is provided for object migration. Sample test cases are provided in a
spreadsheet, along with a Test Strategy guide.
▪ Project Management tools and templates include a PowerPoint template for the initial kick-off
meeting with the customer, and a sample Service Level Agreement (SLA). You can use the
Training Guide as a reference for planning training during the implementation. Also supplied is a
Change Request form and a change/issue log for managing issues during the implementation.
The final tool worth a mention is the Phase Sign-off form. You should use this to get customer
sign-off for a key deliverable or phase in order to keep the project on track.
▪ The Risk Assessment spreadsheet is a tool that automatically calculates the estimates project
risk, based on a series on answers that you supply.
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Project Plan

27

AIP Project Plan - Embedded
Administration > System Initialization > Implementation Center > Implementation Project
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▪

Complete project plan for a SAP
Business One implementation,
aligned to AIP methodology

▪

On-premise or Cloud

▪

Contains detailed tasks for all AIP
phases, viewable at 6 levels of
granularity

▪

Translated into localization
language

▪

During an implementation project,
the plan can be shared by project
team members to:
▪

Attach project documents

▪

Record task deadlines and
actual time
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▪ An implementation project plan is provided with the AIP materials. You can also find this plan
embedded in the SAP Business One client application with the Implementation Center tools.
▪ The plan is fully aligned to the AIP phases and can be used for on-premise or Cloud deployments.
▪ You can expand and view the tasks at six different levels of granularity.
▪ Many partners will find the embedded plan easier to use and it has several advantages. Because it
is part of the client application it is translated into the localization language and can be easily
accessed by users on the project team including customers. And you can attach and share project
documents, and record planned and actual time for a task or phase.
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Project Plan Templates
Administration > System Initialization > Implementation Center > Implementation Project

Add

Duplicate

Project plan templates provided in the system:
▪

Detailed plan includes all AIP phases

▪

Narrowed plan covers only the final three phases

▪

Pre-configured plan contains Starter Pack tasks

▪

Choose duplicate icon to generate a plan from a selected
template, or choose add icon to create your own blank plan
29
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▪ Three different project plans are provided to you:
▪

Detailed project plan. This plan contains tasks for the five phases defined in SAP’s Accelerated
Implementation Program (AIP) methodology.

▪

Narrowed project plan. This plan contains tasks for just the Project Realization, Final Preparation
and Go Live phases of the Accelerated Implementation Program methodology. This is useful for
an implementation-only partner.

▪

Pre-configured project plan. This plan contains the necessary tasks to manage an
implementation based on the entry-level SAP Business One Starter Package.
▪ The project plans are designed to be used as templates: open a plan template and select the
duplicate template icon to generate a new plan that you can edit. The new plan has all the tasks
from the template.
▪ You can also select the add icon to create a new, empty plan and set up your own tasks.
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Planning Tasks
▪

On the Plan tab, you can:

▪

Enter estimates for a task or
(in hours). Times are rolled up
to higher level parent task and
phase

▪

Add info, notes and attach
documents to a task or phase

To add an attachment you must
define path to folder in
Implementation Center Path
Settings

30
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There are two tabs on the project plan - Progress and Plan.
On the Plan tab, you can estimate the planned time in hours for a task at any level, or for a phase. The
times are rolled up to the higher level parent task and phase.
You can also add information, notes and attach documents to a task. For example you could add the
Handover from Sales AIP document to the Project Preparation task, or the Business Blueprint
document to the Business Blueprint task.
When you add info, notes or documents, the gray icon changes to blue.

Note: To save a document as an attachment to a project plan, you must define the path to a project
attachments folder. This is not defined in the General Settings but is done in the Path Settings of the
Implementation Center. The document you browse for will be copied to this folder for use in the project
plan.
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Managing Project Progress
▪

Managing project progress is
done on the Progress tab

▪

You can enter start and end
dates for a task and record
actual time spent on a task in
time record

▪

When entering time you must
select an owner (employee
master data is required)

31
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On the Progress tab, you can enter the estimated start and end date for a task, and record the actual
time spent on a task. To enter time, click the orange arrow in the Actual Duration column to open the
Time Record window.
Note that the owner name is required when you record time. The owner needs to have an employee
master data record but does not need a user account.
The time is recorded in the Actual Duration column and rolls up to a higher level task.
Progress to date is calculated and appears in the Progress % column.
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Task Integration with Configuration Screens
▪

Project tasks include
links to relevant setup
and configuration
screens

32
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▪ The project tasks contain direct links to relevant SAP Business One setup and configuration
screens.
▪ In the example shown, when you select the link arrow for the task “Set up Warehouses”, the
relevant setup window automatically opens.
▪ As you can imagine, this can speed up the time for a consultant to share and configure settings with
the customer. Once the setting is done, the consultant can then select the task complete checkbox
to indicate as a record that the configuration is done.
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Adding and Removing Tasks
▪

To add or remove a task, select a task then choose the
+ or – icon to add a new task after the selected task, or
remove the selected task

▪

To move a task, or move to a different level, choose
one of the arrows
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▪ To add a new task, select a task and use the plus icon. The new task is added after the selected
task.
▪ You can move any task to a new location by selecting it and using the up and down arrow icons.
▪ You can change the level and indentation of any task using the right and left arrow icons.
▪ To remove a task, select it and use the minus icon.
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Embedding Links for a Task
▪

If a new task has a configuration screen, you can add a direct
link in the project plan

▪

An example might be the configuration tasks for an add-on

34
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▪ When you add a new task to a plan, you have the option to add links to related configuration
screens. This is useful if you have an add-on as part of the solution – you can add tasks for
installing the add-on and provide links to the configuration of the add-on.
▪ To add a link to a task:
▪ First, select the checkbox for the task.
▪ Next, choose Add Link from the context menu.
▪ In the Menu Selection Form, you can select the appropriate menu item from the SAP Business
One menu.
▪ After you make a selection, the orange link arrow appears to the left of the task name.
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Summary
Key points from this topic:
▪ You can improve the success of a project by adopting certain strategies such as change
management, risk management, and leveraging experience of SAP and other partners.

▪ A structure project methodology, such as the SAP Accelerated Implementation Program
(AIP) is a proven methodology with best practices for an SAP Business One
implementation.
▪ The AIP methodology divides an implementation into phases with milestones. These
phases cover the period from the handover from the sales team to right before the
handover to the support organization.
▪ The methodology provides tools and templates to assist you with business process
analysis, data migration, risk analysis, change management, test strategy, and training
plans.
▪ The project plans embedded in the SAP Business One client are easy to use and include
all the recommend project activities. You can generate your own project plan from a
template, or create a blank plan in the system. You can attach shared project
documentation and record planned and actual time and progress in the embedded plan.
35
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Here are some key points to take away from this session.
▪ You can improve the success of an implementation project by adopting certain strategies such as
change management, risk management, and leveraging the experience from SAP and other
partners.
▪ SAP’s Accelerated Implementation Program (AIP) is a proven project methodology for an SAP
Business One implementation. It is based on the practical experiences of SAP and many partners.
▪ The AIP methodology divides an implementation into phases with milestones. These phases cover
the period starting with the handover from the sales team to right before the handover to the support
organization:
▪ Project Preparation: The project plan is created for the implementation. A kick-off meeting is held
with the customer, and the software is delivered.
▪ Business Blueprint: The focus is on analyzing the customers business processes and
requirements, and mapping them to a solution.
▪ Project Realization: The heart of the project where the company is configured to match the
business blueprint. Testing also takes place.
▪ Final Preparation: The focus is on preparing for go-live. The go-live date is set, the users are
trained, and the final balances transferred over.
▪ Go-Live and Support: After go-live the customer moves into support mode.
▪ The methodology provides best practices, tools and templates to assist you with business process
analysis, data migration, risk analysis, change management, test strategy, and training plans.
▪ The project plans embedded in the SAP Business One client are easy to use, include all the
recommended project activities, and integrate tasks with the configuration screens.
▪ You can generate your own project plan from one of the templates, or create a blank plan in the
system. You can attach shared project documentation to the embedded plan, and record planned
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and actual time and progress.
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Implementation Tools:
Express Configuration Wizard
SAP Business One Version 9.3

PUBLIC

▪ The Express Configuration Wizard simplifies the task of creating and configuring a new company
database.

36

Objectives

At the end of this course, you will be able to:
▪

Create a new SAP Business One company, and

▪

Configure key settings in a company

by following an easy to use wizard
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▪ At the end of this topic, you will be able to create a new SAP Business One company, and configure
key settings in a company by following an easy to use wizard.
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Business Example

You want to make sure that you
configure key settings in the
correct order.
Additionally, the customer has
asked for an audit log showing all
configuration settings.
Solution: The Express Wizard
provides a structured, systematic
way to create and/ or configure a
company. Additionally, an audit
report is automatically saved of
any settings or configuration
changes made in the wizard.
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▪ Let us look at a business example.
▪ You are configuring a new customer database and want to make sure that you configure key
settings in the correct order. In addition the customer has asked for an audit log of all configuration
settings.
▪ Solution: The Express Wizard provides a structured, systematic way to create and/or configure a
new company. In addition an audit report is automatically saved of any settings or configuration
changes made in the wizard.
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Software Installation
▪

SAP Business One software is
downloaded from the software
download center (accessible from
PartnerEdge or from the support
portal)

▪

For step-by-step installation
instructions, reference the
Administrator’s Guide

▪

During the installation you set the
site user password

▪

You can optionally install a demo
database during the software
installation

▪

You can use the software for 31
days without a license
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Links are available on PartnerEdge for authorized partners to download the SAP Business One
software.
For step-by-step installation instructions, reference the Administrator’s Guide.
During the installation you set the site user (B1SiteUser) password. The site user password is required
for various system-level tasks such as:
▪ Creating new companies
▪ Upgrading to a new release or patch level
▪ Accessing the System Landscape Directory (SLD)
▪ Creating a database user with read-only privileges for reports and queries
Note: The site user password can only subsequently be changed in the System Landscape Directory
(SLD).
You can run the newly-installed SAP Business One product version for 31 days without a license. To
continue working with the application after 31 days, you must install a valid license key assigned by
SAP.
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System Landscape Directory
https://<Server>:<Port>/ControlCenter

▪

Central workplace for managing company databases on the database servers

▪

Managing security including database authentication, single sign-on, encryption keys, site user
password, database user credentials

▪

Managing license, mail, alerts and browser access services
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The System Landscape Directory (SLD) is the central workplace for performing various administrative
and security tasks. It is accessible from a web browser using the url shown above.
Use the SLD to:
▪
Manage companies on the database servers. Companies added here will show on the user’s login
screen.
▪
Manage authentication for database users
▪
Enable single-sign-on functionality
▪
Manage encryption keys used to encrypt data in SAP Business One
▪
Change the site user password
▪
Change the database user used to connect to the database server
On the Services tab of the SLD, you can manage various services including:
▪
The license service
▪
The mail and alerts services
▪
The browser access service
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Creating a New Company
Administration > Choose Company
Options for creating a new company
(select the icon to the right of the New
button)
▪ To create a new company, choose
New from the Choose Company
window
▪ To create and configure a new
company using a wizard, choose
New Using Wizard from the Choose
Company window

You will be prompted to enter the site user
password to proceed.

The B1SiteUser password is required
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To create a new company, choose Administration  Choose Company.
In the choose company window select the icon to the right of the New button to see the dropdown
entries:
• Choose New to create a new company. After you create the company you can use the configuration
windows under the Administration menu to configure it.
• Choose New Using Wizard to create the company database and configure the company using the
wizard. The wizard makes it possible for a partner organization to adopt a uniform approach to
configuration with consultants following a recommended sequence for configuration.
In both cases you will be prompted to enter the site user password to proceed.
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Creating a New Company with Express
Configuration Wizard

42

Express Configuration Wizard – Company Details

Initial details for the company
▪ License required (or Trial
Version)
▪ Name and database name
▪ Option to copy to UDFs, UDTs
and UDOs from current
company
▪ Local settings activates local
tables and functionality
▪ Chart of accounts template (or
user-defined)
▪ Localization
▪ Base language for UI
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The wizard first takes you to the standard company creation screen where you enter the initial details
for the new company:
▪ If this is a new SAP Business One installation, you can select the Trial Version checkbox. After the
31 day window expires, you must install the license key. If a license is already installed, the new
company must be for the same localization.
▪ Name and database name. The name appears in the Company Details screen.
▪ Option to copy the user-defined fields, tables and objects from the current company to the new
company. This can be useful when there is a need to create an additional company for the
customer’s business or to create a test database.
▪ Local Settings. When you select the localization settings, this activates local tables and functionality
for the new company. You cannot change the localization after the company is created.
▪ Chart of Accounts. The chart of accounts templates you see depend on the local settings. If you
choose the “template” option, a default chart of accounts will be created automatically based on the
localization; and you can edit these accounts as desired. Alternatively you can choose the option
“user-defined”. Only the top-level drawers are provided in a user-defined chart of accounts, allowing
you to manually add accounts to the drawers. Note: You cannot change the chart of accounts after
there are posted transactions.
▪ Base language. The initial display language for the UI. This can be changed later.
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Express Configuration Wizard (cont.)
▪ To complete the initial settings,
choose the browse button to
define the posting periods
▪ You should define the posting
periods for the earliest fiscal
year that will be required in the
new company for reporting

© 2018 SAP SE or an SAP affiliate company. All rights reserved. ǀ PUBLIC

44

▪ To complete the initial settings, choose the browse button to define the posting periods. This is a
mandatory step.
▪ You should define the posting periods for the earliest fiscal year that will be required in the new
company for reporting. After the company is created you can define posting periods for subsequent
fiscal years, but you cannot define posting periods for an earlier year.
▪ For due dates, SAP recommends that you define a range that is broader than the posting date
range of the particular period. This lets you accommodate payment terms that calculate a due date
beyond the current system date.
▪ Due dates of posting periods can be changed later. For example, if the due date range does not
allow a transaction with a certain payment term, this can be adjusted.
▪ You cannot create overlapping periods. After creating periods, you can adjust the date range and
the beginning of the fiscal year according to your needs. The fiscal year does not have to be the
same as the calendar year; however, the beginning of the fiscal year must be the first day of the
month. In this case, you need to change the date range of the periods of that fiscal year. Do so by
starting from the last period and working backwards, to avoid a situation whereby the periods
overlap.
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Company Database - Completion
▪

After you define the posting period the wizard creates the database tables

▪

Progress is shown in the status bar

▪

The manager account is created and you need to supply the password

User “manager” is created by
default. You need to supply
manager password.

After you define the posting periods, the wizard creates the tables for the new company.
The “manager” user account is created by default. You supply a password for this user, and you use
these credentials to login to the company for the first time.

Using the Wizard to Configure a Company

46

Configuring a New Company



To prepare SAP Business One for use, you must create
the company database then configure various settings



Due to data dependencies, there is a suggested order for
the configuration and setup for a new company



Most of these settings are located under the menus:
Administration > System Initialization
Administration > Setup
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▪ To prepare SAP Business One for use at a company, you configure various settings, such as
accounting, inventory, business partners, users, sales, and purchasing. Due to data dependencies,
there is a suggested order for the configuration and setup for a new company. For example, you
should configure the accounting settings first.
▪ The individual configuration screens are mostly located under the Administration > System
Initialization and Administration > Setup menus.
▪ Instead of using the individual configuration screens it is often easier to use the Express
Configuration Wizard.
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Configuring a New or Existing Company
Administration > System Initialization > Implementation Center > Implementation Tasks – Configure
Company Settings
▪

To access the wizard to configure a
company, open it from the
Implementation Center
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▪ You can use the wizard to make configuration changes in the new company as well as in an existing
company. To access the wizard, open the Implementation Center and choose Configure Company
Settings.
▪ To use the tasks in the implementation center, the general authorization Administration > System
Initialization> Implementation Tasks > Implementation Tasks is required.
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Express Wizard Configuration Order
Company
Details

Company Information, Hide Functionality

Accounting

Chart of Accounts, Perpetual Inventory, Warehouses

Banking

Banks and House Banks

Business
Partners

Payment Terms, Business Partner Groups

Inventory

Item Groups, Inventory Cycles, Price Lists

Sales and
Purchasing

Document Settings, Document Numbering

Users

User accounts, Licenses, Authorizations
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▪ The wizard guides you through the configuration process steps for configuring the company setup
for each area:
▪ Company Details
▪ Accounting
▪ Banking
▪ Business Partners
▪ Inventory (Stock)
▪ Sales and Purchasing
▪ Users.
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Benefits of Using the Wizard for Configuration

▪

For ease of use, the
configuration screens for
each area are grouped
together in recommended
order

▪

Wizard highlights
irreversible settings in
advance with a red
exclamation mark

▪

After a transaction is
posted these settings are
grayed out and cannot be
changed in the wizard
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▪ The benefit of using the wizard is that configuration screens are grouped together in recommended
order for each module or area – accounting, banking, business partners, inventory (stock), sales
and purchasing, and users. An example is shown here of the Accounting configuration screens.
There are several screens for accounting.
▪ The wizard also highlights in advance any settings that cannot be changed after transactions have
been posted for the company. These settings have a red exclamation mark (!).
▪ When a setting becomes irreversible it is grayed out in the wizard and cannot be changed.
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Summary of Configuration Screens used in Wizard
Area

Equivalent Configuration Screens

Accounting

Administration > System Initialization > Company Details
Financials > Chart of Accounts
Administration > Setup > Financials
Administration > Setup > Financials > Tax

Banking

Administration > Setup > Banking

Business Partners

Administration > System Initialization > General Settings – BP tab
Administration > Setup > Business Partners

Inventory

Administration > Setup > Inventory
Inventory > Price Lists

Sales and Purchasing

Administration > System Initialization > Document Settings
Administration > System Initialization > General Settings - Display tab.
Administration > System Initialization > Document Numbering
Administration > Setup > Purchasing > Landed Costs,
Administration > Setup > General > Reference Field Links
Administration > Setup > Opportunities

Users

Administration > Setup
Administration > License
Administration > System Initialization > Authorizations
Human Resources
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The slide shows a summary of the wizard steps and the equivalent company configuration screens.
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Configuration Report
▪

On completion of wizard for a new company, a
baseline configuration report is created
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When you run the wizard for a new company, a baseline configuration report is created. This can be
handed to the customer as documentation. Each possible setting is shown with the configured or
default value.
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Configuration Report
Administration > System Initialization > Implementation Center > Configuration Management
▪

Configuration report is saved each time the wizard is run, providing an audit trail

▪

Access and compare saved configuration reports

Select saved report and compare to
current configuration (to check if
changes were made directly from
the Administration menus)

Select multiple reports for
comparison
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▪ Another advantage of using the wizard for configuration is that a report is saved each time the
wizard is run, providing an audit trail of changes made.
▪ You can access the saved configuration reports at any time by choosing Configuration Management
from the Implementation Center menu:
▪
You can select a saved report and compare it to the current configuration. Since configuration
changes made outside the wizard are not tracked, you can run this comparison to check if
configuration changes have been made directly from the Administration menus, and not using
the Express Wizard.
▪
You can also select multiple reports and compare them. This allows you to see changes made
at different stages of the implementation or over time.
▪
You also have the ability to save a snapshot of the current configuration at any time, from the
General tab of the Configuration Management screen.
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Summary
Key points from this topic:
▪ You have two options for creating a new company - the Express Configuration Wizard
option reduces the time needed create a new company by following an easy to use
wizard. This makes it possible for a partner to adopt a uniform approach to configuration.
▪ The wizard groups related configuration screens which may not appear under the same
administration menus, and importantly the wizard alerts you in advance to irreversible
settings.
▪ You can also use the Express Configuration Wizard to configure an existing company.
After you run the wizard for the first time, the system saves a baseline configuration
report. Each time you use the wizard, a new report is created and you can compare and
audit configuration changes.
▪ The site user password is required to create a new company. The site use password is
set during installation and maintained in the System Landscape Directory.
▪ You can run the newly-installed SAP Business One product version for 31 days without a
license and create company databases using the trial version.
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▪ These are the key points from this topic:
▪
You have two options for creating a new company – choose New or choose New Using
Wizard. The latter option saves time and removes the need to navigate the individual
configuration screens. This makes it possible for a partner organization to adopt a uniform
approach to configuration. The wizard guides you through the correct order for configuration.
▪
The Wizard brings together the configuration settings found under the Administration > System
Initialization and Administration > Setup menus, plus other menus relevant for Accounting,
Banking, Business Partners, Inventory, Sales and Purchasing, and Users. The wizard
automatically groups related configuration screens.
▪
Importantly, the wizard alerts you to irreversible settings, which are marked with a red
exclamation mark.
▪
You can also run the Express Configuration Wizard to configure an existing company.
▪
After you run the wizard for the first time, the system saves a baseline configuration report.
Each time you use the wizard to make additional configuration changes, a new report is
created and you can compare the changes in the reports using the Configuration Management
function.
▪
The site user password is set during installation and required to create a new company. The
site user password is managed in the System Landscape Directory. You can run the newlyinstalled SAP Business One product version for 31 days without a license and create company
databases using the trial version.
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Implementation Tools:
Key and Irreversible Settings
SAP Business One Version 9.3

PUBLIC

▪ In this topic, you will learn about the key system settings for a new company, including default and
irreversible settings.
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Objectives

Objectives:
▪

Describe the default local settings for a new company database

▪

Explain key settings in the Company Details, General Settings and Document Settings
windows

▪

List the system settings that become irreversible after the first transaction has been
posted

Note: This course highlights a few of the key settings and is intended as an overall introduction to
configuration settings. Be sure to take time using the demo database to research each of the settings
to see how they affect processing.
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▪ At the end of this topic, you will be able to:
▪

Describe the default local settings for a new company database

▪

Explain key settings in the Company Details, General Settings and Document Settings
windows

▪
List the system settings that become irreversible after the first transaction has been posted
Note: This course highlights just a few of the key settings in the Company Details, General Settings
and Document Settings, and is intended as an overall introduction to configuration settings. Be sure to
take time using the demo database to research all of the settings on these windows to see how they
affect document processing and functionality in SAP Business One.
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Business Example
▪

You need to configure a new company database to meet a set of customer requirements

▪

Changes will be made in the Company Details, the General Settings and the Document
Settings.
•

Needs to post certain documents in
advance and be able to change
sales orders after they are issued

•

Sales staff need to know when a
customer’s credit limit is exceeded

•

The accountant:
•

Has a set of rules
for defining the
accounts used in
journal entries.

•

Wants to
depreciate
purchased assets

System should check availability
before order is posted

•

Needs to approve
purchasing
documents over a
set amount

•

Manages freight
charges at the
document level
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▪ You need to configure the new company database to meet the customer requirements.
▪ The changes will be made in the Company Details, the General Settings and the Document
Settings.
▪ To make the right choices, you need to know the effect of a setting and which settings are
irreversible.
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Default Settings for Localization
▪

When you create a new company you select a localization

▪

Many default settings are based on common business
practices in the selected localization
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▪ When you create a new company, you initially enter the name of the company and select a
localization. Based on the localization, many default settings are applied in the Company Details.
▪ For example:
▪ The templates for the chart of accounts are populated according to the localization. You usually
have the option to select a predefined chart of accounts or a user-defined chart of accounts
which contains only the top drawers. It is often faster to use a predefined charts of accounts and
adapt it to the company’s needs, rather than creating a chart of accounts from scratch.
▪ The local and system currencies are based on the selected chart of accounts. Journal entries
are made in the system currency and the system currency is used as the reporting currency.
The local currency is used for reporting to a local tax authority.
▪ Several default settings (checkboxes) are applied based on the localization, including:
▪ Display Credit Balance with Negative Sign. This setting affects the display of credit amounts.
It also influences how you enter the opening balances for credit amounts - as positive or
negative numbers.
▪ Use Perpetual Inventory. This setting, if selected, causes inventory transactions to also post
to the accounting system.
▪ Permit More than One Document Type per Series. This setting will be checked if required for
the localization.
▪ Manage Item Cost per Warehouse. If selected, the system calculates inventory pricing for
each individual warehouse. If not selected, inventory pricing is combined for all warehouses.
▪ Use Purchase Accounts Posting System. If selected this activates purchase accounting.
▪ The default settings represent common business practices used in the localization.

▪ Depending on the chosen localization there may be additional settings on the Company Details.
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Settings - Company Details

59

Company Details
Administration > System Initialization > Company Details
▪

Company Details contains company-wide initialization settings for a new company

▪

Can also be accessed from Express Configuration Wizard
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On the Company Details window you enter general information for the company, accounting
information for tax, and basic initialization settings that apply to the entire company.
▪
On the accounting data tab you can define holidays. Holidays are used to calculate the resolution
time in the service module and to calculate due dates in purchasing and sales documents. You
can change holidays at any time.
▪
The basic initialization tab covers the global configuration settings. Note that some settings
become irreversible after postings are made to the general ledger.
▪
Some settings are grayed out if they are not applicable for the localization. For example, for the
UK localization does not use segmentation accounts.
You can access the Company Details using the path in the slide, and the window is also accessible
from the Express Configuration Wizard.
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Irreversible Settings - Company Details
Irreversible settings cannot be changed after the
first transaction has been posted and include:
▪

Chart of accounts template

▪

Local currency

▪

System currency
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The following settings in the Company Details cannot be reversed after the first transaction is posted
and should be carefully planned with the customer:
▪ Chart of Accounts Template. The chart of accounts template can be changed before postings are
made, but not after any postings.
▪ Local currency. The local currency is the currency in which the company reports to the local tax
authorities and cannot be changed after postings are made.
▪ System currency. The system currency is the currency in which the company reports to the local
tax authorities and cannot be changed after postings are made. Every journal entry is translated
automatically into the system currency according to the daily rate. If you do not have any reporting
requirements in another currency, set the system currency to the local currency. Note: The default
account currency is the default currency for new G/L accounts and can be changed.
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Irreversible Settings - Company Details (cont.)
Irreversible settings that cannot be changed after
the first transaction has been posted:
▪

Display Credit Balance with Negative Sign

▪

Use Segmentation Accounts

▪

Permit More than One Document Type per
Series (selected localizations)

▪

Use Perpetual Inventory

▪

▪

Manage Item Cost per Warehouse

▪

Use Purchase Accounts Posting System

Enable Separate Net and Gross Price Mode
(selected localizations)
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Other settings in the Company Details that cannot be reversed include:
▪ Display Credit Balance with Negative Sign. This setting influences whether credit amounts are
displayed with a minus sign or not. If you enable this checkbox you will need to enter the credit
opening balances of business partners and G/L accounts with a negative sign.
▪ Use Segmentation Accounts. Segmentation is used in some localizations to segment account codes
by departments, divisions, or other categories.
▪ Permit More than One Document Type per Series. If allowed by the localization, this setting allows
the customer to use the same document numbering series for more than one type of document, for
example, invoices and credit memos.
▪ Enable Separate Net and Gross Price Mode is for selected localizations and becomes irreversible
after the first transaction is posted.
▪ Use Perpetual Inventory. This is explained in the logistics courses.
▪ There are further checkboxes if perpetual inventory is enabled:
▪ Manage Item Cost per Warehouse. This option allows a company to maintain different item costs
for each item and warehouse. This checkbox is irreversible after the first inventory transaction is
posted.
▪ Use Purchase Accounts Posting System. Purchase accounting is a legal requirement in some
localizations and so it will be automatically checked. When purchasing documents are issued,
the expense is recorded in a separate expense account. This checkbox becomes irreversible
after the first journal entry is posted.
▪ Note: The Allow Stock Release Without Item Cost checkbox is reversible. This setting allows a
company to include items in documents even when item cost has not been determined.
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Irreversible Settings - Company Details (cont.)
Irreversible settings that cannot be changed after
the first transaction has been posted:
▪

Install bank statement processing

▪

Enable Intrastat

▪

Enable fixed assets. Note: fixed assets cannot
be reversed, even before transactions are
posted

▪

Mask credit card number

▪

Enable project management

Note: The setting Enable Advanced G/L
Account Determination is reversible.
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Other settings in the Company Details that become irreversible are:
▪ Enable Fixed Assets. If you enable fixed assets you cannot reverse this setting, even before any
transactions have been posted.
▪ Install Bank Statement Processing. You can activate it at any time, but once it is activated and
transactions have been processed, bank statement processing cannot be deactivated.
▪ Enable Intrastat. Once enabled this setting is irreversible.
▪ Mask Credit Card Number. This checkbox may be checked by the localization. Only the last 4 digits
of a credit card is exposed. If checked, this cannot be unchecked.
▪ Enable Project Management checkbox becomes irreversible after projects are defined.
Note: The setting Enable Advanced G/L Account Determination is reversible.
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Summary – Company Details
Settings to address the business scenario:

Customer requirement

Configuration
Screen

Setting

Comments

The accountant has a set of rules
for defining the accounts used in
journal entries.

Company
Details

Enable Advanced G/L
Account Determination

Reversible

The accountant wants to depreciate
purchased assets.

Company
Details

Enable fixed assets

Irreversible
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Settings in the Company Details to address the customer requirements from the business scenario:
▪

The Enable Advanced G/L Account Determination checkbox results in additional functions
being added to the G/L account determination window, that allow you to set up criteria for
account determination. You can change this.

▪

The fixed assets checkbox activates fixed assets functionality and documents in SAP Business
One. This setting is immediately irreversible even when no documents have been posted.
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Settings – General Settings
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General Settings
Administration > System Initialization > General Settings

▪

General Settings cover defaults and initialization for business partners,
budget, inventory, cash flow and cost accounting, pricing and user
display

▪

These settings are also accessible from the Express Configuration
Wizard
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▪ In addition to the company-wide settings, General Settings cover a wide range of defaults and
initialization parameters for different areas of SAP Business One including business partners,
budget, cost accounting, pricing and inventory, as well as user display and services.
▪ Unlike the Company Details settings, general settings can be changed.
▪ Note that some localizations may have additional tabs in the General Settings.
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General Settings – Business Partners

Settings on BP tab activate the following functionality:
▪

Credit limit restrictions

▪

Approval processes

▪

Data ownership authorizations

You can also define default payment methods,
payment terms and dunning terms
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The BP tab is important for an implementation consultant because here you can:
▪ Switch on credit and commitment limit restrictions for customers and specify the documents which
will be monitored.
▪ Activate approval processes for marketing documents. See the course topic Approval Processes for
more information.
▪ Enable data ownership authorizations to apply to documents and forms. See the course topic Data
Ownership Authorizations for more details. The ability to activate approval processes and data
ownership on this tab gives you the flexibility to create approval templates and data ownership rules
in advance and then switch them on when you are ready, using this tab.
On this tab you can also set defaults to apply to business partners. These defaults will be used for new
master data. For information on these customer defaults, see the Customers course in the SAP
Business One Logistics program.
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General Settings – Financial and Accounting

▪

Budget tab: initialize budget functionality

▪

Cash Flow tab: define global settings for use in cash flow reporting

▪

Cost Accounting tab: enable and initialize cost accounting functionality
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▪ If a company wants to manage a budget in SAP Business One, you need to select the checkbox on
the Budget tab and select the type of budget restriction for documents that deviate from the budget.
▪ On the Cash Flow tab you define global settings for use in cash flow reporting.
▪ On the Cost Accounting tab you enable and initialize cost accounting functionality.
See the Financials course for more information in these areas.
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General Settings – User Services

▪

Settings on the Services tab determine windows that are
automatically opened when a user logs on.

▪

You can also set defaults for e-mail and enable instant
messaging (Live Collaboration).

Note: Many settings on this tab can be overwritten at the user
account level.
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Settings on the Services tab determine which windows are automatically opened when a user logs on,
such as:
• The Exchange Rates and Indexes window to set exchange rates for the day
• The Confirmation of Recurring Postings and/or Recurring Transactions windows
• Postdated credit vouchers without a reference, and/or postdated checks
• The Messages/Alert Overview window whenever the user receives a new message
Also on this tab you can set:
•
Update Messages (the frequency the system checks for new alerts). The default is 5 minutes.
•
The screen locking time (the default is 30 minutes). If Windows screen locking is activated, this is
not needed.
•
Alternative keyboard usage
•
The default e-mail service for users (SAP Business One mailer, or Microsoft Outlook). Note that
Microsoft Outlook needs the add-on installed. You can also define the SMTP mail server settings
for this company – this is useful if there are multiple company databases on the server.
•
Enable Transaction Notification. This should be checked to support the use of stored procedures
in the database.
•
Enable Live Collaboration. You can enable the use of SAP Business One instant messaging for
the company.
Note: Many of the settings on this tab can be overwritten in the user account, and a user can change
these settings for themselves. So the settings here should be regarded as mainly default settings.
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General Settings – User Display Settings

Settings on the Display and Font & Bkgd tabs are used as defaults when a new
user account is created:
▪

Display tab: Define default settings for the display language, length and weight
units, date and time, number of rows, decimal places, etc.

▪

Font & Bkgd tab: Define the display font, font size and optional background
image for user sessions.

Note: Many of these settings can be overwritten by User Defaults or in the user
account.
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Settings on these tabs are used as defaults when a new user account is created. Note: Many of the
settings on these tables can be overwritten by User Defaults and at the individual user account level.
On the Display tab are settings that control the appearance of the user interface, as well as time and
date formats:
• UI language
• Background color
• Standard units for various length and weights for items. SAP Business One proposes these length
and weight units automatically when you define a new item.
• Time format –12-hour or 24-hour
• Date format. The sequence here does not affect how you must enter dates in forms.
• Date separator. The character between the day and month, and month and year.
• Manage Company Time. This checkbox is only used when the SAP Business One server is in one
time zone and all users are in a different time zone.
• The maximum number of rows that will be displayed in any List of window.
• The default UI template for customizing user forms. See the topic UI Configuration Templates for
more information.
• SAP Business One suggestions for the user as they type in the names of various fields such as item
numbers, item descriptions, business partner codes, and business partner names.
• The number of rows for display in Choose From List windows.
• The number of decimal places displayed for amounts, prices, exchange rates, quantities,
percentages, units, and calculated values in queries. Note: For all of the decimal settings, except for
calculated values in queries, the following applies:
▪ If no journal entry has been posted, you can change the number of decimal places.
▪ After a journal entry has been posted, you can only increase the number of decimal places, up to
6 digits. This change is irreversible.
On the Font & Bkgd tab, you can set font, font size and background image for the UI. A preview option
is available.
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General Settings – Path Tab
Define paths to shared folders required by the
system to support user activities:

Icons that use the shared folders

▪ Microsoft Word templates - export to
Word
▪ Microsoft Excel - export to Excel
▪ Pictures - stored images
▪ Attachments – attached files, export
as PDF, e-mail documents
▪ Extensions - secure images
▪ Scanner address – automatically
detected
▪ XML file folder - when a program
generates an XML file
Note: Users need to have write permissions to
these folders.
71
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▪ On the Path tab you must define the paths to shared folders that the system will use to support
various user activities. The folders must be accessible by users (users need write permissions to
the folders):
▪ When a user exports a document to a Microsoft Word file, a template is required. Templates are
provided in the WordDocs folder of the SAP Business One installation.
▪ Similarly, the ExcelDocs folder is required for exporting to Microsoft Excel. This folder is also
provided in the SAP Business One installation.
▪ The Pictures folder is used for stored images. If you do not specify a path for the Pictures folder,
users cannot perform certain actions, such as adding images to master data records, printing
documents with company logos, and so on.
▪ The Attachments folder is used for several purposes, including obviously to attach files to
documents, and also when exporting documents as a PDF, and e-mailing documents to a
business partner.
▪ The Extensions folder is used for the retrieval of stored secured images, include official stamps,
which, due to legal requirements, can only be saved as *.dll files and not as picture formats.
▪ If a document scanner is connected to the system, it is automatically detected and the scanner
location is stored in this path, allowing scanned documents to be integrated with relevant
screens. For example, when you enter an item, you can scan an image directly from the images
tab for a master record.
▪ The XML File folder is used by the system when a program such as an add-on generates XML
files.
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Attachments Folder Use
▪

Attachments folder is widely
used

▪

Path to attachments folder
can be changed and applied
to existing attachments using
Refresh Paths in Documents
button

▪

Export as PDF

UDF with link to document

You can create sub-folders
for use by one user or a
group of users using User
Defaults

Print Preferences

Attachments to
document or
master data
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The Attachments folder is used widely:
▪

For a document exported by a user as a PDF. The file is saved in the attachments folder.

▪

When a document is sent in an email. For example in Print Preferences you can designate
that a document will be automatically emailed when it is added. The document is sent as an
email attachment.

▪

When a user adds an attachment to a document, activity, business partner or other form that
has an Attachments tab. The file must exist in the attachments folder.

▪

When a user-defined field (UDF) is added with type General and structure Link that will hold a
link to a file. The file is copied into the attachments folder.

▪ If a company decides in the future to change the path to this folder, the new path can be applied to
attachments in existing documents by pressing the Refresh Paths in Documents button located to
the right of the Attachments path.
▪ Instead of designating one central attachments folder for all users, you can create sub-folders and
designate a folder per user or group of users. This is done in the User Defaults window. See the
companion course Users and User Defaults for more information.
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General Settings – Hide Functions Tab

Use the Hide Functions tab to easily remove unwanted functionality from the user interface,
including:
▪

Budget tab in General Settings, plus the menu entries for budgets under the Financials
module

▪

Payment Wizard menu and payment methods under the Banking module

▪

Dunning wizard menu under the Sales A/R module

▪

Cost accounting tab in General Settings plus menu under the Financials module

▪

References to serial and batch numbers under the Inventory module

▪

Production and resource menus under the Inventory module

▪

MRP module

▪

Units of measure references
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▪ The Hide Functions tab is not used to define settings but is actually a way to easily hide unwanted
functionality from the user interface.
▪ The functionality is still available, but it is hidden from the user.
▪ The areas of functionality you can hide include:
▪ Budget tab in the General Settings, plus the menu entries for budgets under the Financials
module
▪ Payment Wizard menu and payment methods under the Banking module
▪ Dunning wizard menu under the Sales A/R module
▪ Cost accounting tab in the General Settings plus menu under the Financials module
▪ References to serial and batch numbers under the Inventory module
▪ Production and resource menus under the Inventory module
▪ MRP module
▪ Units of measure references
▪ Note that some functions cannot be hidden after documents have been posted. For example you
cannot hide serial and batch numbers if items already exist in the database that are managed with
serial or batch numbers.
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Hide Functions Tab - Effect

Effect of hiding Payment
Wizard, Production and MRP
functions:
•

On main menu

•

In various forms and
windows
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▪ Let’s look at an example of hide functions.
▪ Assume a company does not use the production and MRP functions. They also do not want to run
the Payment Wizard. We can easily remove these functions from the system.
▪ Not only are the menus removed from the main menu, but in addition references to the function are
removed from various windows and forms throughout the system. For example, the MRP Planning
and Production tabs are removed from item master data.
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Other General Settings tabs
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Settings on the Inventory, Resources, Cockpit, and Pricing tabs are explained in the Logistics courses
in this curriculum.
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Summary – General Settings
Settings to address the business scenario:

Customer requirement

Configuration
Screen

Setting

Comments

Management approval is needed
for purchasing documents that
meet predefined criteria.

General
Settings

BP tab –
Enable
approval
process

Also define approval
stages and templates

If a customer’s credit limit is
exceeded by over 500, the sales
employee should report it to a
manager.

General
Settings

BP tab –
Customer
Activity
Restrictions

Also define payment
terms for customers
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▪ Settings in the General Settings to address the customer requirements from the business scenario:
▪
Enable approval process on the BP tab.
▪
Customer credit checking is also enabled on the BP tab.
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Settings – Document Settings

77

Document Settings - General
Administration > System Initialization >
Document Settings
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▪

Key settings for processing
documents

▪

Settings on the General tab apply to
all document types

▪

Most settings can be changed at any
time – Manage Freight in Documents
becomes irreversible after a
document is posted

78

Key settings that apply to all document types are made on the General tab of the Document Settings.
These settings affect the way documents are processed:
▪ Gross Profit: Define whether to calculate gross profit percentage from the base price or the sales
price.
▪ Document Remarks Include: Select whether the remarks on marketing documents include the base
document number, or the customer or vendor reference number.
▪ Response to Release/Receipt of Inventory Outside Defined Range: Define the system response
when the inventory level of an item falls below the minimum quantity as the result of a sales or
inventory document.
▪ Block Negative Inventory: Select to block documents that would cause the level of inventory to fall
below zero. If you deselect the checkbox, the document will be added even if there is no inventory.
▪ Rounding Method: Select whether the amounts and prices that appear in marketing documents
should be rounded by currency or by document.
▪ Exchange Rate Base Date: Choose the date on which the system calculates the exchange rate for
A/P documents.
Other key settings are:
▪ Manage Freight in Documents: Select to add a Freight field in all sales and purchasing documents.
This lets you calculate additional costs connected to a document.
▪ Block Documents with Earlier Posting Date and Allow Future Posting Date checkboxes either block
or allow documents by checking the posting date in the document

▪ Display Cancelled and Cancellation Marketing Documents in Reports: Select to include cancelled
and cancellation documents in reports.
▪ Enable Advanced Available to Promise: Select to enable the advanced ATP function (SAP HANA
only)
Note: Most of these settings are reversible and can be changed at any time. The exception is Manage
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Freight in Documents. Once you have selected this checkbox you cannot reverse it after a
document has been posted.
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Document Settings – Per Document
Administration > System Initialization > Document Settings
▪

Per document settings apply to specific document type, e.g., sales orders
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▪ On the Per Document tab you can view and change settings for processing individual document
types.
▪ For example, for sales orders you can enable automatic checks on the available quantities of items.
▪ Many of these settings are automatically set according to best practices but you should check them
to make sure they match to the customer’s business process.
▪ Document settings are covered in more details in the logistics courses.

79

Document Settings – Electronic Documents
Administration > System Initialization > Document Settings
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▪

On the Electronic Documents tab you can
enable functionality for creating electronic
documents

▪

This functionality is available in most
localizations but not all

▪

In addition to enabling the functionality,
you need install the EFM add-on and map
the marketing documents to XML format

▪

When generated, electronic documents
are stored in the XML folder specified in
Path settings

▪

Electronic transmittal is done using the
integration framework of SAP Business
One and you need to activate the relevant
scenario package
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▪ On this tab you can enable the functionality for creating electronic versions of marketing documents.
▪ The functionality is available for most localizations but not all.
▪ You need to first define the mapping of the marketing document fields to XML format using the
Electronic File Manager (EFM) add-on. You can upload a format definition from the EFM as a
default format in this window.
▪ The electronic documents can be generated automatically when the document is added and are
stored in the XML File Folder specified in the General Settings on the Path tab.
▪ The generated document is transmitted from the XML file folder by the integration framework of
SAP Business One. A scenario package is available in the integration framework for electronic
transmittal, and you must activate the scenario package for the relevant database.

80

Summary – Document Settings
Settings to address the business scenario:

Customer requirement

Configuration
Screen

Setting

The company wants to manage freight
costs at the document level.

Document Settings
– General tab

Manage Freight in
Documents

The sales department needs to post
certain documents in advance, with a
posting date in the next posting period.

Document Settings
– General tab

Allow Future
Posting Date

The sales department needs the ability
to make changes to sales orders after
they have been posted.

Document Settings
– Per Document

Allow Changes to
Existing Orders

The system should check the available
quantities of items included in a sales
order before the order is posted.

Document Settings
– Per Document
(Sales Order)

Activate automatic
availability check
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Comments
Irreversible after
document posted with
freight

Alternate: Enable
Advanced Available to
Promise for SAP
HANA
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Settings in the Document Settings to address the customer requirements from the business scenario:
▪
Manage Freight in Documents checkbox becomes irreversible after a document is posted with
freight included.
▪
Allow Future Posting Date checkbox allows the user to set the posting and document dates to a
future date. A warning is given to the user.
▪
Allow Changes to Existing Orders checkbox enables the user to change the selected document
after it has been added to the system.
▪
Activate Automatic Availability checkbox for the sales order document will check the stock level of
items included in a sales order before it is added, and will suggest options to the user if
the available quantity is less than the quantity in the sales order. Note: for SAP HANA there is an
alternate checkbox on the General tab of the Document Settings: Enable Advanced Available to
Promise. If you select this checkbox the Activate Automatic Availability checkbox on the Per
Document tab is deselected.
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Summary
Key points from this topic:
▪

When you create a new company you select a localization. Many default settings are based
on the selected localization

▪

Key settings for a new company are found in the Company Details, General Settings and
Document Settings screens

▪

Some settings become irreversible after the first posting to the general ledger, including:
▪ Chart of accounts template
▪ Local and system currency
▪ Display credit balance with negative sign
▪ Use segmentation accounts (some localizations)
▪ Permit more than one document type per series (some localizations)
▪ Use perpetual inventory
▪ Manage item cost per warehouse
▪ Use purchase accounts posting system
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▪

Here are some key points to take away from this session.
▪

When you create a new company you select a localization. Many default settings are based on
the selected localization.

▪

Key settings for a new company are found in the Company Details, General Settings and
Document Settings screens

▪

Some settings become irreversible after the first posting to the general ledger. A few of these
are shown on the slide.
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Implementation Tools:
Opening Balances
SAP Business One Version 9.3

PUBLIC

▪ In this course you will learn how to enter opening balances for a new customer implementation.
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Objectives

Objectives:
 Describe the process for migrating legacy balances for business partners,
inventory, and G/L accounts into a new SAP Business One system
 Explain the best practices and tools for entering opening balances
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▪ In this topic, you will learn the process for migrating legacy balances
for business partners, inventory, and G/L accounts into a new SAP
Business One system prior to going live.
▪ You will also learn best practices and tools for entering opening
balances from the legacy system.

84

Business Scenario

 The customer will go live in two days. Once the legacy system is closed down, you
need to balance the accounts from the legacy system with the account balances in
SAP Business One
 To accomplish this, you need to enter the balances for G/L accounts and business
partners, and enter item quantities and costs, so that the financial reports match

Profit and
Loss
Statement

Balance
Sheet
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▪ Just before go-live, you have a short timeframe where you must enter
the G/L account balances from the legacy system, including the
balances for business partner accounts. You also need to enter the
item quantities and costs. At the end of this effort, the financial reports
in the new SAP Business One system match the legacy reports.
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Cutover Period in the Implementation Cycle
SAP Business One AIP - Implementation Cycle
Project
Preparation

Business
Blueprint

Master data migration

Go Live and
Support

Final Preparation

Project Realization

Cutover period
▪

Freeze legacy system

▪

Perform stock count

▪

Enter or migrate open
transactions and final opening
balances

▪

Verify balances in production
system

GoLive

Time
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▪ The period immediately before go-live is called cutover. This period can be as short
as a few hours, or can last a few days, such as over a weekend.
▪ During the cutover period the major activities are to:
▪ Freeze the legacy system so no new transactions are entered. In the frozen
legacy system, reconcile business partner accounts and try to close out
documents to minimize the quantity of open transactions.
▪ Perform a stock count.
▪ Enter or migrate open transactions and final opening balances into the new
SAP Business One system.
▪ At go-live, financial information in the SAP Business One system must match
the legacy system balance sheet accounts.
Things to consider include:
▪ Will the new SAP Business One system run in parallel with the legacy system for a
period of time?
▪ Can the go-live take place at the start of the customer’s fiscal year or will it happen
during the fiscal year?
▪ Can open transactions in the legacy systems be closed before the cutover?
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Data Migration During Cutover

During cutover, it is recommended to migrate final transactions and
opening balances in a certain order, to avoid duplicate postings.
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Data Migration Order for Opening Balances

1. Final
Master
Data

2. Item
Quantities
and Costs
(after stock
count)

3. Open
Transactions:
•

Orders

•

Invoices

•

Payments

•

Production orders

4. Final Opening
Balances:
• Business Partner
Balances
• G/L Account
Balances
• Cash and Bank
Balances

Reference: AIP Data Migration Guide
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In general you should follow this order for transferring the final data from the legacy
system:
1. Final master data (that was added by the customer after the initial master data
migration)
2. Item quantities and costs (to match the legacy system values at the point of
cutover)
3. Open transactions from the legacy system, such as purchase and sales orders
and invoices, partial payments and production orders
4. Final account balances for business partners and G/L accounts including cash
and bank accounts
▪ In conjunction with this training you should refer to the Data Migration Guide from
the AIP methodology for a detailed step-by-step guide to opening balances.
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Final Master Data Migration

1. Final Master Data

Migrate any new master data created in the legacy system
after the main migration ends:
▪ Business Partner Groups and Master Records
▪ Item Groups and Master Records
▪ Bills of Material
▪ Resources for Production
▪ Price Lists
▪ Catalogue Numbers
▪ Employee Master Data
▪ Service Contracts
▪ Service Templates
▪ Customer Equipment Card
▪ Knowledgebase Solutions
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▪ Master data is usually migrated in the Project Realization phase of the
implementation project; however, there may be a need to migrate new master data
created in the legacy system after the main migration ends.
▪ Final master data may cover not just last minute business partner and item master
records, but also bills of material, resources for production, price lists, catalogue
numbers, employee records and service information such as existing contracts,
templates, equipment cards and a solution knowledgebase.

▪ The customer should be encouraged to clean up the legacy data before migrating
it to the new system. This might include:
▪ Removing duplicate master data
▪ Removing old, inactive business partners or products
▪ Consolidating price lists or introducing new price lists
▪ Using a new numbering scheme for customer and vendor codes, product
numbers, or chart of account numbers.
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Item Quantities and Costs

▪ Item quantities and costs are
entered from the customer’s stock
count

2. Item Quantities and
Costs

▪ Migrating item quantities must be
carefully planned since there could
be open transactions on the legacy
system which impact inventory when
they are migrated
▪ If perpetual inventory in use,
inventory G/L account will be
updated with inventory valuation
when quantities are migrated
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▪ Item quantities and costs must be entered into SAP Business One to reflect the
legacy system. The customer should freeze operations on the legacy system, and
perform a stock count first, so that item quantities are accurate.
▪ Migrating item quantities must be carefully planned since there may be open
transactions on the legacy system which may affect inventory levels once they are
carried over to the new system. For example, open deliveries which would release
inventory.

▪ The item cost is used for calculation of inventory valuation. If the system uses
perpetual inventory, the inventory G/L account will be updated when the item
quantities are migrated.
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Open Transactions

3. Open Transactions

Classify open transactions into:
Documents that do not
affect inventory or
accounting:

•
•
•
•

Documents that do not
affect inventory but do
affect accounting

• A/R invoices*
• A/P invoices*
• Payments, including down payments,
partial payments

Documents that will affect
inventory

• Deliveries**
• Returns**
• Credit notes**
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Sales Quotations
Sales Orders not linked to deliveries
Purchase Quotations
Purchase Orders not linked to goods
receipts
• Production orders
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▪ Open transactions are those that are currently in process on the legacy system.
▪ You should classify open transactions into:
▪

Open documents that do not impact accounting or inventory, such as sales
quotations, sales orders not linked to deliveries, purchase quotations,
purchase orders not linked to goods receipts, and production orders. These
are easily imported using the Data Transfer Workbench (DTW) tool.

▪

Open documents that do not affect inventory but do affect accounting
balances are A/R and A/P invoices and Payments. Care must be taken when
you import these documents since the invoices can affect inventory if there is
no preceding delivery or goods receipt imported. *Caution: SAP
recommends that these A/R and A/P invoices are imported as service type
invoices instead of item type documents to avoid the possibility of inventory
updates.

▪

Open documents that do affect inventory, such as deliveries, returns, and
credit notes. **Caution: SAP recommends that these transactions are not
migrated, since this can lead to an imbalance between stock quantities and
valuation. Instead the customer should try to invoice or close these documents
on the legacy system. If it is not possible, the customer should retain these
documents and process them on the legacy system until they are closed.

▪ Before you import transactional data, you must clarify with the customer if legacy
documents should be entered with the original number. If the customer needs the
original legacy numbers, use manual document numbers when importing the
documents.

91

Final Opening Balances

4. Final Opening Balances:
• Business Partner
Balances
• G/L Account Balances

▪

If item quantities and costs were imported in step 2, and
perpetual inventory is used, the inventory G/L account is
already correct and should be excluded in this step

▪

If all open invoices and payments were imported in step 3, the
A/R and A/P control accounts should be already correct and
should be excluded in this step

▪

Before transferring balances for bank accounts, customer
should reconcile bank transactions in the accounts:

• Cash and Bank Balances

•

If account can be fully reconciled, transfer the balance
amount

•

If account is not fully reconciled, need to post unreconciled
transactions individually
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▪ Lastly, enter the final opening balances for business partners and G/L accounts
including bank accounts.
▪ Important:
▪ If the item quantities and costs have been imported in step 2, and perpetual
inventory is used, the inventory G/L account is already correct, and should be
excluded to avoid duplicate updates.
▪

If all open A/R and A/P documents have been imported in step 3, together with
all partial payments, down payments, or payments in advance not based on
invoice, the final balances for business partners should already be correct. In
this case do not enter the balances for the A/R and A/P control accounts to
avoid duplicate updates.

▪

Before transferring the G/L accounts for bank accounts, the customer should
attempt to reconcile the transactions in the bank accounts. If the account can
be fully reconciled, you can transfer the balance. If there are unreconciled
transactions in the account, you need to post these transactions individually in
SAP Business One.
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Tools for Importing Opening Balances
Multiple tools are available for importing final opening balances and open transactions:
Type of Opening
Balance

Opening
Balance
Transaction

Data Transfer
Workbench

Import
from Excel
utility*

Manual Documents

Inventory

✓

✓
(Goods receipt)

✓

Goods Receipt

G/L Accounts

✓

✓
(Journal entry)

✓

Journal Entry

Business Partner

✓

✓
(Invoice, payment)

✓

Invoice, Payment, etc.

Open Documents

✓
(Order)
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Sales and purchase orders,
etc.
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There is no single approach to import opening balances. Multiple tools are available
in SAP Business One for importing final opening balances:
• Opening balance transaction is an easy to use tool built into the client and can be
used to enter inventory quantities and valuation, G/L account balances and
business partner account balances.
• Data Transfer Workbench (DTW) is a tool for import of bulk documents and can be
used to import goods receipts, journal entries, open transactions such as sales and
purchase orders, and open transactions that affect accounting, such as A/R and
A/P invoices. An advantage of this approach is that you have a document in SAP
Business One as the source. DTW requires a knowledge of the database table
structure.
• The Import from Excel utility is an in-built tool for import of master data. It
processes data from a Microsoft Excel spreadsheet. *It can also be used to
populate the opening balances transaction window for inventory, G/L accounts and
business partner accounts.
• Lastly, if data loads are low, you can manually enter the documents.
Note: In this course the focus is on the opening balances transactions. For more
information on DTW see the related course Using Data Transfer Workbench in this
training. For more information on the Import from Excel utility see the related course
Import from Excel in this training.
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Effects of Marketing Documents
▪

When you import or manually create marketing documents, postings are made to inventory and to various
accounts in the general ledger

Inventory
Sales Order



Delivery



A/R Invoice
A/R Invoice (with



BP balance

Revenue

Inventory accounts












no preceding
documents)
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When you import or create marketing documents such as sales and
purchase orders, and A/R and A/P invoices, be aware of the impact on
inventory and general ledger accounts. As an example:
• An imported sales order will commit stock from inventory
• An imported delivery for the sales order will affect the in stock
quantity and will make postings to inventory-related accounts in the
general ledger, including the valuation of inventory if continuous stock
is in use
• An imported A/R invoice for the delivery will post to the business
partner account, as well as revenue and tax-related accounts
• If you decide to import only the A/R invoice with no preceding
documents, the A/R invoice will make the postings and stock changes
that would have been made by the preceding documents.
If you are loading the transactions as part of the opening balances for a
new company, you must make sure that the documents you import are
not “double counted” in inventory.
When you import or create invoices you need to avoid “double entry” of
the control accounts when you enter the opening balances.
If you decide to import the A/R invoices as service-type invoices instead
of item-type invoices, you will avoid the stock postings, but there will still
be postings to the business partner and revenue accounts.
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Reconciliation Reports

SAP Business One

Legacy System


Inventory quantities and values



Inventory Audit Report



Business partner balances



Aging Reports



G/L Account balances



Balance Sheet / Profit & Loss



Open orders



Open Items List
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▪ Regardless of how you perform the migration of items, G/L accounts and business
partner balances, you need to reconcile the accounts between SAP Business One
and the legacy system. Print and retain a hard copy of all reconciliation reports
from SAP Business One and the legacy system to prove the migration correctness:
▪ To reconcile inventory quantities and values, run the Stock Audit Report. Match
the item quantities in SAP Business One with the quantities in the legacy
system.
▪ To reconcile business partner balances, run the Customer Receivables and
Vendor Liabilities Aging reports with a posting date range until the start of the
current fiscal year. Make sure the business partner opening balances in SAP
Business One align with the legacy system.
▪ To reconcile G/L account balances, run the Balance Sheet as per the first day of
the current fiscal year.
▪ If you migrated other open items such as sales orders and purchase orders, run
the Open Items List report in SAP Business One and compare with the
corresponding open items in the legacy system.
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Inventory Opening Balances

▪ In this section you will learn the tools for importing inventory quantities
and costs as opening balances.
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Inventory Opening Balance Transaction
Inventory > Inventory Transactions > Inventory Opening Balance






The transaction allows you to enter in
stock quantity and unit price for each
item, by:


Selecting item codes and entering
the quantity and cost for each item,
or



Importing rows into the grid using the
Import from Excel utility

You can select the price source as:


Item cost



Selected price list



Last evaluated price

If perpetual inventory in use, the
transaction posts to the inventory
account
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The opening balances transaction allows you to enter the in stock quantity and the
unit price for each item, from a single screen.
The transaction works in two ways:
• You can select items to populate the rows in the window, and then enter the
quantity and cost on each row, or
• You can choose Import Items to populate the entire row grid from a spreadsheet
(using the Import from Excel utility). See the related Import from Excel course for
more details.

The unit price might represent the cost of manufacturing the item, or cost of
purchasing the item. For a new implementation this price is taken from the legacy
system. The Price Source dropdown list lets you select the source:
• Item Cost: the price will be taken from the item master data
• By Price List: if you have already set up a price list for the item, the price will be
taken from the selected price list
• Last Evaluated Price: This is only relevant if a warehouse valuation report

was previously generated in SAP Business One
You also have the option to enter the item cost directly on the item row.
Tip: If you are using moving average valuation, you can create a price list with the
average prices from the legacy system and choose this price list in the opening
balances transaction.
When you post this transaction it updates the in stock quantity of each item (this is
reflected in the item master data). If you are working with perpetual inventory, it also
posts a journal entry to record the value of inventory.
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Inventory Opening Balance Transaction (Cont.)
Inventory → Inventory Transactions → Inventory Opening Balance
▪

▪

If item is managed by batch or serial number,
right-mouse click item row to enter applicable
batch or serial information
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If you select a bin location enabled
warehouse for an item you can enter the
bin location for the item
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▪ If the item is set to be managed with batch or serial numbers, you can
right-mouse click the item row and select serial or batch from the
context menu to enter the applicable serial numbers or batch
information.
▪ If you select a bin location enabled warehouse, the Bin Location
column becomes editable allowing you to enter the bin location holding
the item.
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Considerations for Perpetual Inventory
 If perpetual inventory is in use, you need to consider the valuation method so that the
valuation matches the legacy system
 Make sure this account balance is not entered again when entering G/L balances
Item Quantity
and Cost

Standard Cost: Moving Average: FIFO:
Unit Cost
Unit Cost
Unit Cost

5 @ 100

100

100

100

5 @ 200

100

150

200

1500

1500

Value of items 1000
in inventory
account

Note: the batch/serial number valuation is similar to FIFO
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▪ If perpetual inventory is in use in the legacy system, you need to consider each of
the valuation methods so that the valuation correctly matches the legacy system.
Also make sure the inventory account balance is not entered again

when entering G/L balances.
▪ Here is a simple example of how the valuation method can affect the unit price. In
the example, 5 items were purchased at a cost of 100, and another 5 items
purchased at a cost of 200.
▪ With standard cost valuation the item cost is fixed so you can use the cost
from the legacy system.
▪ With moving average the item cost for an item will be recalculated each time
based on the quantity, therefore you need to calculate the average unit cost
from the legacy system.
▪ With FIFO valuation you should enter the item cost multiple times with different
quantities using the cost price from each layer in the legacy system.
▪ Note that the batch/serial number valuation method is similar to FIFO, in that the
unit cost is kept at the level of the batch or individual serial number.
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Journal Entry
If perpetual inventory in use, journal entry updates the default inventory account defined in the
G/L account determination
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If perpetual inventory is in use, the journal entry updates the default inventory
account defined in the G/L account determination, and credits an offsetting account
that you specify in the right-hand column of the grid row. SAP recommends you
create an opening balances G/L account (usually in the equity drawer) and use this
offsetting account to ensure there is no effect on other general ledger accounts. The
offsetting account can be selected on each item row.
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Opening Balances for G/L Accounts

▪ In this section you will learn tools and best practices for entering final
G/L account opening balances.
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G/L Account Opening Balances - Introduction

Account Name

Debit

Credit

Assets:
Cash

150.000

Inventory

90.000

Receivables (A/R)

79.000

Equipment

51.000

 If go-live is during fiscal year, transfer profit &
loss accounts in addition to balance sheet
accounts

Liabilities:
Loans

28.000

Employees

125.000

Payables (A/P)

17.000

Equity:
Equity
TOTAL:

200.000
370.000

 If go-live is at start of fiscal year, conduct
period-end closing on the legacy system and
transfer only balance sheet accounts

 If you have already imported A/R and A/P
invoices, do not enter control account
balances
 If you have already imported item costs, do
not enter inventory account balances (for
perpetual inventory)

370.000
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▪ If the go-live occurs at the start of a fiscal year, conduct period-end closing on the
legacy system, then transfer the G/L account balances from the balance sheet
drawers.
▪ If the go-live occurs during the fiscal year, you need to transfer the balance sheet
accounts and the profit and loss accounts in addition. The customer should run the
P&L report for each period since the start of the financial year. This will allow you
to enter the balances for each period in SAP Business One.
▪ If you have already imported open A/R and A/P invoices, do not enter balances for
these control accounts.
▪ If you have already imported item costs, do not enter inventory account balances
again (for perpetual inventory).
▪ For more information, refer to the Data Migration Guide in the AIP materials.
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G/L Accounts Opening Balance Transaction
Administration → System Initialization → Opening Balances → G/L Accounts Opening Balance

To use the transaction:
▪

Select drawers from chart of
accounts

▪

Select opening balance
account

▪

Enter balance in account
row

▪

To spread balances over a
fiscal year, post balances for
each period

▪

Option to import
rows from
spreadsheet
into grid area

If Display Credit Balance
with Negative Sign checkbox
is enabled, enter a minus
sign for credit balances.
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▪ The G/L accounts opening balance transaction in SAP Business One allows you to
enter the opening balance for each G/L account on a row in a single screen. You
can use and follow the trial balance from the legacy system.
▪ When you open the transaction the window is populated with the accounts from the
drawers that you select.
▪ You must first select an opening balance account. This acts as the offsetting or
balancing account for the posted journal entries, and should end up with a zero
value after all the G/L balances have been entered from the legacy system.
▪ Although a separate journal entry is posted for each account row, the posting date
is the same. Therefore you need to decide whether to enter the balances spread
over a fiscal year, for example, you can divide the balances by posting period, and
post for each period with the posting date set to the end of the month. You can
enter several balances with different dates for the same account.
▪ When entering opening balances, you must enter the minus sign for credit
balances if the Display Credit Balance with Negative Sign checkbox is set in
Company Details.
▪ The Import from Excel button provides a way to populate the grid area (rows) of
this transaction from a spreadsheet. See the related course Import from Excel for
more details.
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Result – G/L Accounts Opening Balance Transaction
Separate journal entry posted for each G/L account row:
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▪ The transaction posts a separate journal entry for each account row.
▪ The Origin of the opening balance journal entry is ‘OB’ which helps you to identify
these journal entries for reporting.

104

Opening Balances for Business Partners

▪ In this section you will learn about tools for entering business partner
opening balances.
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Business Partner Opening Balances
Administration → System Initialization → Opening Balances → Business Partners Opening Balance
▪

Alternative to importing invoices and
payments

▪

Window is populated with selected
business partners

▪

Select a clearing account and enter
the balance for each business partner
on a row, with the correct due date
for aging. Make sure the relevant
posing periods are open

▪

If the business partner account
contains multiple transactions you
can rerun the transaction

▪

If Display Credit Balance with
Negative Sign checkbox is enabled,
enter a minus sign for credit
balances.
106

Option to import
rows from
spreadsheet
into grid area
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▪ The business partners opening balance transaction is an easy to use tool, and an
alternative to importing invoice documents and payments using DTW.
▪ When you open the transaction the window is populated with the selected business
partners. You first need to select an opening balances clearing account which is
used in the journal entry as the offsetting account.
▪ If possible use the aging report from the legacy system. You enter the legacy
account balance on a row for each business partner, with the correct due date for
aging. To support aging in the new system, you should specify the accurate due
date for each transaction. Note: make sure that the posting periods in SAP
Business One are open so that postings can be made with the original due dates.
▪ The default control account from the master data is selected on the row, but you
can select a different control account if necessary from the list of defined control
accounts.
▪ If the business partner account contains multiple transactions with different due
dates, you can enter each transaction separately by rerunning the opening balance
transaction. You should also enter a row for any business partner prepayment or
down payment.
▪ If you are starting in the middle of the financial year and you want to see beginning
balances from the start of the year in SAP Business One, you must enter the
opening balances for each business partner as of the last day of the previous year,
and then enter a delta balance for each business partner for each successive
posting period.
▪ There is an option to import data into the grid of the transaction using the Import
from Excel utility.
▪ Note: If the Display Credit Balance with Negative Sign checkbox is enabled in the
Company Details setup screen, enter a minus sign for credit balances.
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Result – Business Partners Opening Balance Transaction
▪ Journal entry posted for each row. The business partner balance in the account is updated.
▪ The journal entry can subsequently be selected for matching payments and also appears in the
aging report.

Journal entry in
business partner
account (identified
with origin OB)
Due date reflected
in aging report
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▪ When the opening balances are posted a journal entry is created for each row and
the business partner account is updated. The origin code of the journal entry is OB,
which helps you to identify these opening balances journal entries. The journal
entry can subsequently be selected for matching payments.
▪ If the system currency differs from the local currency, the balances are converted
automatically. The data is displayed in the Balance (SC) column. If accounts were
defined as foreign currency accounts in the chart of accounts, the OB (FC) field is
enabled for input.
▪ The journal entry also appears in the aging report with the due date entered on the
row.
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Summary
Key points from this topic:
▪ The goal of opening balances is to match the financial reports of the legacy system and the SAP
Business One system.
▪ SAP recommends that you migrate opening balances in a certain order:
▪
▪
▪
▪

Final master data
Item quantities and costs
Open transactions
Final balances for business partners, items, and G/L accounts (including bank transactions)

▪ During cutover, the legacy system is frozen and stock is counted. Open transactions should be closed
if possible. Business partner and bank accounts should be reconciled.
▪ To import opening balances you can use the opening balances transactions for items, business
partners and G/L accounts. There is also an option to import the rows from a spreadsheet using the
Import from Excel utility. Each balance results in a journal entry with origin OB, so they can be traced.
▪ You can use the Data Transfer Workbench (DTW) to import open documents such as sales and
purchase orders, invoices and payments. The result is a document in the new system.
▪ For more details on entering opening balances, see the Data Migration Guide in the AIP materials.
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Here are some key points to take away from this topic.
• The goal of entering opening balances is to match the balance sheet and
the Profit & Loss reports of the legacy system and the new SAP Business
One system.
• SAP recommends that you migrate final opening balances in a certain
order:

•

•
•

•
•

• Final master data
• Item quantities and costs, based on an inventory stock take
• Open transactions such as sales and purchase orders, A/R and A/P invoices,
production orders, bills of materials, etc.
• Final balances for business partners, items, and G/L accounts.
The cutover period is a crucial time when the legacy system is frozen, stock is counted,
and final balances are entered for inventory, business partners and G/L accounts. In the
legacy system, the client should close as many open existing transactions as possible,
and business partner accounts should be reconciled so that only open invoice balances
and prepayments that are not based on an invoice need to be transferred. Item
quantities and costs must be entered before open transactions that release inventory
can be imported.

There are multiple options to enter opening balances, and you should
discuss the options with the customer.
You can use the Opening Balances transactions for inventory, business
partners, and G/L accounts. There is an option to import the rows from a
spreadsheet using the Import from Excel Utility. Each balance results in a
journal entry with the origin OB, so they can be easily traced in the new
system.
You can use the Data Transfer Workbench to import open documents
such as sales and purchase orders, invoices and payments, if it is
preferable to have a document as a source in the new system.
For more details on a structured approach to entering opening balances,
refer to the Data Migration Guide from the AIP methodology.
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Implementation Tools:
Quick Copy
SAP Business One Version 9.3

PUBLIC

▪ In this topic, we will look at how to select and copy database records
between SAP Business One company databases.

109

Objectives

▪

At the end of this topic, you will be able to select and copy records between
SAP Business One company databases using the Quick Copy tool
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This topic covers the use of the Quick Copy tool during an implementation project. On completing this
topic, you will be able to select and copy records between SAP Business One company databases.

Business Scenario

▪

During an implementation project you will
typically use and create multiple company
databases

▪

You will need separate database for testing
and training purposes

▪

Quick Copy allows you to quickly copy
subsets of data to other databases (individual
records or categories of data)

Use for requirements
gathering

Demo
database

Production
database

Copy Data

Training database
(for hands-on
exercises)
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Test database
(for system testing)
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Quick Copy is a very useful tool during an implementation project. During the implementation project you
will typically create multiple company databases. For example:
•
A new production database that you will configure for the customer
•
A copy of the production database for testing
•
A copy of the production database for training
The Quick Copy tool enables you to quickly copy subsets of data from the production database to other
databases. You can select individual records or entire categories of data.
For example, you might want to copy master data records and configuration settings from the production
database to a test database. Or you can copy recent customizations you make on the production system
to another database for testing and validation.
Note that Quick Copy is not a full database copy. You still need to maintain full database backups for
recovery purposes.

Implementation Center
Administration > System Initialization > Implementation Center > Implementation Tasks >
Data Management tab
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Quick Copy is one of the tools provided in the Implementation Center in SAP Business One.
To launch Quick Copy, choose Copy Data Between Companies.
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Quick Copy Overview
▪

Direct copy from source to target database (same version required)

▪

Indirect copy (using an intermediate file)
Target companies

Direct copy to company
Source
company
Copy to File

*.xml

Copy from File

*.qdf

Project file with
saved category
selections
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Quick Copy allows you to:
• Copy directly between company databases. The database version of the target company should
match that of the source company.
• Copy indirectly via an intermediate file. If you choose indirect copy, Quick Copy saves the selected
records in a file with the extension .qdf. You then login to the target company and run the import
using Quick Copy.
The company database that you are currently using is the source.
For direct copy, you will be prompted to select the target company on the database server and provide
the login credentials.
For indirect copy, you will create the qdf file on the source, then login to the target company to import
the qdf file.
You can optionally save an xml project file containing your data category selections and copy options.
You can use this project file the next time you use Quick Copy, saving you from having to make the
selections again.

113

Copy Options

114

Quick Copy Window
Quick Copy window has two
sections:
▪

Data categories are shown
on the left

▪

Options for the copy are
shown on the right

▪

Data categories are
blocked from selection until
you select all the required
options and choose OK
(the OK button is not active
until the required options
are set)

Categories are
initially blocked for
selection
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When you open the Quick Copy window you can see that the categories of data are shown on the lefthand side of the screen. The categories are initially blocked for selection until you select or set options
on the right-hand side of the window.
After you make selections on the right side of the window, the OK button becomes active.
Choose the OK button, and the data categories will open up for selection.
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Options for Quick Copy
Source or
Target

Select:
▪ Copy to File to copy records to an
intermediate file (*.qdf)
▪ Copy from File to import records to a
target company from a qdf file
▪ Copy to Company to copy directly

Copy Method

Defines how the import will insert or
update records in the target database.
Not applicable for Copy to File.

Error
Handling

Defines how the system will handle
errors encountered during either the
copy or import process

Copy Options Defines various options for the import.
Not applicable for Copy to File.
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There are four sections with options:
 Select the copy function and browse to choose the qdf file or the target company database.
 Select the copy method (this applies only for Copy from File or Copy to Company)
 Set options for handling errors.
 Select the copy options (for import to the target company).
Once you have made these settings, and choose the OK button, the data categories on the left-hand
side of the screen will open up for selection.
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Copy Methods

Add new records and update existing records that have a matching key
And new records only but do not update records with a matching key
Only update existing records with a matching key
Erase all records for the categories before adding new records
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The copy method works as follows:
 Add new records and update existing records that have a matching key
 Add new records but not update records with matching keys
 Only update existing records with matching keys without adding new records
 Erase all existing records for the categories in the target database before adding new records
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Understanding Copy Methods
The effect of each copy method on the target database is shown here:
The source database T1 has four records (keys 1, 2, 3 and 4). The target database T2 has three records
with matching keys 1,2 and 3.
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This slide shows the effect of each of the copy methods on the target company database:
•
Add New Records and Update Existing Records: In the example, a new record is added to the
target database T2 with key 4. The records with matching keys 1, 2 and 3 will be updated with the
values from the source database T1. Notice that the content for record keys 1, 2 and 3 has
changed.
•
Add New Records Without Updating Existing Records: In the example, a new record is added to
the target database T2 with key 4. However, unlike the first method shown above, in this case the
records with keys 1, 2 and 3 are not updated.
•
Update Existing Records Without Adding New Records: This method does not add any new
records so record key 4 is not inserted in the target database. The records with matching keys 1,
2 and 3 will be updated with the values from the source database T1.
•
Delete All Records Then Add New Records: This option deletes data for a matching key, then
adds new records.
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Error Handling

Error handling choices govern Quick Copy response while importing records:
▪ Ignore errors and continue copying valid records
▪ Terminate the copy process after a specified number of errors
▪ If the records contain UDFs, but the target system does not, you can elect to skip the records, or, copy them
and ignore the missing UDFs
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The error handling choices govern the Quick Copy response to an error while importing the records.
You can choose to:
 Skip the affected record and continue copying valid records, or
 Stop the copy process when the number of errors reaches a specified limit
If the objects to be copied contain user-defined fields (UDFs), and the target system does not contain
the UDFs, you can elect to skip the records, or to copy the records and ignore the missing UDFs:
• If you select the Copy Records and Ignore Missing UDFs option, the application copies records
even when user-defined fields in the source company are missing from the target company.
• If you select Do Not Copy Records with Missing UDFs, and for example, the master data in the
source company contains a UDF that is not present in the target company, the copy operation will
fail.

For example, the BP table in the source company contains a user-defined field, whose definition has
not been copied to the target company. If this field is not selected, when you try to copy BP records to
the target company, the copy operation fails.

119

Copy Options

▪ If objects to be copied contain accounts, you can choose to copy the accounts to the target, or assign default
accounts from the target
▪ If the objects contain empty fields, you can choose to skip copying the field and leave the original value in the
target, or overwrite the target field with empty values
▪ Option to force backup before the import starts
▪ Option to copy to target even when there are active connections
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Many database records contain assigned accounts. The copy option for accounts can be chosen to:
 Use Accounts in Source – If the source accounts also exist in the target, then the application
copies the account assignments from the object in the source to the object in the target.
However, if the source accounts do not exist in the target, then the application encounters an
error during the copy process.
 Use Default Accounts in Target – The application assigns the default accounts in the target to
the object, and does not copy the source assignments. Note: If default accounts are not
configured in the target company, and you select this option, then the account fields of the object
in the target are empty after the copy process.
The copy option for empty fields only affects updates:
 Do Not Overwrite Target Fields and Keep Original Values – If a field in the source is empty, then
the application skips copying this field. The application keeps the original value of the
corresponding field in the target, which remains the same before and after the copy process.
 Overwrite Target Fields with Empty Values – If a field in the source is empty, then the application
overwrites the target field with empty values.
You also have the option to:
• Enforce a backup before the import starts. If you select the Enforce Backup Before Starting Copy
Process checkbox, the import will not proceed if the target database has not been backed up within
two hours.
• Allow the import of data to the target company database, even when there are user connections to
it.
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Categories and Dependencies
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Category Structure

▪

Categories are shown in a tree
structure that when expanded follows
the SAP Business One menu
structure
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You select data from a category tree structure that when expanded follows the SAP Business One
menu structure. Note that the structure does not change from company to company.
The categories cover customizations (including queries and reports), administration and configuration
settings, financial settings, business partner master data, inventory (including item master data and
price lists), resource and production master data, and human resource master data.
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Selecting Data for the Copy
▪

Select the categories required for copy

▪

The system shows data dependencies and you can
choose to continue with the copy process, or adjust the
selected categories
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You can select one or more categories at the top level of the category tree or at a lower level.
Choose the copy button to initiate the copy process.
The system first checks data dependencies and will show dependent objects that will be automatically
copied together with the data you selected.
You can choose to continue with the copy process or cancel and adjust your selected categories.
Note: If the target database already contains records that reference G/L accounts , for example,
business partner and item master data, journal entries posted by transactions, then you will not be able
to import the chart of accounts from the source database
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Viewing and Selecting Records to be Copied
▪

Before you run the copy you can view all records for a category

▪

You can deselect individual records from the copy process
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▪ To see the eligible records that you can copy, select the row for the object at the lowest level in a
category. The list of records is shown on the right.
▪ You can individually deselect records that are not required for copy.
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Dependent Categories

Inventory > Item Master Data



Item Groups
Price Lists
Customs Groups



Manufacturers
Business Partner Master Data

etc.

BP Groups
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When you select a category, there might be data dependencies on other categories. For example, the
item master data category has dependencies on business partner master data (vendors or resellers)
as well as item groups and price lists.
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Dependent Categories (Cont.)
▪ When you select an object or category, possible dependencies on
other categories are marked
▪ Marked dependencies are derived from the database structure and
are provided as a warning

! Selected category is dependent up on other
categories
! Other categories are dependent on this
category
(!) Other categories are dependent on a category
deeper in the structure
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The Quick Copy tool indicates possible dependencies on other categories. These dependencies are
derived from the database table structure, and not from the actual data records to be copied, and are
therefore provided as warning for you to check if records in the marked category should also be copied.
In the example shown, the item master data category is selected:
 A black exclamation mark ‘!’ indicates that the item master data category is possibly dependent
on other data categories.
 A red exclamation mark ‘!’ indicates for an unselected category that the selected item master
data category is possibly dependent on this category. In the example, the categories Bar Codes,
Bin Location Master Data, and Price Lists are possibly dependent on the item master data
category. Again this information is derived from the database table structure and may not
represent the actual data.
 When you see a category marked with red parentheses ‘(!)’, this indicates that the possible
dependencies are deeper in the category structure. You can expand the category to see the
dependent objects within its structure. In the example the Administration, Financials and
Business Partners categories possibly have dependencies on the selected category, at a deeper
level within the category.
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Viewing Dependent Records
▪ During the copy process, the system displays actual dependent objects dynamically derived from the
data records to be copied
▪ Dependent objects are automatically selected for copy with the other data
▪ Links are provided to view dependent records
▪ If you deselect a dependent object, copy may fail
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During the copy process, the system displays the real dependent objects, dynamically derived from the
data records to be copied. These dependent objects are automatically selected for copy with the other
data.
Links are provided to view the dependent records, enabling you to decide whether to include them in
the copy.
Be aware that if you deselect a dependent object, the copy may fail.
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Copy Log
▪

Log shows number of records copied, number of records filed, number of records not copies, and a
link to drill down to records
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The copy process may take a long time if you are doing a direct copy and there are many records. For
this reason it may be better to copy to an intermediate file so that you can perform the import at any
time.
After the copy, the system provides a full log record of the number of records copied, the number of
records that failed, and the number of records not copied, together with a link to the records.
Note: if you chose the option to stop after 1 error, you will only see records copies up to the point of
failure.
In the example, shown, we can see the number of records copied for the selected Customization and
Item Master Data categories, plus the dependent data categories. And we can drill-down to see the
codes of the copied records.
Since the report shows an error on Bin Location master data, we can drill down to see the reason why
this failed.
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Quick Copy Window (cont.)
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▪

Icon bar displays when Quick Copy
window open

▪

Contains icons to view and display
project files and log files

▪

Toggle dependencies on and off

▪

Access the copy options in the
right-side of the window

▪

View online help
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When the Quick Copy window is open you see a new icon bar in the client application.
The icons enable you to:
•
Open a previously saved project XML file
•
Save a new project file
•
Toggle on and off the display of dependent categories
•
Show the copy options in the right-side of the window. These options become hidden when the
copy process has run, so you can use this icon to view them again.
•
View the online help for Quick Copy
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Saving a Project File
▪ Option to save settings and selected categories in a project file (XML)
▪ To reuse the project file, choose the toolbar icon
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The XML project file contains the saved data categories and the selected copy options (copy methods,
error handling, etc.). This file can be reused and can save time if you repeatedly need to export the
same types of data.
The system will prompt you to create a project file if you close the Quick Copy window, or you can
choose the save icon from the icon toolbar.
You can also create and save a project file when you import on the target company.
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Summary
Here are some key points:
▪ Quick Copy allows you to selectively copy data records from one company database to another
▪

Quick Copy is useful during an implementation project for copying customizations and
configuration information, and master data, to a test or training system or to a different company
entity

▪

You can copy directly, or copy to an intermediate file:
▪

For direct copy, both companies must have the same product version

▪

The intermediate file has the extension qdf

▪

You can select one or more categories for copy. Note: Categories are not selectable until you
complete all the required copy options on the right-side of the window.

▪

To see eligible records for copy, select the object row in the category hierarchy. You can deselect
individual records.

▪

When you select a category for export, Quick Copy automatically marks dependent objects.
During the copy process the dependent objects are also selected for copying.

▪

You can optionally save the selected categories and settings in an xml file, for repeat use.
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Here are some key points to take away from this session.
 Quick Copy allows you to selectively copy data records from one company database to another.
 The tool is useful during an implementation project for copying customizations and configuration
information, or master data, to a test or training system, or to a different entity for the same
company.
 You can copy directly, or copy to an intermediate file:
•
For direct copy, both companies must have the same product version
•

The intermediate file has the extension qdf



You can select one or more categories for copy. Note: Categories are not selectable until you
complete all the required copy options on the right-side of the window.
 To see eligible records for copy, select the object row in the category hierarchy. You can
deselect individual records.
 When you select a category for copy, the Quick Copy tool automatically marks dependent
objects. During the copy process the dependent objects are also selected for copying.
 You can optionally save an XML project file containing your selected data categories and copy
options. This can save time if you repeatedly need to export the same types of data.
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System Setup and Administration:
Users and User Groups
SAP Business One Version 9.3

PUBLIC

▪ This topic covers user accounts, default settings for users, and user groups.
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Objectives

Objectives:
▪ Define and manage accounts and default settings for users of SAP
Business One
▪ Designate a user as a super user or a mobile user
▪ Explain the concept of a user group and how they work
▪ Manage user passwords and define a company-wide password policy
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▪ On completion of this topic, you will be able to define and manage accounts and default settings for
users of SAP Business One.
▪ You will also be able to designate a user as a super user or a mobile user.
▪ You will be able to explain the concept of a user group and how these groups work.
▪ Lastly, you will be able to manage passwords for users, including the definition of a company-wide
password policy.
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Business Example

DG Industries has 15 users in the sales department. Each of these users works with the
same forms and menus, and needs the same form settings for documents, the same UI
look-and-feel, and similar requirements for print settings
The company wants to enforce a strong password policy, requiring users to select a
password of a set minimum length.
Solution:
▪

Define a common set of user defaults and assign to each
user account

▪

Define common form settings for one user and copy to the
other user accounts (or to a user group)

▪

Define a common set of UI changes and assign to each user
account (or to a user group)

▪

Define a custom password policy for the company.
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▪ DG Industries has 15 users in the sales department who need to access SAP Business One. These
users work with the same forms and menus.
▪ When processing sales documents, the users need to have the same form settings for documents,
the same UI look-and-feel, and similar requirements for print settings.
▪ The company wants to enforce a strong password policy, requiring users to select a password of a
set minimum length.
▪ Solution:

▪ Define a set of common defaults for display and print settings and assign to each user account
as User Defaults
▪ Set up one user account with the required form settings, then copy the form settings to the other
user accounts (or to a user group)
▪ Define a common set of UI configuration changes in a UI Template, then assign to each of the
user accounts (or to a user group)
▪ Define a custom password policy in SAP Business One.
▪ Note: User Groups can speed up the assignment of common settings, including general
authorizations, to multiple users. User groups will be discussed in this course.
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User Accounts
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User Accounts
Each user needs an account. In addition, a user cannot access any functionality until they have been
assigned both the correct license and general authorizations.
Authorizations

Linked Records
User account
Sales employee/ Buyer

License

Employee Master Data

General Authorizations

Form Settings
User Defaults

Personalization
UI Configuration
Dashboards
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To work with SAP Business One, a user needs an account. The user account contains the userid,
password and other details.
Even with an account, a user cannot access any functionality until they have been assigned both the
correct license and general authorizations:
▪
The license allows legal use of the software
▪
General Authorizations permit access to functions and menus in SAP Business One according to
the user’s license type and can be further refined by role
The user’s account is associated with personalization options such as form settings, user defaults, UI
configuration templates, and cockpit dashboards.
The user account can be optionally linked to an employee master data record for HR purposes and for
another type of authorization – data ownership.
The user account can be linked to a designated sales employee or buyer which is entered into
marketing documents.
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User Account Setup
Administration  Setup General  Users
▪

To create a user account, enter the details in
the Users – Setup window

▪

The User Code must be unique and is case
sensitive

▪

After you have saved the window you cannot
change the user code

▪

To enable single sign-on (SSO), enter the
Microsoft Windows domain and user account

Note:
▪

You have the option to generate a user account
using information from the employee master
data.
▪ You can also access this setup screen from the
Express Configuration Wizard
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To create a user account, choose the path shown in the slide and enter the user details. The user
code must be unique, up to 8 characters, and is case sensitive. Once saved, the user code cannot be
changed.
To enable the user to login with single sign-on (SSO), enter the Windows domain and account name.
You must also enable single sign-on functionality in the System Landscape Directory (SLD). As a
result, users can access SAP Business One without entering their user code and password. If you want
to use the single sign-on function for SAP Business One, version for SAP HANA, you must choose
domain user authentication and specify the domain name and user during the installation of the SAP
Business One server components.
Note:
▪ If you create employee master data first, you have the option to generate the user account when
you create the master data
▪ You can access the user setup window from the Express Configuration Wizard. See the related
course in the Implementation Tools curriculum.
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Account for Super User

▪

Select the Superuser checkbox to designate a super
user

▪

A super user has by default authorization to every
function in the system - you cannot edit general
authorizations for a super user

▪

This account must be assigned a Professional
license

▪

Non super users have no authorization to any function
by default and you need to set general authorizations
for each user
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▪ If you check the Superuser checkbox in the user account, the user becomes a super user. A super
user has by default full authorization to every function in SAP Business One and must be assigned
a professional license. You cannot edit the authorizations for a super user account.
▪ If you do not check the Superuser checkbox, the user by default has no authorizations to any
system functionality. General Authorizations must be set for each user to every function that the
user will work with. You can assign a limited license to this user or a professional license.
▪ A super user can create new user accounts, reset the passwords of other users, and assign
licenses and authorizations for other users. During the implementation project the super users will
be nominated and should receive training in all system and administration functionality.
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Account for Mobile User
▪

Select the Mobile User checkbox to enable access
using the mobile apps for IOS and Android

▪

Enter mobile phone number and device ID

▪

Install the integration framework of SAP Business
One and activate the sap.B1Mobile scenario

▪

Assign a B1i license to the mobile user in addition to
the contracted license
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▪ To enable a user to access SAP Business One using the mobile apps for IOS and Android, select
the Mobile User checkbox. The mobile phone number is mandatory in the user account as the user
must enter this number when they logon from the phone. If the device has no phone number, for
example, an iPad, choose a fictitious mobile phone number.
▪ You must also enter the ID of the user's mobile device, which is a unique MAC address. To find the
device ID, launch the SAP Business One mobile app on the device. In the Logon page, tap Settings.
The device ID appears in the Device ID field, in the Logon Settings section.
▪ The mobile apps use the Web services of the integration framework to connect to the database.
Therefore you must install the integration framework of SAP Business One. This is free and
distributed with the SAP Business One installation software. You also need to activate the mobile
scenario sap.B1Mobile within the integration framework.
▪ The integration framework uses the B1i user to connect to SAP Business One, for example for
authentication when using the mobile solution. You need to assign a B1i license to the user. This
license is free but must be assigned in addition to the contracted license.
▪ Consult the relevant user guides on IOS and Android for more information on using the mobile
apps.
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Employee Master Data and User Account
▪

Employee master data is used to define organizational hierarchies,
teams, department and branches

▪

Employee record and user account can be linked, for ease of
maintaining user records
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▪ Employee master data is used to define organizational hierarchies, teams, department and
branches. These relationships are used for data ownership authorizations.
▪ The employee record and the user account can be linked using the User Code in the employee
record and the Employee name in the user account. This can make it easier to maintain and update
user records.
▪ Many fields are common between the employee master data and the user account. When you add
an employee master data record, the system will prompt you to automatically create a user account
if one does not exist. Various fields from the employee record are copied over to the user account
and the two records are linked.
▪ If a user account already exists, you can have common fields copied from the master data to the
user account.
▪ When the records are linked, if you enter additional data in the user account, the system will copy
the data over to the employee record, and vice versa.
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Removing an Account

▪

To delete a user account, open
the user account and choose Data
> Remove

▪

Remember to remove the license
assignment prior to deleting the
account

▪

The system will not let you create
a new account later with the same
user code
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▪ Over time it may be necessary to remove user accounts. To do this, select the user account then
open the Data menu and choose Remove.
▪ Remember to remove the license assignment prior to removing the account to avoid misallocation
or orphaning of licenses.
▪ Note that the system will not let you create a new account later with the same user code (the record
is still kept in the database).
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Predefined Users

▪
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At installation time, predefined user accounts
are created and reserved:
▪

Manager

▪

B1i

▪

Workflow

▪

AlertSvc

▪

Support
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When SAP Business One is installed, some predefined user accounts are created and reserved:
▪
The manager user is created when the company is first created.
▪
The B1i user is created when the integration framework of SAP Business One is selected for
installation. This is the technical user account used internally by the integration framework to
connect to SAP Business One.
▪
The Workflow user is created when the Workflow service is installed. The Workflow service
allows companies to design and execute standard business processes consisting of tasks and
business logic. The Workflow user is used to connect from the service to the company database.
▪
The AlertSvc user is automatically created at installation time. This internal technical user
ensures that the alert service sends alert notifications to a user even if the user is not logged in
to SAP Business One. See the related topic on Alerts for more details.
▪
The Support user is available when Remote Support Platform (RSP) is activated on the
customer’s server. It provides a way for a support consultant to log in and access a company’s
system to perform maintenance and support, without the need for a license.
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Assigning a License
Administration  License  License Administration
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▪

Each user must be allocated a license

▪

Mobile users must in addition be assigned
B1i license
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▪ Each user must be allocated a license to use the system. To assign a license, select the user code
then select the type of license from the available, purchased licenses. Each time a license is
assigned to a user the number of available licenses is reduced.
▪ Mobile users also must be assigned a B1i license which is free, and which allows the use of the
integration framework for mobile web apps.
▪ Notice that you can import the license file from this screen. The license file is sent to you by SAP
and contains the licenses you have purchased for the customer.
▪ For more information on licensing, see the license guide.
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User Groups
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User Groups

▪

In the user account, you can
optionally assign the user to a
user group

▪

User group is list of users with
similar characteristics

▪

User groups operate on the
concept that users with the
same role require similar
settings
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In the user account you can optionally assign the user to a user group. Essentially a user group is a list
of users who share common requirements, for example, form settings or general authorizations. The
idea is to assign common settings at the group level instead of to each individual user.
User groups operate on the concept that employees in a company can be grouped according to their
roles or functions they work with (for example, sales people, accountants, and managers). Generally,
users with the same role require similar:
• General authorizations
• Alert notifications
• Form settings
• UI look-and-feel settings
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Creating User Groups
Administration  Setup General  User Groups
Choose Create Group button

Choose Group Type and add users by name

Before creating a user group you
should identify users with similar roles
and responsibilities so you choose the
correct type:

© 2018 SAP SE or an SAP affiliate company. All rights reserved. ǀ PUBLIC

▪

Authorization

▪

Alerts

▪

Form Settings

▪

UI Configuration Templates

▪

Cross All Types
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To create a new user group, open the menu shown in the slide and choose the Create Group button
(or press Ctrl +A to switch to add mode).
A user group can be of type Authorization, Alerts, Form Settings, UI Configuration Templates, or Cross
All Types. Before you create a user group you should identify users with similar roles and requirements
so you can create a group with the correct type:
▪ Authorization. For users who share the same general authorization requirements. For more
information on authorization user groups, see the related course General Authorizations.
▪ Alerts. For users who need the same alert notifications. For more information on alerts, see the
related course Alerts.
▪ Form settings. For users with common forms settings per document. Form settings for one user can
quickly be copied to the users in a user group.
▪ UI configuration templates. For users with common UI look-and-feel requirements. For more
information on UI configuration templates user groups, see the related course UI Configuration
Templates.
▪ Cross All Types. For users who share common settings in more than one of the other group types.
You then add users to the group by selecting from the list of users. You can optionally set a valid date
range for the new group. For example, you can predefine a set of authorizations for a group and
activate them at a later date.
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How User Group Types Work
User groups appear in related configuration windows according to the type:
Window
Group Type

Authorization

General
Authorizations

Alerts
Management

Copy Form
Settings

X

Alerts

X

Form Settings

X

UI Configuration Templates
Cross All Types

UI Configuration
Template

X
X

X
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X
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User groups appear in related configuration windows according to the type:
• Authorization groups appear in the General Authorizations window, allowing you to assign
authorizations simultaneously to everyone in the user group.
• Alert groups appear in the Alerts Management window when you configure a new alert, allowing you
to assign all the users in the group to receive alert notifications.
• Form settings groups appear in the Copy Form Settings window, allowing you to simultaneously
copy form settings from a source user to all users in the group.
• UI Configuration templates groups appear in the UI Configuration Template setup window, allowing
you to assign a UI template simultaneously to all the users in the group.
• Cross All Types groups appear in all four configuration windows. This allows you to assign the
users in this group in any one of the configuration windows.

147

Example: Form Settings User Group
To assign form settings with a user group:
▪ Create the user group with type Form Settings or Cross All Types and add the users
▪ Login as one of the users and set the form settings
▪ Choose the Copy Form Settings button from that user’s account
▪ In the Copy Form Settings window, choose the Groups tab and select the predefined group
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To assign form settings with a user group:
•
Create the user group with the type Form Settings or Cross All Types and add the users to the
group
•
Login as one of the users and set the form settings for the documents
•
Choose the Copy Form Settings button from that user’s account
•
In the Copy Form Settings window, choose the Groups tab and select the predefined group. The
group members will receive the same form settings.
To see how authorization user groups work, see the related course on General Authorizations.
To see how UI configuration templates user groups work, see the related course on UI Configuration
Templates. To see how alerts user groups work, see the related course on Alerts.
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User Settings and Defaults
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User Settings (General Settings)
▪
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You can define default settings for login
sessions, display, and font and
background on the Services, Display, and
Font & Bkgd tabs of the General Settings
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In the General Settings you can define the default settings that will be applied to user accounts. These
settings include actions at the start of each login session, display language, date and time formats, and
fonts and backgrounds.
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User Settings (User Defaults)
Administration  Setup General  User Defaults
▪

User Defaults include display, date and time format, language and
font, and print settings

▪

Defaults are assigned to users with similar requirements in these
areas

▪

Note: Print settings are selected per document and override similar
per document settings in the Print Preferences window
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▪ In the User Defaults screen, you can define a set of default settings and assign them to user
accounts. You assign a code to the set of defaults, and then select the code in the user account.
▪ An example might be to set up common defaults for users who work in the same local department,
or who work with the same warehouse.
▪ The settings include date and time formats, the display color, language and font, plus accounts used
for cash and checking, default warehouse, and so on.
▪ On the Print tab you can define print actions on a per document basis. These include the number of
copies and remarks for printing, as well as actions that are taken automatically when adding a
document, such as an email or export to PDF. In the slide example, the options to automatically
export and e-mail a sales quotation as a PDF are selected for that document. Note that similar per
document settings can be made in the Print Preferences  Per Document window. These user
defaults settings take priority over the setting in print preferences.
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User Settings (User Defaults) Cont.
. . . and the path to an attachments folder for the
users

User defaults also cover credit
card settings . . .

Note: The path to the
parent attachment
folder is defined in the
General Settings. In
the User Defaults
window you can assign
a sub-folder as the
attachments folder
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User defaults also cover credit card G/L accounts, and allow you to set up separate attachment folders
for different group of users.
The attachments folder is used when a user:
▪

Exports a document as a PDF

▪

Attaches a document to an email

▪

Adds an attachment to a document, activity, business partner or other form that has an
Attachments tab.

The path to the company-wide attachments folder must first be defined in the General Settings (Path
tab). Then you can define sub-folders of the main attachments folder and assign the path to the subfolder for a set of users.
You should determine an appropriate schedule for backing up the attachments folders. You can
schedule backup of the attachments folders using the Remote Support Platform (RSP) tool.
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User Defaults (User Account)

User Account

User Defaults

General Settings
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Some of the default settings for users can be changed by the user for their own account.
Users can open their account using the My Personal Settings icon.
Not all settings are available in the user account, but when they are, these settings override the same
settings defined in the user defaults or in the General Settings. Thus the narrowest settings take
precedence over the wider settings.
A user can change settings in the General, Services and Display tabs of their account. One important
setting that a user can control is the ability to use the enter key on a numeric key pad as a tab key so
that the user can move between fields in a document for faster data entry. Note that this setting only
applies to a keyboard that has a numeric key pad.
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Password Administration
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Password Policy
Administration Setup  General  Security  Password Administration
▪

Password policy applies to all users and dictates the strength of password and how often it needs to be
changed. The security level selected in this screen is applied to the system

▪

Low, medium, high and custom policy options

▪

Password example shown to user as template for creating a new password
Default policy

Custom policy (example)
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▪ Password administration is typically done by the super user.
▪ A default password policy is supplied to enforce password compliance. The default policy is
available under the password administration function. Only super users have access to this function.
▪ The password policy applies to all users and dictates the required strength of the user password,
the composition of characters, and how often it needs to be changed.
▪ You can select low, medium, high or enter custom settings for the password policy. The security
level that is selected in this screen is applied to the system.
▪ The default password policy is low and only requires a 4 character minimum password length and
the password never expires. The high password policy requires an 8 character minimum password
length and forces a password change ever 30 days. You can set your own custom policy.
▪ Whichever policy is chosen, you can choose a password example that is shown to users when they
create passwords and this acts as a template for the required password criteria.
▪ If single-sign on is in use throughout the company, the user still has the option to login using their
SAP Business One credentials, so the password policy should be maintained.
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Setting a User’s Password
Administration  Setup  General  Users
▪

Password can be set by super user when account
created

▪

Alternately user can create password at first logon
(Change Password at Next Logon checkbox)

▪

Password must adhere to current password policy
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▪ The initial password for a user can be set by the super user when the account is first created, by
selecting the ellipsis button to the right of the password field.
▪ Alternately, the super user can leave the password empty and select the checkbox option for the
user to create a password when they first log on. In this case the user receives a prompt to create a
password in accordance to the password policy. The user leaves the old password field empty, and
simply enters and confirms the new password.
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Changing Own Password
Administration  Setup  General  Security  Change Password
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▪

Users can change own password at any
time using the change password
function

▪

Change password function available to
all users regardless of license or
authorizations

▪

User must adhere to password policy

▪

All passwords are encrypted
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▪ Users can change their password at any time by choosing the change password function. This
function is available to all users, regardless of license or authorizations. The new password must
adhere to the password policy.
▪ Note that in SAP Business One, all passwords are encrypted.
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Locked User Account

▪

Super user can lock and unlock user
account

▪

User account can be locked to
prevent access or temporarily
disable an account

▪

Account will be automatically locked
after a specified number of
unsuccessful login attempts (as
defined in the password policy)
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▪ A user account can be locked to prevent access to SAP Business One or to temporarily disable an
account. The super user can lock an account manually, and the account will be automatically locked
after a specified number of unsuccessful login attempts by the user, if this is defined in the
password policy. The default low password policy does not lock a user account.
▪ Only a super user can unlock a user account.
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Access Log
Tools > Access Log
▪

Records each user
logon, logoff, and
password change

▪

Double-click row to
see detailed log
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▪
▪
▪
▪
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An audit log is maintained that records each user logon, logoff, and password change.
This is especially useful for monitoring password changes and failed login attempts.
To view the log, choose the Tools menu then choose Access Log.
You can double-click a row to see details for a user. The client IP address is included in the details,
allowing the administrator to track the source of an attempted login.
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Summary
▪

All users need an account and license. There are two types of user account:
▪ A super user has by default full authorization to every function and needs a Professional license
▪ Normal users have no authorization to any function and need general authorizations to each
function, plus a license.

▪ Several predefined user accounts exist in a new company database and are reserved
▪ A user group is a list of users who share common requirements, for example, form settings, UI lookand-feel, general authorizations. User groups enable you to assign common settings at the group level
instead of to each individual user
▪ You can define overall settings for users in the General Settings
▪ You can define User Defaults which can be assigned to a group or subset of users
▪ You can also define some settings in the user account itself, which override General Settings and User
Defaults
▪ The password administration function allows a super user to set the strength of the password on a
company-wide basis. Super users can lock an account to prevent access.

▪ The access log provides an audit trail of user logons and password changes
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Here are some key points to take away from this session.
▪ All users need an account and license. There are two types of user account. If you check the
Superuser checkbox when you create a user account, the user will have full authorization to
every function in SAP Business One and this cannot be changed. This user needs a
Professional license. If you do not check the Superuser checkbox, the user by default has no
authorizations to any function and you need to grant general authorizations to each user plus a
suitable license.
▪ Several predefined user accounts exist in a new company database and are reserved.
▪ A user group is a list of users who share common requirements, for example, form settings, UI
look-and-feel, general authorizations. User groups enable you to assign common settings at the
group level instead of to each individual user.
▪ You can define overall settings for users in the General Settings on the Services, Display and
Font & Bkgd tabs.
▪ You can also define a set of User Defaults including printing options, credit cards, and an
attachments folder, and assign these defaults to users with common requirements, roles and/or
locations.
▪ There is also the option to define many of these settings at the user account level. Settings
made at the user account level override settings in the user defaults or in the General Settings.
▪ The password administration function allows a super user to set the strength of the password
using a password policy. There are three prebuilt password policies (low, medium and high) plus
the ability to define a policy to your own requirement. Super users can change the password for
a user account, or lock an account to prevent access.
▪ All users can change their own password. The new password must comply with the password
policy and an example of the required password is shown to the user.
▪ The access log provides an audit trail of user logons and password changes
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System Setup and Administration:
General Authorizations
SAP Business One Version 9.3

PUBLIC

▪ Welcome to the General Authorizations topic.
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Objectives

Objectives:
▪ Describe the process for manually assigning general
authorizations to a user
▪ Define authorization user groups to efficiently assign a set of
authorizations to multiple users
▪ Explain the difference between authorizations and effective
authorizations
▪ Copy general authorizations from one user to other users
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▪ On completion of this topic, you will be able to describe the process for manually assigning general
authorizations to a user so that they can access functions and menus in SAP Business One.
▪ You will also learn how to define and use authorization user groups to efficiently assign a set of
authorizations to multiple users.
▪ You will be able to explain the difference between authorizations and effective authorizations.
▪ Lastly you will learn some timesaving tips to copy a set of general authorizations from one user to
other users.
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Business Example
DG Industries has 15 users in the sales department. These
users need authorization to the Sales – A/R menus and
other sales-related functions in SAP Business One.
In addition the sales manager needs access to sales
reports and sales analysis dashboards.
Option 1: Set the required general authorizations for one
sales user, then copy these authorizations to other sales
users, including the sales manager. Then manually adjust
the authorizations for the sales manager.
Option 2: Create a user group (type authorization). Set the
required authorizations and assign all sales users to this
group, including the sales manager. Manually adjust the
authorizations for the sales manager.
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▪ DG Industries has 15 users in the sales department. These users need authorization to the Sales –
A/R menus and functions in SAP Business One.
▪ The sales manager needs in addition access to sales reports and sales analysis dashboards. This
is a very simple example of an authorization requirement; in real life the requirements would be
much more complex.
▪ There are several ways to implement these authorizations in an optimized way:
▪ Option 1: Set up one user with the required authorizations, then copy the set of authorizations to
the other sales users including the manager. Manually fine tune the authorizations for the sales
manager to add the additional authorizations needed for the role.
▪ Option 2: Create a new authorization user group based on the default sales authorization group.
Assign all users to this group including the manager, then manually fine tune the authorizations
for the sales manager.
▪ In this course you will see how the two options work.
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Introduction to General Authorizations

164

Accessing System Functionality

Each user who is not a super user needs
to be assigned both a license and general
authorization to menus and functions
required for their role:
▪

License determines which
functions the user is legally
contracted to work with

▪

General authorizations permit
the user to access the menu
functions and objects required by
the user’s job role, within the
scope of the assigned license
type
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▪ When a user account is created for a normal user (not a super user), the user can logon to SAP
Business One but cannot access any functionality.
▪ The user requires both a license and general authorizations to the menus and functions they need
to work with:
▪ The type of license assigned to a user determines which functions and documents the user is
legally contracted to use. If the user tries to access a function that is outside the scope of the
license, the user will get an error generated from the license server.
▪ The general authorizations granted to a user permit the user to access or update the SAP
Business One functions and objects within the scope of the assigned license type. These
authorizations allow a company to limit access to menus and functions based on the
requirements of a user’s job role. If the user does not have authorization to a menu, the user will
get an authorization error when he or she tries to access the menu.
▪ Note that assigning a general authorization to a user for a function that is not permitted by the
assigned license type will not grant the user permission to access that function.
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Authorizations for Super Users
Administration  System Initialization  Authorizations General Authorizations
▪

Authorizations window shows list of authorizations granted to a selected user

▪

Authorizations are listed by subject area and generally match the main menu

Super user
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▪

A super user has full
authorization to all menus and
functions and requires a
Professional license

▪

You cannot modify the
authorizations for a super user
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▪ The general authorizations window shows the list of authorizations granted to a selected user. The
user account is selected in the left part of the window under the Users tab.
▪ Authorizations are listed by subject area and are expandable and generally match the main menu.
▪ A user defined as super user has full authorization to all SAP Business One menus and functions
and you cannot modify the authorizations for this user since the selection is grayed out. In the
example, the selected user is a super user and has full authorization to all menus and functions. For
this reason a super user must be assigned a Professional license.
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Authorizations for Regular Users
Administration  System Initialization  Authorizations General Authorizations
▪

A newly created normal user initially has no authorizations to menus and functions

▪

Authorizations must be set for the user so they can perform their job

▪

Authorizations should be granted in accordance with the license purchased for the user

Normal user
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▪ By default, all newly created users who are not super users have no authorizations to any SAP
Business One menus or functions. General Authorizations must be set for each user so they can
perform their job. In the example, the selected user is a normal user and initially has no
authorization to menus and functions.
▪ Note: authorizations should be granted in accordance with the license purchased for the user. The
license comparison chart is available for download from the PartnerEdge portal and shows the
access rights for each license type.
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Temporary Authorization
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▪

If user does not have authorization
to a function a popup message will
appear

▪

A super user can temporarily allow
one time access

168

▪ Users are not allowed to access a form, report or document for which they have no authorization.
▪ In the example, a CRM user wants to view the cash flow forecast. However they do not have
authorization to access this function. When they try to access the menu item a popup message
appears notifying the user that they do not have authorization. A super user can temporarily allow
the user one time access to the function.
▪ If the user needs permanent access to the function then the general authorization should be
assigned.
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Setting Authorizations Manually

Option 1 of the business scenario manually assigns authorizations to one sample user then copies the
authorizations to other users.
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Setting Authorizations Manually
Administration  System Initialization  Authorizations General Authorizations

1.

Select the user account

2.

For each subject area,
select Full Authorization
or Read-Only from the
dropdown list

3.

Only super users or
authorized users can set
authorizations for users

4.

For a full explanation of
each authorization, refer
to the how-to guide
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▪ To set an authorization manually, open the authorizations window and on the Users tab select the
user. Then open the dropdown list for each menu or function and select Full Authorization or ReadOnly:
▪ If you select Full Authorization then the user is able to display and modify data for that function.
For example, if this authorization is selected for the Sales Quotation function, a user would be
able to view, create and update sales quotations.
▪ If you select Read-Only then the user can view, but not change any data.
▪ Only super users or authorized users can set authorizations for users.
▪ For a full explanation of each general authorization, refer to the how-to guide How to Define
Authorizations.
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Setting Authorizations Manually (cont.)
When you set an authorization to the top node for a
subject, the same authorization trickles down to all
sub-level menus

If you assign or change the authorization at a
sub-level, the top level node will change to
Various Authorizations
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▪ When you assign an authorization for a module, such as Sales – A/R, the same authorization
trickles down to all the sub-menus within the module.
▪ If you assign or change an authorization at a lower level of the module, the top level authorization
will change to Various Authorizations to indicate there are authorizations set lower down in the tree.
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Setting Authorizations Manually (cont.)
For each user you can:
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▪

Limit the discount they
can offer on sales,
purchasing and/or other
windows

▪

Set the maximum cash
amount on incoming
payments
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▪ In the authorizations window you can also set the maximum discount a user can offer in sales,
purchasing or other forms such as business partner master data and payment terms. If the discount
percentage is zero, the user will not be allowed to enter a discount at all. In the example shown
here the user is allowed to enter discounts up to 15% in sales documents.
▪ You can also permit the amount of cash a user is allowed to enter in an incoming payment
(Payment Means window, Cash tab). When you select the checkbox you will be able to enter the
cash amount.
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Copy Authorizations
To copy a set of authorizations to multiple users,
select the source user, choose the Copy
Authorizations button, then select the target users

You can also copy authorizations to a
single user using drag and drop
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▪ To save time, you can copy the authorizations from one user to other users.
▪ In the authorizations window, select the user then choose the Copy Authorizations button. A list of
users will appear and you can select multiple target users for the copy.
▪ You can also copy the authorizations from a selected user to another user by holding your mouse
over the source user name until a black rectangle appears, then dragging and dropping the
rectangle over the target user. The system asks you to confirm you want to copy the authorizations.
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Authorization User Groups

Option 2 of the business scenario assigns authorizations to users at the authorization user group level.
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Timesaver – Authorization User Groups
Administration > Setup > General > User Groups
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▪

Authorization user groups are
predefined sets of authorizations that
can be assigned to multiple users

▪

The system provides four default
authorization user groups – finance,
sales, purchasing and inventory – which
contain the authorizations generally
required for these roles

▪

You can use these default user groups
out-of-the-box, edit them, copy them to
new user groups, or create new user
groups from scratch
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▪ Setting authorizations on a per user basis can be time consuming. If a company has several users
who perform the same role, or work with the same set of functions, it is more efficient to use an
authorization user group.
▪ Authorization user groups are predefined sets of authorizations that can be assigned to multiple
users.
▪ In a new system there are four default groups defined by SAP which contain the authorizations
generally required for finance, sales, purchasing and inventory-related roles.
▪ You can use these default user groups out-of-the-box, edit them, copy them to create new groups,
or create your own user groups from scratch.
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Creating a New Authorization User Group
Administration > Setup > General > User Groups
Choose Create Group button

Select Group Type as
Authorization or Cross All
Types

Options:
▪ Set active date range for group
▪ Select a cockpit template (SAP
HANA only)
▪ Set active date range per user

Note: User Groups can also be created for other types of use. For
information on these groups see the Users and User Defaults course.
© 2018 SAP SE or an SAP affiliate company. All rights reserved. ǀ PUBLIC

176

▪ To create a new authorization group, choose the Create Group button and enter a name and
description.
▪ Select the Group Type as Authorization or Cross All Types.
▪ You have the option to set an active date when you create a new group. This allows you to
predefine the authorizations then roll them out at a later date. You can also set an active date range
for each individual user you add to the group.
▪ For SAP HANA you can associate a predefined, published cockpit template which will be assigned
to all the group members. SAP provides Sales, Finance, Purchase and Inventory templates out-ofthe-box, but you can also add your own cockpit templates. For information on cockpit templates,
see the Getting Started topic in the Overview program.
Note: User Groups can also be created for other types of use (for example, alerts and form settings).
For more information on these groups see the Users and User Groups course in this program.
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Setting Authorizations at the Group Level
▪

User groups of type Authorization and Cross All Types are visible in the authorizations window
(Groups tab)

▪

Set the authorizations for the group as you would for a user
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▪ User groups of type Authorization and Cross All Types are visible in the authorizations window.
▪ To set authorizations for a user group, select the Groups tab in the authorizations window, then
select the predefined group. You can then set the authorizations as you would manually for a user.
▪ The authorizations will instantly apply to all users in the group.

177

Copying Authorizations to a New Authorization Group
▪

Instead of setting the
authorizations manually for a
new group, you can copy
authorizations from one of the
predefined groups

▪

Then you can manually adjust
for the company’s unique
requirements
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▪ Instead of setting the authorizations manually for a new user group, you can copy the authorizations
from one of the predefined user groups provided out-of-the-box (Sales, Purchase, Finance and
Inventory). This gives you a good starting point for setting authorizations. For example, if you create
a new group for sales managers, you can select the default sales user group as the basis.
▪ To do this, select the Copy Authorizations button. Then select the target user group.
▪ You can then adjust the authorizations in the new group, as required.
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Assigning Group Authorizations to a User Account
From the user account:
▪

You can also assign a user to a group from the
user account

▪

In the user account select the ellipsis button for
the Groups field, and select a group from the
list

▪ When you assign a user to a group, the user is
added to the group list and instantly receives
the general authorizations set for the group

Note: If you change an authorization in a group
after you have assigned users to the group, those
users will all receive the changed authorization.
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▪ In addition to assigning users to a group by adding them in the group, you can assign a user to a
group from the user account. In the user account select the ellipsis button to the right of the Groups
field, and select a group from the list shown.
▪ When you assign a user to a group, the user is added to the group list and instantly receives the
general authorizations set for the group.
▪ Note: If you change an authorization in a group after you have assigned users to the group, those
users will all receive the changed authorization.

▪ You can select more than one group if applicable for the user’s role and if the user has the
appropriate license. You can also manually change the authorizations for a user even if they belong
to a user group.
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Managing Authorizations

180

Reviewing Set Authorizations
To review authorizations for a user or a user group, select the user or user group name then choose the
export to Excel icon
Export Individual User Authorizations

Export User Group Authorizations
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▪ From the authorizations window you can export the set authorizations for a user or user group to
Microsoft Excel.
▪ To export the authorizations for one or more individual users, select the Users tab in the
authorizations window then choose the Excel icon on the icon bar, and select one or more users.
▪ To export the authorizations for one or more user groups, select the Groups tab in the general
authorizations window then choose the Excel icon and select the groups.
▪ Tip: During an implementation project, a report or spreadsheet of the assigned authorizations
should be saved with the project documentation.
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Effective Authorizations for a User
Effective Authorizations column shows the combined authorizations granted to a user – both manually and from
an authorization user group.

Authorizations
granted to user
manually
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Combined
authorizations
granted to user
182

▪ An additional column is available in the authorizations window. This column only shows when you
select a user on the Users tab.
▪ To view this column, click the arrow in the top-right part of the matrix, or adjust the column widths
manually to bring the additional column into view.
▪ The Effective Authorization column shows the combined authorizations granted to a user – from an
authorization user group and from any manual authorizations. In case of conflicting authorizations,
the highest (most generous) authorization will prevail.
▪ In the example, the selected user has not been granted any authorizations directly; however the
user has effective authorizations from an authorization user group.
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Multiple Authorization Groups

•

If user account is assigned to multiple
authorization groups the user could potentially
receive conflicting permissions for a specific
function (Read-Only, No Authorization and/or Full
Authorization)

Result:
•

User groups:

Sales - OEC

The system will grant the most generous
authorization

Sales
Inventory
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▪ The system does not prevent a user from being assigned to more than one authorization group. In
the user account you can see the authorization groups assigned to a user.
▪ If a user is assigned to multiple authorization groups then potentially there could be conflicting
authorizations for a specific function.
▪ For example, the user could potentially receive all three permissions to the Sales – A/R menu
(Read-Only, No Authorization and/or Full Authorization).
▪ In this case the system will grant the highest (most generous authorization) and this will appear as
the effective authorization.

183

Change Log
Tools > Change Log…

▪

Changes to authorizations for a user or user group are
tracked in change log

▪

Each row is a snapshot of what was changed

▪

Differences window consolidates two selected rows
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▪ Changes to authorizations for a user or user group are tracked in the Change Log. This provides an
audit trail.
▪ The Change Log is available from the Tools menu when the authorizations window is open and
when a user or user group is selected in this window.
▪ Each row in the change log represents a snapshot of what was changed, and you can see the full
details by double-clicking the row.
▪ You can also select two rows and show the differences. The differences window shows a
consolidation of the two selected rows, including the change date, the changed field, the previous
value and the new value, as well as the name of the person changing the authorization.
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Additional Authorization Creator
Administration  System Initialization  Authorizations General Authorizations  Additional
Authorization Creator
▪

In this window, developers can add
new authorizations to the
authorization table to control access
to new menus and forms

▪

Use System Information to find the
form ID:
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In the Additional Authorization Creator window, developers can add user authorizations to the
authorizations table. A user authorization controls access to a new menu item or user form. You can
set the possible authorizations as Full/None or Full/Read/None.

•

You enter an Authorization Id and Name, and the FormID. To find the form ID, open the form and
choose View > System information on the Top Menu. The form ID shows in the status bar when you
hover over the form.
• The new authorization appears in the authorizations window, under the subject area User
Authorization.
For more information on user-defined tables and user-defined objects, see the User-Defined Tables
topic in this course.
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Authorizations for Reports

186

Sales and Purchasing Reports

Option to authorize or restrict
access to all sales and
purchasing reports, to the
Open Items List, or to
individual document types in
the Open Items List
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Sales and purchasing reports contain sensitive information and a company might want to restrict
access to these reports.
In the Reports subject area you can restrict access to all sales and purchasing reports, or to the Open
Items list report, or to individual document types in the Open Items list . If you select No Authorization,
the user cannot open these reports.
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Analytics Reports

Ability to authorize or restrict
access to
•

Excel Report and
Interactive Designer

•

Interactive analysis reports

•

Semantic layer views

•

KPIs, cockpits and
dashboards
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You can authorize or restrict access to SAP HANA analytical reports, including the ability to:
•
Launch the Excel Report and Interactive Analysis Designer tool
•
View a specific Excel interactive analysis report (by functional area or at the specific report level)
•
View the semantic layer
•
Access information in KPIs, cockpits and dashboards
Note: In the authorizations window you can see a button Apply Auth. To Back End.
This button is only relevant for companies that use Microsoft SQL Server for production and SAP
HANA for analytics (B1A). Authorizations are required for users to access the semantic layer (these
authorizations are listed under the Analytics subject area). After the authorizations are updated, they
are saved to the SAP Business One production database, but they also must be synchronized with the
underlying SAP HANA analytics server. For consistency, SAP recommends that the SAP HANA
analytics server is stopped when making these changes, then after the changes are saved, to restart
the analytics server and use this button to synchronize the changes. In the current release, the
synchronization is not automatic and must be manually done by the administrator pressing this button.
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Summary 1 of 2
Key points from this topic:
▪ Each user who is not a super user needs to be assigned both a license and general authorization to
menus and functions required for their role:
▪ A super user has by default full authorization to every function and needs a Professional license
▪ Regular users have no authorization to any function and you need to grant general authorizations
to each user according to the license
▪ The authorizations window shows the list of general authorizations in the same general order as SAP
Business One menus and functions
▪ Authorizations are also required to run reports, and for analytics
▪ To set an authorization manually, select the user then open the dropdown list for each menu or
function and select Full Authorization or Read-Only:
▪ If you select Full Authorization the user can display and modify data for that function. For
example, view, create and update sales quotations
▪ If you select Read-Only the user can view, but not change any data
▪ To save time, you can copy the authorizations from one user to other users
▪ Changes to authorizations are recorded in the Change Log, for audit purposes
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▪ Here are some key points to take away from this session.
▪ Each user who is not a super user needs to be assigned both a license and general
authorization to menus and functions required for their role
▪ A super user has by default full authorization to every function in SAP Business One. Super
users need a Professional license.
▪ A regular user by default has no authorizations to any function and you need to grant general
authorizations to each user according to the license purchased for the user.
▪ The authorizations window shows the list of general authorizations in the same general order as
SAP Business One menus and functions. Authorizations are also required for access to reports
and analytics.
▪ To set an authorization manually, select the user and open the dropdown list for each menu or
function and select full or read-only authorization:
▪
If you select Full Authorization the user can display and modify data for that function. For
example, a user would be able to view, create and update sales quotations
▪
If you select Read-Only then the user can view, but not change any data
▪ You can also copy authorizations from one user to multiple users, or to a single user by dragging
and dropping.
▪ Note that any change to authorizations is recorded in the Change Log, for audit purposes.
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Summary 2 of 2
Key points from this topic:
▪ If a company has several users who perform the same role, or work with the same set of
functions, it is more efficient to use an authorization user group
▪ Authorization user groups are predefined sets of authorizations that can be assigned to multiple
users. In a new system there are four default groups which contain the authorizations generally
required for finance, sales, purchasing and inventory-related roles
▪ User groups appear in the authorizations window and you can set the authorizations as you
would manually for a user
▪ When you create a new group, you can copy authorizations from another user group
▪ The Effective Authorization column shows the combined authorizations granted to a user – from
an authorization user group and from any manual authorizations
▪ If multiple, conflicting authorizations are granted to a user, the highest (most generous)
authorization will apply
▪ You can export assigned authorizations to Microsoft Excel to review, or for project documentation
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▪ Here are some key points to take away from this session.
▪ Manually setting authorizations for each user is time consuming. If a company has several users
who perform the same role, or work with the same set of functions, it is more efficient to use an
authorization user group
▪ Authorization user groups are predefined sets of authorizations that can be assigned to multiple
users. In a new system there are four default groups which contain the authorizations generally
required for finance, sales, purchasing and inventory-related roles
▪ These user groups appear in the authorizations window and you can set the authorizations as
you would manually for a single user
▪ When you create a new group, you can copy authorizations from another user group
▪ The Effective Authorization column shows the combined authorizations granted to a user – from
an authorization user group and from any manual authorizations.
▪ If multiple, conflicting authorizations are granted to a user from a combination of manual
assignment and user group, the highest (most generous) authorization will apply
▪ You can export assigned authorizations to Microsoft Excel to review, or for project
documentation
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System Setup and Administration:
Data Ownership Authorizations
SAP Business One Version 9.3

PUBLIC

▪ In this topic you will learn about data ownership authorizations which are used to
protect access to individual marketing documents stored in the company database.
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Objectives

Objectives:
 Describe the purpose of data ownership authorizations
 Explain how the different data ownership methods work and how the
owner of a document is assigned according to each method
 Permit user access to marketing documents and business partner
master data using data ownership relationships
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▪ On completion of this topic, you will be able to:
▪ Describe the purpose of data ownership authorizations
▪ Explain how the different data ownership methods work and how the owner of a
document is assigned according to each method
▪ Permit user access to marketing documents and business partner master data
using data ownership relationships
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Data Ownership Concept
▪

General authorizations and license permit a user to
access objects and documents, including documents
created by other users

▪

Many companies want to restrict access on a more
granular, need-to-know basis

▪

When data ownership is enabled, access to other
users’ documents is restricted and access must be
granted using data ownership authorizations:

General
Authorization

License

▪

Data ownership authorizations are granted
through a user’s relationship with the owner of a
document

▪

Relationships are defined using employee
master data

▪

If a document has no owner, any user can access it

▪

Super users are not restricted by data ownership and
can access all documents regardless of owner

Data
Ownership
Authorization
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▪ General authorizations and a license permit a user to access objects and all
documents for the object.
▪ All created marketing documents are stored in the SAP Business One database,
meaning that any user with the appropriate general authorization and license can
access documents created by other users.
▪ This is not always desirable. Many companies want to restrict access on a more
granular, need-to-know basis.
▪ Data ownership is not enabled in the system by default. But when you enable data
ownership, access to other users’ documents is restricted. Access to a document
must be granted using data ownership authorizations:
▪ Data ownership authorizations are different to general authorizations. Data
ownership authorizations are granted through a user’s relationship with the
owner of a document, and these relationships are defined using employee
master data. Therefore owners and users who need access must have an
employee record
▪ If a document has no owner then data ownership rules are ignored and any user
can access the document.
▪ Note that super users are not restricted by data ownership. Super users can
access all documents regardless of owner.
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Data Ownership Requirements Can Be Varied
Sales Department

Purchasing Department

Marc
Manager

Molly
Manager

George
Profit

Beth Seller

Team
lead
Peers

Fred
Revenue

Peers



Mary
Discount
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Fred
Buyer

✓

Mary
Purchase
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▪ Who should be able to view and even update documents created by another user?
These requirements will vary from company to company, and data ownership
provides a flexible mechanism to address these requirements, based on employee
relationships. Let’s look at two very different examples from within the same
company:
▪ A sales department requires that sales opportunities, quotations and sales
orders should not be visible outside the sales department. In addition there is a
need to restrict access within the sales department. In the slide example, Fred
Revenue and Mary Discount are peers but they each want exclusive control
over their own customers. Documents belonging to their customers or leads
should not be accessible to peers. Only the manager of the sales team, George
Profit, needs visibility to documents owned by Fred and Mary.
▪ In the same company, the purchasing department is very small and unlike the
sales department, the purchasing documents and business partner information
are shared within the team in order to support vendors and manage vendor
negotiations. However, purchasing documents should not be visible to users
outside the purchasing team.
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Possible Data Ownership Relationships
Company

If data ownership is enabled, a user is authorized
through a defined relationship with the document
owner:

Department

•

Peer. The user and the owner share the same
manager

•

Manager. The owner is the manager of the user

Manager

•

Subordinate. The user is the manager of the
owner

Peer

•

Team. The user and the owner are part of the
same team

Manager

•

Department. The user and the owner are
members of the same department

•

Branch. The user and the owner are part of the
same branch

•

Company. The user can access a document
regardless of owner (bypasses any ownership)

Branch

Subordinate

Subordinate

Team
Peer
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If a company enables data ownership, a user is authorized through a defined relationship
with the document owner. The possible relationships are:
▪ Peer: the user and the owner are considered peers if they share the same manager on
their corresponding employee records. A user granted peer authorization can access
documents provided they have the same manager as the owner.
▪ Manager: the owner is the user’s manager per the manager field on the user’s employee
record. A user granted manager authorization can access documents owned by his or her
direct manager.
▪ Subordinate: the user is the owner’s manager per the manager field on the owner’s
employee record. A user granted subordinate authorization can access documents
owned by his or her direct subordinates.
▪ Team: the user and the owner are members of the same team as defined in their
employee records. A user granted team authorization can access documents owned by
other members of the team.
▪ Department: the user and the owner are members of the same department as selected in
their employee records. A user granted department authorization can access documents
owned by other members of the department.
▪ Branch: the user and the owner are members of the same branch as selected in their
employee records. A user granted branch authorization can access documents owned by
other members of the same branch. If the multi-branch feature is enabled, you can select
multiple branches for an employee. When a user is assigned to more than one branch
and has data ownership authorization based on the branch relationship, the user can
access documents owned by any users from the same branches.
▪ Company: A user granted company authorization can access the document regardless of
owner, effectively bypassing data ownership for the document.
We will revisit these relationships later in this course.
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Employee Master Data
Human Resources > Employee Master Data

In the employee record you can designate an employee’s
manager, department, branch and set as a member of a
team
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▪ Employee master data is at the heart of data ownership authorizations. To be
assigned as the owner of a document or master data record, a user must have an
employee record. All users who need permission to access other user’s documents
need an employee record also.
▪ You can use employee master data to model the organization of a company. In the
master data, you can specify information about an employee, including the
employee’s manager, department, branch, and membership of any teams within
the organization. Note that the peer relationship is assumed if two or more
employees have the same manager.
▪ In the sample master data for the sales manager George Profit we can see the
name of his manager, his department, and any teams that he belongs to.
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Data Ownership Management Methods

In this section we discuss the data ownership management methods available in SAP Business One.
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Data Ownership Management Methods
The owner of a document is assigned when the
document is created and depends on which method
the company has chosen for data ownership:
•

Business partner only

•

Document only

•

Business partner and document

•

Branch*

Only one method can be selected for the company
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▪ The owner of a document is assigned when the document is created, and depends
on the data ownership method that a company has chosen.
▪ There are three methods to consider – business partner only, document only, or a
combination of both. Only one method can be selected for the company.
▪ We will look at these methods in more detail.
▪ *Note: if the multiple branches functionality is enabled in the Company Details
screen, there is a fourth option to manage data ownership by branch. With this
option, a user is not given authorizations to specific documents; instead,
authorization to access documents or business partner data is determined by the
user’s branch assignment. The branch method is not covered in this course.
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Owner Assignment – Business Partner Only Method
Owner is assigned from master data owner (business partner master data contains an owner field)
This method also restricts access to the master data
▪

Owner is set by user who creates or
updates master data

▪

This owner will be assigned in all
documents for the business partner

▪

This method additionally restricts
access to business partner master
data in choose from lists, reports and
while browsing records

▪

Master data owner
Document owner

If no owner is selected in the master
data, data ownership rules are not
enforced for the business partner
(option to enforce selection of owner
in master data)

© 2018 SAP SE or an SAP affiliate company. All rights reserved. ǀ PUBLIC

199

▪ If the business partner only method is selected for a company, the business
partner master data contains an owner field. The owner is set by the user who
creates or updates the master data record. This owner will be then automatically
assigned in all documents created for the business partner. Thus the documents
inherit the owner from the master data.
▪ Users can only access the business partner master data and documents for that
business partner if they have a defined relationship with the owner of the business
partner master data. This method additionally restricts access to business partner
master data when a user browses through records, or runs reports, or in choose
from lists. The system will skip records if the user is not authorized by relationship
with the business partner owner.
▪ If no owner is selected in the master data, data ownership rules are not enforced,
and any user can access the master data and documents for the business partner.
▪ There is an option to enforce the selection of an owner when a user creates the
business partner record. The default setting is not to enforce an owner, which
provides some flexibility if a company wants to apply data ownership to customers
but not to vendors. In this case an owner can be selected in customer records but
left empty in vendor records.
▪ Note: The system will block removal of an employee record if the employee is set
as the owner in business partner master data.
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Owner Assignment – Document Only Method
Owner is assigned in each document when it is created, according to a set of rules
Note: Business partner master data is not restricted.

Owner field in each document is assigned when document is created as follows:
If…

And

Document creator
does not have an
employee record

Document creator
has an employee
record

Result

Example: customer is Microchips

No owner is assigned
A sales employee or buyer exists in Owner is the sales
business partner master data with a employee or buyer
linked employee record
from master data
No sales employee or buyer exists
in business partner master data

A sales employee or buyer exists in
business partner master data but
does not have an employee record

Owner is the creator
of the document
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If the document only method is selected, the owner is assigned in each document,
when the document is created, according to a set of rules. With this method, business
partner information cannot be restricted and the business partner master data has no
owner field.
Instead the owner field in each document is assigned by the system according to a
series of rules:
▪ If the creator of the document does not have an employee record, an owner is
not assigned by the system. If it has no owner, a document is not protected by
data ownership. However, the owner can be manually selected by the
document creator.
▪ If the creator has an employee record, and a sales employee or buyer is
recorded in the business partner master data, and the sales employee or
buyer has an employee record that is linked to their user account, the system
assigns the sales employee or buyer as the owner of the document.
▪ If the creator has an employee record, and no sales employee or buyer is
recorded in the business partner master data, then the system assigns the
creator as the owner of the document.
▪ If the creator has an employee record, and a sales employee or buyer is
recorded in the master data, but the sales employee or buyer does not have
an employee record, then the system assigns the document creator as the
owner in the document.
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Owner Assignment – Business Partner and Document Method
Owner assignment depends on whether there is an owner for the master data

▪

If the business partner has an owner in the
master data, data ownership works according
to the business partner only method

▪

If the business partner does not have an owner
in the master data, data ownership works
according to the document only method

▪

The owner name from the master data will be
automatically assigned to all documents for
the business partner.

▪

The owner name in a document will be assigned
according to the rules for the document only
strategy

BPMD
Owner

?

Owner
© 2018 SAP SE or an SAP affiliate company. All rights reserved. ǀ PUBLIC

201

▪ The third method business partner and document is really a hybrid of the other
two methods. The business partner master data has an owner field and this
method allows a company to restrict access to both documents and business
partner master data.
▪ When a business partner has an owner in the master data, data ownership
works according to the business partner only method. The owner name from
the master data will be automatically assigned to all documents for the
business partner. Permissions to documents and master data are granted
based on a user’s relationship with the master data owner.
▪

When the business partner has no owner in the master data, the owner in a
document is assigned according to the rules for the document only method.
Permissions to documents are granted based on a user’s relationship with the
document owner (see previous slide). Be aware that this is different to the
business partner only method, in which data ownership does not apply at all if
the business partner has no owner.
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Owner and Sales Employee/Buyer Fields
▪

Sales Employee or Buyer is assigned to document from business partner master data

▪

If document only method is used, sales employee or buyer will be assigned as document owner if
sales employee/buyer has an employee record linked to their user account
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▪ In addition to the owner field, a sales or purchasing document has a sales
employee or buyer field. The sales employee or buyer for a sales or purchasing
document is always assigned from the business partner master data. Note that the
names of the sales employees and buyers are maintained in the Sales
Employees/Buyers setup window.
▪ If the document only method is used, a sales employee or buyer will be assigned
as document owner if the sales employee or buyer has an employee record linked
to their user account.
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Choosing a Data Ownership Method

If…

And….

Best fit

Exclusive owner
can be
designated for a
business partner

Other users who work with
the business partner have
a defined relationship with
the owner

By business partner

Exclusive owner
cannot be
designated for a
business partner

By document

Mix of both

By business partner
and by document
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▪ The data ownership method for a company might be influenced by how the
company works with its business partners. For example:
▪ If there is a person who has sole responsibility for a business partner then that
person can be designated the exclusive owner of the business partner in the
master data. If all other users who need access to the business partner and
documents have one of the defined relationships to the owner, then the
business partner only method can be chosen. Obviously the selection of the
business partner owner is important to making this method work.
▪

If there is no single owner for a business partner because multiple users
manage the business partner relationship, making it hard to specify an owner,
then the document only method can be chosen. The business partner will
not have an owner. A document owner will be assigned according to the rules
and any user who needs access to documents for the business partner must
have one of the defined relationships with the document owner.

▪

If the company has a mix of the above scenarios, the business partner and
document method can be chosen. If some business partners have an
exclusive owner, but some business partners do not, then this is an optimal
method.
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Enabling Data Ownership in the System
Administration > System Initialization > General Settings (BP tab)

✓ Enable Data Ownership
Manage Data Ownership By Document Only
Business Partner Only
Business Partner and Document

✓

▪

Enable and select data ownership
method

▪

Method can be instantly changed at
any time from this window

▪

Additional checkbox for Business
Partner only method - Allow BP
Without an Owner:
▪

If checked (default), the system
will allow master data with no
owner

▪

If unchecked, the system will
force the user to select an
owner in master data

Allow BP Without an Owner
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▪ Data ownership authorization is enabled in the General Settings on the BP tab.
Once you enable data ownership, access restrictions are immediately enforced.
Normal users have no access to other users’ documents until they are given
permissions.
▪ When you enable data ownership you select the method:
▪ Document only
▪ Business partner only
▪ Business partner and document
▪ Note that the method can be instantly changed at any time from this window. If you
do change the method, you may need to set the permissions for the new method.
▪ When the Business Partner Only method is selected, a further checkbox appears
that allows business partners without an owner. If you uncheck this checkbox, the
system will force the user to select an owner when they create new master data
records for customers and vendors. If a business partner has no owner, data
ownership rules will not apply to the business partner or to documents for the
business partner.
▪ If you have enabled multiple branches in the Company Details screen, you will see
a fourth option for managing data ownership – Branch. This should not be
confused with the branch relationship in data ownership. If multiple branches is
enabled and you select data ownership by branch, then user access to marketing
documents, business partners, and reports is authorized through branch
assignment. For example, a user is only able to access a business partner if both
the user and the business partner are assigned to the correct branch. The branch
data ownership method is not covered in this course.
204

Setting Data Ownership Permissions

▪ The next part of this topic looks at the process for setting data ownership permissions.
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Data Ownership Permissions - Concept
Administration  System Initialization  Authorizations  Data Ownership 
Data Ownership Authorizations
▪ Data ownership authorizations window shows, for a selected employee, a matrix of predefined relationships:
Peer, Manager, Subordinate, etc.

▪ You can assign Full or Read Only permissions. The default is None (no access)
▪ In the example, the user Marc Manager will be assigned full permission to A/R invoice documents owned by
his subordinates
▪ If user receives overlapping authorizations, the most generous takes precedence
Employees

Document Peer

Manager Subordinate

Department

Branch

Team

Company

A/R Invoice None

None

None

None

None

None

George Profit
Marc Manager
Beth Seller
Fred Revenue
Mary Discount

None
Full

Note that the Document
column varies according
to the data ownership
method.

Read Only
None
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▪ The data ownership authorizations window shows a list of all users who have
employee records together with a matrix of predefined relationships. Note that the
Document column varies according to the data ownership method.
▪ To assign an authorization, select the employee then select an authorization for the
relationship that the employee has with the document owner/business partner
owner. Possible authorizations are: full (read and update), read only, or none. The
default is no access (none).
▪ Once set, the authorization applies to all documents in the future that meet the
relationship.
▪ In the example the user Marc Manager is about to be granted full access to A/R
invoice documents owned by his subordinates. Marc will have access to all future
A/R invoices created by people who report to him.
▪ It is possible to assign authorizations that overlap. For example, Marc could also
be assigned Read Only access to A/R invoices for the Department relationship.
Since Marc’s subordinates can also be in the same department, this might mean
that Marc has both full access and read only access to the same documents. In
this case the most generous authorization takes precedence, for example, full
instead of read-only, or read only instead of none.
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Set Data Ownership Permissions - Business Partner Only
▪ If the business partner only method is in use, the Document column shows only two entries – business
partner and purchase request document
▪ Authorizations are assigned to each user on the business partner row, by selecting their relationship to the
owner of the master data
▪ Purchase request document is not associated with a business partner, so you must set permission based on
user’s relationship to owner of this document
Employees

Document

Peer

Manager Subordinate Department Branch Team

Company

George Profit

Business Partner

None

None

Full

Read Only

None

None

None

Marc Manager

Purchase Request None

None

Full

None

None

None

None

Beth Seller

George Profit has:

Fred Revenue

•

Full access to documents and master data for business partners owned by subordinates

Mary Discount

•

Read only access to documents and master data for business partners owned by people
in the same department

•

Full access to purchase requests owned by subordinates
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▪ If the method is business partner only, the Document column shows only two
entries – business partner and purchase request. The purchase request document
is included because it is the only document not associated with a business partner,
therefore you must set authorizations specifically for this document type.
▪ On the business partner row, you assign permissions for each user according to
their relationship with the owner of the business partner master data:
• If read only authorization is granted for a relationship, and if the user has the
required relationship to the owner, then the user can view the business partner
master data in choose from lists, can view all documents for the business
partner, and can view the business partner data and documents in various
reports, for example, the Open Items List or Aging Reports.
• If full authorization is granted, the user can in addition create and edit
documents for the business partner, and update the master data.
• Once a user is authorized, the user now has access to all business partner
records and all documents where they have a relationship to the business
partner owner.
▪ On the purchase request row, you assign permissions to each user by selecting
their relationship to the owner of the purchase request document.
▪ In the example, George Profit is a sales manager and has:
▪ Full access to documents and master data for business partners owned by the
employees who report to him (subordinates)
▪ Read only access to documents and master data for business partners owned
by an employee in the same department
▪ No access to documents and master data owned by his manager, his peers,
branch or team
▪ Full access to purchase request documents owned by subordinates, but no
access to purchase requests owned by other employees.
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Set Data Ownership Permissions - Document Only
▪

If the document only method is in use, the Document column shows a full list of marketing documents

▪

Authorizations are assigned to each user for each document type by selecting their relationship to the
owner of the document

▪

This method can permit access to one document type but not to another, even if both have the same owner

Employees

Document

Peer

Manager Subordinate Department Branch Team

Company

George Profit

Sales Order

None

None

Full

Read Only

None

None

None

Marc Manager

A/R Invoice

None

None

Full

Read Only

None

None

None

Beth Seller

A/R Credit Memo None

None

None

None

None

None

None

Fred Revenue

A/P Invoice

None

None

None

None

None

None

George Profit has:

Mary Discount
...

None

...

•

Full access to sales orders and A/R invoices owned by
employees who report to him

•

Read only access to sales orders and A/R invoices owned by
people in the same department
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▪ If the document only method is chosen, the Document column shows a full list of
marketing document types. You assign authorizations to each selected user for
each document type by selecting Full or Read Only or None (default) according to
the user’s relationship to the owner of the document. You make these selections
for each document type.
▪ Being able to set permissions at the document type level enables a company to
permit access to one document type but not to another. For example, you can
permit access to sales orders but not to A/R invoices, even if both documents have
the same owner.
▪ In the example, George Profit is a sales manager and has:
▪ Full access to sales orders and A/R invoices owned by all employees who
report to him (subordinates)
▪ Read only access to sales orders and A/R invoices owned by any employees
in the same department
▪ No access to sales orders or A/R invoices owned by his peers, his manager,
his branch or team.
▪ The full list of document types is not shown in this example.

208

Set Ownership Permissions - Business Partner and Document
▪

If the combined method is in use, the Document column shows a row for the business partner and a row
for each marketing document including the purchase request

▪

Authorizations are assigned to each user on the business partner row and on each document row

▪

If the master data has an owner the authorizations on the business partner row apply. If there is no

▪

owner in the master data then the document type authorizations apply
Employees

Document

Manager Subordinate Department Branch Team

Company

George Profit

Business Partner None

None

Marc Manager

Sales Order

None

None

Beth Seller

A/R Invoice

None

None

Fred Revenue

A/R Credit Memo None

None

Mary

Read Only

None

None

None

None

Full

Read Only

None

None

None

Full

Read Only

None

None

None

None

None

None

None

None

• If business
Discount
•

...

Peer

partner
master dataNone
has an owner,
has Read
Only access
to all documents
and master
A/P Invoice
NoneGeorge Profit
None
None
None
None None
data for business partners owned by a subordinate
Purchase
None
None
Full
None
None
None None
If business partner master data has no owner, George Profit has Full access to Sales Orders and A/R Invoices
Request
owned by a subordinate and Read Only access to documents owned by others in the same department
...
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▪ If the combined business partner and document method is chosen, the
Document column shows a business partner row plus a row for each marketing
document type, including the Purchase Request document:
▪ On the business partner row, assign authorization to a user by selecting Full or
Read Only or None (default) according to their relationship to the owner of the
master data. If the business partner master data has an owner, the
authorizations assigned on this row apply.
▪ On the document rows, you assign authorization to a user by selecting Full or
Read Only or None (default) according to the user’s relationship to the owner
of the document. If the business partner master data does not have an owner,
the authorizations assigned on these rows apply.
▪ In this example the user George Profit has different authorizations depending if the
master data contains an owner:
▪

If there is an owner in the master data, George Profit has read only access to
both documents and master data for business partners owned by subordinates

▪

If there is no owner in the master data, George profit has full access to sales
orders and A/R invoices owned by subordinates, and read only access to
sales orders and A/R invoices owned by other people in the same department.
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Data Ownership at the Company Level

▪ If a selection of full or read only is made in the Company column, this effectively grants the user access to
all documents regardless of owner, thus canceling out data ownership authorizations
▪ An example of when this authorization might be used is for the company auditor who might need read
access to documents and who has no defined relationship to the owners.

Employees

Document

Manager Subordinate Department Branch Team

Company

George Profit

Business Partner None

Peer

None

None

None

None

None

Read Only

Amy Auditor

Sales Order

None

None

None

None

None

None

Read Only

Beth Seller

A/R Invoice

None

None

None

None

None

None

Read Only

Fred Revenue

A/R Credit Memo None

None

Read Only

Mary Discount

A/P Invoice

None

...

...

None
None
None
None
Amy
Auditor has None
Read only access
None
Noneto allNone
documents and business partners, regardless
of owner

None
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Read Only
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▪ If a selection of full or read only is made in the Company column for a user, this
effectively grants the user full or read-only access to all documents regardless of
owner, thus canceling out data ownership authorizations.
▪ An example of when this authorization might be used is for the company auditor
who might need to access documents but does not have a defined relationship to
the owners. You can simply grant this access to this one employee.

▪ The company relationship is available for all three methods.
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Summary – Data Ownership Permissions
▪

Once data ownership is enabled, a document that has an
owner can only be accessed by the owner, a super user, or
other users authorized by relationship to the owner

▪

For the business partner only method, the owner is
assigned in the master data and inherited by documents.
There is an option to force selection of an owner in the master
data

▪

For the document only method, the owner is assigned in
each individual document according to a set of rules

▪

To permit access to a document, select read-only or full
access for each user for a relationship to the owner

▪

Relationships are: peer, manager, subordinate, department,
branch, team. Authorization at the company level gives a user
access to all business partners and documents (Business
Partner only method) or all documents of a selected type
(Document only method)

▪

All users need an employee master record
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▪ Once data ownership is enabled, a document that has an owner can only be
accessed by the owner, a super user, or other users authorized by relationship to
the owner
▪ For the business partner only method, the owner is assigned in the business
partner master data and is inherited by all documents created for the business
partner. There is an option to force the user to select an owner in the master data.
Once permission is given by way of relationship to the business partner owner, a
user can access all documents for that business partner. The exception is the
purchase request document which has no business partner and therefore
permissions must be granted to this document type.
▪ For the document only method, the owner is assigned to each individual
document when it is created, according to a set of rules, and the owner can be
different in documents for the same business partner.
▪ To permit access to a document, select read-only or full access for each user
according to their relationship with the owner. The possible relationships are peer,
manager, subordinate, department, branch and team. The company relationship
gives a user read or full access to all business partners and documents (Business
Partner only method) or to all documents for a selected document type

(Document only method).
▪ Relationships are defined using employee master data, therefore all users,
including owners and users who need access, must have an employee master
record.
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Sharing Options

▪ This section of the topic looks at options for overriding certain documents and reports from data
ownership rules.
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Data Ownership on Reports
•

Data ownership affects content of reports, Drag&Relate, and browsing through documents

•

The system will skip documents for which the employee has no data ownership relationship authorization

Business partners
not shown in
choose from list

Documents 15-19
skipped in report
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▪ The authorization permissions affect reports, Drag& Relate, and browsing through
existing documents. While browsing, if the user encounters a document that is
restricted by authorization, the system skips it or shows it as read only, depending
on whether authorization was selected as none or read only.
▪ If a user does not have permission to a document, the document records will be
skipped in the report or when the user browses through documents. For example,
a user who runs the Open Items List report will only see the following documents in
the report:
▪ Documents that they own
▪ Documents to which they have been granted data ownership permissions, or
▪ Documents that have no owner
▪ The system will skip other documents.
▪ If the business partner only method is in use, and a user does not have permission
to the business partner owner, the business partner will not show in choose from
lists.
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Header and Row Owners

Row
owner

▪

Marketing documents can
potentially have a row owner that is
different to a header owner

▪

The row owner field is not initially
visible but can be made visible
using forms settings

▪

The default owner for all documents
is Header and Row Owner, which
permits users to access a
document if they have a
relationship with either the header
owner or the row owner.

Header
owner
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Marketing documents can potentially have a header owner and a different row owner
(the owner field appears in both the header and row of a document). The row

owner field in a marketing document is not initially visible in the document
row but can be made visible using form settings.
Normally the row owner defaults to the header owner, but it can happen that the
owner of a row is different to the header owner. This could happen, for example as
shown in the slide, if Michael Spear left the company and Bill Levine updated his
document.
When you set data ownership authorizations for a document, the default owner is the
owner of both the header and rows (Header and Row Owner). This permits a user to
access a document if they have a relationship with either the header owner or the row
owner. In the example here, any user can access this document if they are permitted
and if they have a relationship with either Michael or Bill.
If a company wants to restrict the access relationship to just the header owner, they
can do this using sharing options
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Data Ownership Sharing Options
Administration  System Initialization  Authorizations  Data Ownership  Data Ownership
Sharing Options
Sharing options let you refine data ownership rules, temporarily or permanently for a document, report or
form:
• You can enforce data ownership for a form by
• You can enforce data ownership for document by
relationship to the document header owner, or
relationship to the header and row owner, the header
you can completely bypass data ownership for
owner, or bypass data ownership for the document
documents in report

Documents
A/P Invoice
A/R Invoice

Windows
No Restriction

Open Items List

Header and Row Owner

Header Owner
Customer Receivables Aging

Header Owner

No Restriction

Delivery

Opportunities Forecast

Opportunity

...
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Data ownership sharing options allow you to refine data ownership rules, temporarily or
permanently, for a specific, named document type, report, or form.
The Documents tab shows a list of all marketing documents. Here you can override the data
ownership rules set for a document in the Data Ownership Authorizations window:
▪ If you select Header Owner for a document type, instead of Header and Row Owner, this
enforces data ownership by relationship to only the header owner. Users must have a
defined relationship with the header owner, and are not permitted to access the document
based on a relationship with only the row owner.
▪ If you select No Restriction for a document, this bypasses data ownership rules for all
instances of the document type. An example might be to temporarily allow access to all
A/R invoices to troubleshoot a problem.
The Windows tab is initially blank but you can select any form or report from the dropdown
list and select either No Restriction or Header Owner:
▪ If you choose Header Owner, data ownership rules are enforced for the form or report with
respect to the owner of the document header.
▪ If you choose No Restriction, all users will be able to view all records in the form or report,
with no skipping of records. Data ownership is effectively bypassed for the form or report.
An example might be to allow users to view all documents in the Open Items report or to
view all business partners in the Aging Reports or Payment Wizard. The user does not
need data ownership authorization to the business partners or documents. Note: Users
have read only access to the business partners and documents.
▪ If a form or report is not selected in this tab, then data ownership rules will apply.

▪ Note that the dropdown list shows all forms in the system, many of which
are not relevant for data ownership. You can type in the full or partial name of a

form at the top of the dropdown list to quickly navigate through the list. Or you can open
the form and use System Information to show the form number in the status bar.
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Sharing Options – Header and Row Owners Example

▪

A business reason for selecting Header Owner
might be a sales opportunity that is handled at
different stages by different users

▪

Each stage is a row in the sales opportunity
and a different owner can be selected at the
row level

Assume header owner is in team A, and row owner is in team B.
Data ownership is granted to user from team B based on team
relationship:
• If Header Owner is selected for sales opportunity, user in team
B will have no access to sales opportunity because they have
no relationship to the header owner
• If Header and Row Owner is selected, user can access sales
opportunity through team relationship to row owner. However
the user can view but not update the document header
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▪ A business example for selecting Header Owner as the document owner might be
a sales opportunity that is handled at different stages by different users. A
company might want to limit which users have access to an opportunity that is
being worked on by a team. The company can achieve this by setting a different
owner for the header and the stage rows.
▪ Assume the header owner (Marc Manager) works in team A. The owner for the
stage row works in team B.
▪ If data ownership access is granted to a user in team B based on the team
relationship:
▪ If the owner is selected as Header Owner, the user from team B will have no
access to the sales opportunity because the user is in a different team to the
header owner
▪ If the owner is selected as Header and Row Owner, the user has access to the
sales opportunity through the team relationship with the row owner. If the
user’s relationship is only with the row owner, the user can view but not update
the document header, even if they have full permission.
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Sharing Options – Documents Tab
Administration  System Initialization  Authorizations  Data Ownership  Data Ownership
Sharing Options (Documents tab)
▪
▪
▪

Document only method – shows full list of marketing documents
Business Partner only method – shows only purchase request
Business partner and document method – marketing documents are relevant only when there is no owner
in the business partner master data

Document only
method

Business partner only
method – purchase
request is only
document shown
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Business partner and
document method - if
no owner in master
data
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The data ownership sharing options has different tabs depending on the data
ownership method in use:
▪ If the document only method is in use, the Documents tab shows the list of
marketing documents and you can bypass data ownership rules for any
document by selecting No Restriction for the document. You can optionally
select Header Owner to restrict access only to users with a relationship to the
document header owner
▪ If the business partner only method is in use, the Documents tab will only
show the purchase request document, since this document does not have a
business partner owner. The actions on this document are the same as for the
document only method
▪ If the business partner and document method is in use, the Documents tab is
only relevant if the business partner does not have an owner in the master data.
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Sharing Options – Business Partner Tab
Administration  System Initialization  Authorizations  Data Ownership  Data Ownership Sharing
Options (Business Partner tab)
▪

Business Partner tab only available for
business partner only and business
partner and document methods

▪

Settings apply only when the business
partner master data has an owner:

▪
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▪

Business Partner Owner (default)
enforces data ownership rules by
business partner for all documents

▪

No Restriction bypasses data
ownership rules for all documents

If business partner does not have an owner,
settings on the Documents tab apply
instead
218

▪ The Business Partner tab of the data ownership sharing window is only available
for business partner only and business partner and document methods.
▪ This tab is not available for the document only method.
▪ The settings made on this tab apply only when the business partner master data
has an owner:
▪ The default setting in the owner column is business partner owner, meaning that
the documents are subject to data ownership
▪ The other setting is No Restriction which allows the bypass of data ownership
rules. This might be useful to keep the system running without data ownership
checks if an incorrect owner was selected in the master data that results in
users being blocked.
▪ The full list of documents can be viewed by expanding the node for the business
partner.
▪ Note that if the business partner and document method is in use and there is no
owner for a business partner, the settings on the Documents tab will apply instead
of the settings on this tab.
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Summary 1 of 2
Key points from this topic:
 General authorizations and a license permit a user to access objects and all documents for the
object. This is not always desirable. Many companies want to restrict access on a more granular,
need-to-know basis.
 Data ownership is not enabled in the system by default. Once you enable data ownership, access to
other users’ documents is restricted and must be granted using data ownership authorizations.
 Data ownership authorizations are different to general authorizations. Data ownership authorizations
are based on a user’s relationship with the owner of a document.
 Employee master data defines the relationship between owners and users who need to access
documents. Employee master data enables you to define an organizational structure with reporting
lines, teams, branches and departments.
 If a document has no owner then data ownership rules are ignored and any user can access the
document.
 Super users are not restricted by data ownership and can access all documents regardless of
owner.

© 2018 SAP SE or an SAP affiliate company. All rights reserved. ǀ PUBLIC

219

Here are some key points to take away from this session.
▪ General authorizations and a license permit a user to access objects and all
documents for the object. This is not always desirable. Many companies want to
restrict access on a more granular, need-to-know basis. An example might be a
sales or purchasing department where all users have the same general
authorizations and license, but where documents should not be visible to all users
in the department.
▪ Data ownership is not enabled in the system by default. But when you enable data
ownership, access to other users’ documents is restricted. Access to a document
must be granted using data ownership authorizations.
▪ Data ownership authorizations are different to general authorizations. Data
ownership authorizations are based on a user’s relationship with the owner of a
document.
▪ Employee master data defines the relationship between owners and users who
need to access documents. Employee master data enables you to define an
organizational structure with reporting lines, teams, branches and departments.
▪ If a document has no owner then data ownership rules are ignored and any user
can access the document.
▪ Super users are not restricted by data ownership and can access all documents
regardless of owner.
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Summary 2 of 2
Key points from this topic:
 There are three data ownership methods which control how the owner is assigned in a document:
▪ Business partner only: applies to documents and business partner master data. The owner of the
master data is assigned as the document owner.
▪ Document only: applies to documents. The owner of the document is assigned according to a set
of rules.
▪ Business partner and document: is a hybrid. If there is an owner in the master data, the rules for
the business partner only method are used. If there is no owner the rules for the document only
method are used.
 Data ownership permissions are: None, Read-Only or Full. None is the default so all permissions must
be explicitly defined for each user in the Data Ownership Authorizations window.
 Data ownership relationships with the owner can be: peer, team, manager, subordinate, branch,
department or company.
 If data ownership is set at the company level for a document or business partner, the user will have
read-only or full access (as assigned) to all documents and/or all business partners. An example is to
give an auditor read access to all documents.
 You can bypass data ownership for a document type, or for specified forms and reports, using the
sharing options window.
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Here are some key points to take away from this session.
▪ There are three data ownership methods which control how the owner is assigned
in a document:
▪ Business partner only: applies to documents and business partner master data
and access is based on a user’s relationship with the owner of the master data.
▪ Document only: protects documents and access is based on a user’s
relationship with the owner of the document.
▪ Business partner and document: is a hybrid. If there is an owner in the master
data, the rules for the business partner only method are used. If there is no
owner the rules for the document only method are used.
▪ Data ownership permissions are: None, Read-Only or Full. None is the default so
all permissions must be explicitly defined for each user in the Data Ownership
Authorizations window.
▪ Data ownership relationships with the owner can be: peer, team, manager,
subordinate, branch, department or company.
▪ If data ownership is set for a user at the company level for a document or
business partner, the user will have read-only or full access (as assigned) to all
documents and/or all business partners. An example is to give an auditor read
access to all documents.
▪ You can bypass data ownership for a document type, or for specified forms and
reports, using the sharing options window.
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System Setup and Administration:
Document and Master Data Numbering
SAP Business One Version 9.3

PUBLIC

▪ This topic will show you how to set up customized numbering for document series and master data
records.
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Objectives

Objectives:
▪

Create and assign ranges of document numbers to users

▪

Change menu names for documents in the main menu

▪

Create and assign automatic numbering series for business partner,
item and resource master data
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▪ On completion of this topic, you will be able to:
▪ Create and assign ranges of document numbers to users
▪ Change menu name for functions in the main menu
▪ Create and assign automatic numbering series for business partner, item and resource master
data

222

Business Scenario

The sales staff at DG Industries work in separate market areas. The sales
documents need to be numbered differently so they can be tracked to each area.
Additionally, the customers in each market area should be numbered
accordingly.

Sales Order

Delivery

A\R Invoice

Incoming
Payment
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▪ The sales staff at DG Industries are divided into three separate market areas, each with a different
set of customers.
▪ The sales documents produced by each area should be numbered differently so they can be
tracked to each area.
▪ Additionally, the customers for each area are coded differently.
▪ Solution: You can define multiple document numbering series, and customer master data
numbering series, and assign these series to specific users.
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Document Numbers

▪ In the first part of this topic, we will cover document numbering.

224

Document Numbering
Administration > System Initialization > Document Numbering
▪

Each company has its own numbering
method and rules

▪

The document numbering function
provides the flexibility to define unique
numbering schemes for a company’s
master data records as well as for
individual documents and transactions

▪

Document numbering is defined in a
series for each document type and the
series tracks the next number to be
allocated in the series

▪

Note: Some localizations have legal
regulations for document numbers

Numbering series
per document type
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▪ Each company has its own numbering method and rules. The document numbering function
provides the flexibility to define unique numbering schemes for both master data records
(customers, vendors, items and resources) as well as for individual documents and transactions.
▪ Document numbering is defined in a series for each document type.
▪ The document numbering series tracks the next document number to be allocated for each
document type. The system will automatically allocate numbers incrementally from the first number
and will record the next number to be allocated for each document type.
▪ Note that some localizations have legal regulations regarding document numbers.
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Document Numbering Series
▪

A new company database has a
predefined numbering series for
each document – the Primary
series

▪

In the default series, document
numbers start at 1

▪

Multiple users can share the same
series, or you can define additional
numbering series for different users
so they can work with different
numbering ranges
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▪ A new company database has a predefined series of numbers for each document type, starting at 1.
This is called the Primary series.
▪ The series has no ending number therefore the numbering is uncapped. You can use these series
right out-of-the-box if the company wants to start document numbers at 1.
▪ Multiple users can share the same series.
▪ Alternately you can define additional numbering series for different users so they can work with
different ranges of numbers.
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Editing the Primary Series
▪

You can change the starting
number in the primary series
(before any documents have
been posted)

▪

Double-click the row for the
document type to open the
series setup window

▪

Enter a new starting number
and optionally a final number for
the series
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▪ In a new SAP Business One system, you can change the starting number in the default Primary
series for any document type. You must do this before a document has been posted. One reason
for doing this is so that document numbers follow incrementally on from the legacy system
numbers.
▪ To change the default numbering series, double-click the row for the selected document type to
open the series setup window.
▪ In the Primary series row you can enter a new starting number for the series, and optionally a final
number for the series.
▪ If you change the default series the change will be instantaneous and when documents are created
they will start with the new number.
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Creating a New Document Numbering Series
▪

To create a new series, open the series setup window then choose
Add Row from the context menu

▪

Enter the starting number for the series

▪

You must also enter the final number in the previous series

▪

Document numbers cannot overlap between series for the same
document type
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▪ If only one series is required within the company, you can use the default Primary series for all
users.
▪ However you have the option to create additional series for a document type, and allocate different
series to different users. This is useful if you want each user to work with a defined range of
document numbers.
▪ To create a new series, open the series setup window then right-mouse click on the Primary series
row and choose the option to add a new row from the context menu.
▪ Enter a name for the series, together with the starting number and optional last number. The system
populates the Next No. field automatically.
▪ Note: when you create a new series, you must enter the final number in the previous series
(including the Primary series). This is to avoid overlapping numbers between series. If legally
acceptable in the localization, the system allows gaps in the numbering between series.
▪ The example shows three new series for sales quotations. Each series will be used in a separate
area of the business. Each new series starts with the next consecutive number after the previous
series, to ensure there are no gaps in the document numbers.
▪ If the localization permits a document numbering series containing more than one document type,
you will be able to set this up in this window provided the Permit More than One Document Type
per Series checkbox is ticked in the Company Details. This setting is irreversible.
▪ Note: when you save the new numbering series the system requires you to also update the main
document numbering window.
▪ To create and maintain document series, you need the general authorization Administration >
Document Numbering.
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Creating a New Document Numbering Series (cont.)
▪

You can enter a prefix and/or suffix for any series, including the primary series

▪

Prefix or suffix is not part of actual document number and only appears when printing

▪

Series can be locked to remove from allocation

© 2018 SAP SE or an SAP affiliate company. All rights reserved. ǀ PUBLIC

229

▪ You can enter a prefix or suffix (or both) for any series, including the primary series.
▪ The prefix or suffix is not part of the actual number that is assigned to the document, but will appear
when the document is printed.
▪ You can also enter remarks on the row pertaining to the series.
▪ The Lock checkbox allows you to remove a series from allocation. No further documents can be
created with the numbers in that series. To continue operations, ensure that another series is set as
the default.
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Authorizing Users to Document Numbering Series
▪

When a new user account is created, user has no access to any numbering series, even the default series

▪

User needs authorization to the series group

▪

Select a Group in the series setup window then grant the authorization to the series group (in the
Authorizations window)

▪

Once the user is authorized they can create documents

Grant the user the
general
authorization
“Series – Group
No.2”

Assign the
numbering series
to Group 2
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▪ When a new user account is created, that user has no access to any document numbering series,
even to the default series. This means that the user cannot open the initial window for any
document type, until they have general authorization to the numbering series group.
▪ Each numbering series can be assigned to a group in the series setup window. You can select a
group number between 1 and 10. There can be more than one numbering series with the same
series group.
▪ You can then authorize users to one or more numbering series groups according to their document
numbering needs. There are two ways to authorize a user:
▪ Assign the user to an authorization user group that has the authorization to the group
associated with the numbering series. Note: An authorization user group is not the same as a
numbering series group.
▪ Manually assign the user Full authorization to a numbering series group in the Authorizations
window.
▪ The general authorization is called Numbering Series and there are 10 authorizations which map to
the groups in the series setup window.
▪ In the slide example, the primary numbering series is assigned to group 1 and the new LOC2
numbering series is assigned to group 2.
▪ In the general authorizations window the user George is given full authorization to series group 2.
This means that George can create documents in the LOC2 series.
▪ For more information on general authorizations and authorization groups, see the companion
course General Authorizations.
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Period Indicators and Numbering Series
▪

Period indicator column aligns series directly to a posting period

▪

As a result, only document numbers for a series with same period indicator as current posting period can be
posted

▪

Period indicator can be used to align a numbering series to a fiscal period and enable document numbering
to restart at 1 for each new fiscal year

▪

Default period indicator is assumed if you do not select a period indicator, and is also the default for a new
numbering series

© 2018 SAP SE or an SAP affiliate company. All rights reserved. ǀ PUBLIC

231

▪ The Period indicator column on the series row aligns the series directly to a financial posting period,
for example, FY2016, FY2017. As a result, documents can be posted with numbers from the series
only if the period indicator matches the current posting period.
▪ An example might be to use a new numbering series at the start of a new financial year. If you use a
different period indicator for each new posting period, you can define a new numbering series and
set the first document number to 1 for each new fiscal year.
▪ Period indicators are optional. When you define a new posting period the Default period indicator is
assumed if you do not select a specific period indicator. This is also the default period indicator for
a new numbering series.
▪ Note: If you create a new period indicator and want to use this for the existing posting periods, you
must do this before any document postings.
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Cancellation Series

•

If a document can be cancelled by a user,
cancellation checkbox appears on series
row

•

To designate a series as a cancellation
series, select the Cancelation checkbox

•

When user cancels a document, original
document is cancelled and a new
cancellation document is issued from the
cancellation series
Original invoice

Cancellation invoice
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▪ If a document has the ability to be cancelled by the user, you will see a cancellation checkbox on
the series row. If you select this checkbox you can dedicate the series to cancellation documents.
When the user cancels a document, the document is closed with its original number, and a new
document is issued with the cancellation number from the series. The cancellation series is only
used when the system creates a cancellation document.
▪ This allows the document numbering in the current series to continue incrementally.
▪ By default, cancellation documents take numbers from the cancellation series with the lowest
numeric range, even if you have specified a non-cancellation series as the default series.
▪ Therefore, in order to manage your documents more easily, we recommend that you add
cancellation documents to cancellation series only.
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Defaults Series for a User
▪

If you have multiple series, you can assign a series as
a default for the user

▪

In series setup window, select a series and choose Set
as Default. Default series automatically selected for
new document

Set as default for:
 Current user
 All users
 Certain users
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▪ If a user is authorized to multiple series, you can set one series as the default for the user.
▪ To assign a default series, in the series setup window select the series row and choose the Set as
Default button. You can assign the series as default for the current user, for all users, and for
selected users by name. When the user creates a document, the default series is automatically
selected for the new document and the next number from the default series is allocated to the
document.

233

Working with Multiple Series
▪

If a user is authorized to multiple series, the dropdown list in the document will show all series the user is
authorized to

▪

The default series set for the user is automatically selected first

▪

A cancellation series does not show in the dropdown list

▪

If period indicators are used, a numbering series will only show when the period indicator matches the period
indicator in the current posting period

Default series for user
automatically selected

All series that user is
authorized to are
selectable in
dropdown list
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▪ If a user is authorized to multiple numbering series for a document the dropdown list in the
document will show all the series the user is authorized to. The default series for the user is
automatically selected first.
▪ In the example the user has authorization to groups 1 and 2. The series Sales 1 has been set a
default for the user so this series initially shows when the user creates a document. The user can
open the dropdown list to see all series to which they have authorization, and select a different
series.
▪ A cancellation series never appears in the dropdown list.
▪ If period indicators are used in a series, the series will not show in the dropdown list until the system
date is within a posting period with the same period indicator. In the example, the current period
does not have the same period indicator, therefore the series S2016 and S2017 do not appear in
the dropdown list.
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Manual Document Numbering

▪

Authorized users can enter a manual
document number by selecting Manual
from the dropdown list

▪

The document number is entered
by the user

▪

System will skip this number in
future when it allocates from a
predefined series

▪
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Manual documents always have
the status “Open – Printed”
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▪ Authorized users and super users can enter a manual document number. This is useful if you are
entering legacy documents during an implementation and the customer needs to use the exact
numbers from the legacy system. The general authorization is Document Manual Numbering.
▪ Select the Manual series from the dropdown list and enter a number in the document
▪ If a legacy document already has the same number, the system will skip this number in future when
it allocates from the series.
▪ Note: When they are added, manual documents automatically have the status “Open – Printed”.
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Menu Names for Documents

▪

Option to change main
menu name and
document title for any
sales, purchasing or
inventory document, for
example:
A/R invoices

Sales Invoices

▪

New name is entered on
document row in
numbering setup window
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▪ By scrolling to the right of the document numbering setup window you will see the a column where
you can change the name of a sales, purchasing or inventory document name in the main menu.
This might be required if the customer uses unique terminology to describe these documents.
▪ To specify a new name, enter it in the row for the document in the numbering setup window.
▪ You can change document names even if documents have already been entered in the system. The
new name appears in the SAP Business One Main Menu and in the title bar of documents of this
type.
▪ Note: this change affects all users.
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Master Data Numbering

▪ In this part of the topic you will see how to set up numbering ranges for master data.
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Master Data Numbering
▪

In a new system, there is a default manual
series for master data: customer and vendor
master data, item and resource master data

▪

Manual series is default for all users and allows
user to enter a code when creating new master
data
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▪ In a new company the system provides a manual series for master data: customer and vendor
master data, item master data, and resource master data for production.
▪ Double-click the series row to open the setup window. This manual series is grayed out and cannot
be edited or deleted, although it can be locked. The manual series is default for all users and the
user manually enters a code when they create new master data.
▪ Note that if fixed assets functionality is enabled, it will use the numbering series for item master
data.
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Creating an Automatic Master Data Numbering Series
▪

Defining a new series for master
data is similar to defining a
document numbering series

▪

Enter the starting number for the
code. This number will be
allocated as the master data
code, and the next number by 1

▪

You can optionally a prefix and/or
suffix. Prefix and suffix will be
added to generated code to
create multi-part numbers. Prefix
and suffix are not incremented

▪

You must specify No. of Digits

Prefix and/or
suffix are part of
generated code
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You must specify the
number of digits for the
code (leading zeroes
will be added)
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▪ You can define automatic numbering ranges for master data. These series function similarly to the
document numbering series, and they track and allocate numbers when new master data is created.
▪ Defining a new series for master data is very similar to defining a numbering series for documents.
▪ To define a new series, enter the first number for the series. This will be allocated by the system as
the code (key) for new master data records. The system then increments the next number for the
series by 1.
▪ You can optionally enter a suffix and/or a prefix for each series. Unlike the prefix or suffix for a
document number, the master data prefix or suffix will be added to the master data code that is
generated when the master data is created. This gives you the ability to create multi-part numbers
such as 01-0001-01. Note that only the main part of the number is incremented, not the prefix or
suffix which in this example would remain as 01.
▪ For a master data series you must specify the number of digits for the code. If you set the starting
number to 1, and the number of digits is 4, leading zeroes will be added to the code so that it is
allocated as 0001.
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Creating an Automatic Master Data Numbering Series (Cont.)
▪

You can set authorizations for users based on the Group selected for the series

▪

You can also set a series as default for users

▪

Checkbox to display message when master data created using non-manual series

▪

Master data series cannot be aligned to a period indicator
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▪ You can set authorizations for users based on the selected Group in the series setup window. This
is identical to document numbering series.
▪ And you can set a master data series as a default for one or more users.
▪ There is an optional checkbox to display a message when master data is created using a series that
is not the manual series.
▪ Note: you cannot align a master data numbering series with a period indicator.
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Creating an Automatic Master Data Numbering Series (cont.)
▪

Because the prefix and/or suffix is part of the code,
different series can have overlapping numbers

▪

Only the main part of the number is incremented,
not the prefix or suffix
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▪ Because in master data the prefix and/or suffix is part of the code, different series can have
overlapping numbers.
▪ In the slide example, each series has the same range of numbers but because we have also
defined a prefix for each series, the actual codes generated are unique.
▪ The generated code will always contain the exact number of digits specified and leading zeroes will
be added in front. For example, if a series starts at 1, and the number of digits is 3, the code
allocated in the master data is 001. If the number of digits is 6, the generated code will be 000001.
Note: The number of digits for a series cannot be changed after a master data record has been
created.
▪ Care should be taken since the number of digits can be a limiting factor for the size of the series. In
the example shown, in the series Computer there can be 9999 possible items since the number of
digits is defined as 4.
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Check Document Numbering Utility
Administration > Utilities > Check Document Numbering
▪
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Report shows list of missing or duplicate
document or master data numbers

242

▪ A utility is provided to check for duplicated or missing numbers in documents or master data. In the
selection criteria you can select documents by type, and include master data numbering as well.
▪ The report shows a list of missing or duplicate numbers. You can use this report to check numbers
after an initial upload of documents during implementation.
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Summary
Key points from this topic:
▪ Document numbering allows authorized users to establish ranges of numbers that will be
automatically assigned in documents and master data
▪ You can create a numbering series for each document type, and for business partner, item
and resource master data
▪ Users must be authorized to use a numbering series. To do this, first assign the numbering
series to a series group, then authorize users to the series group using the general
authorization
▪ If users are authorized to multiple numbering series you can set one as default
▪ Document numbers do not include the prefix or suffix, therefore numbers cannot overlap
between series. Master data numbers do include the prefix or suffix, therefore numbers can
overlap between series
▪ In master data series you must specify the number of digits for the code. The code will be
padded with leading zeros until the number of digits is reached

▪ In the document numbering setup window you can change the name of a sales, purchasing
or inventory document name in the main menu
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▪ Here are some key points to take from this topic:
▪

The document numbering function allows authorized users to establish ranges of numbers that
will be automatically assigned in documents and master data

▪

You can create a numbering series for each document type, and for business partner, item
and resource master data

▪

Users must be authorized to use a numbering series. To do this, first assign the numbering
series to a series group, then authorize users to the series group using the general
authorization

▪

If users are authorized to multiple numbering series you should set one as default to prevent a
user from selecting the wrong series in the series dropdown list in a document.

▪

Document numbering series can have a prefix and/or suffix. The allocated document number
does not include the prefix or suffix, therefore numbers cannot overlap between series. Master
data numbering series also include the prefix or suffix, and the allocated number does include
the prefix and/or suffix, therefore master data numbers can overlap between series.

▪

Document numbers can restart each year if a period indicator is used in the series definition.

▪

In master data series you must specify the number of digits for the allocated code. The code
will be padded with leading zeros until the number of digits is reached.

▪

In the document numbering setup window you can change the name of a sales, purchasing or
inventory document name in the main menu. This might be required if the customer uses
unique terminology to describe these documents.

243

System Setup and Administration:
UI Configuration Templates

PUBLIC

▪ In this topic you will see how to simplify the predefined forms in SAP Business One.
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Objectives

At the end of this topic, you will be able to:
▪ Edit and simplify the layout of standard documents and forms
▪ Assign the edited documents and forms to multiple users by means of a
UI configuration template
▪ Explain how to manage multiple UI configuration templates
▪ Describe how the UI Elements tab in the form settings window works
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▪ After completing this topic, you will be able to:
▪ Edit the layout of standard SAP Business One documents and forms
▪ Assign the edited documents and forms to users in a UI Configuration template
▪ Explain how to manage multiple UI configuration templates
▪ Describe how the UI Elements tab in the form settings window works
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Business Example

To improve the efficiency of service calls, customer support staff
need to quickly scan key information in documents and master
data.
They need a simplified version of the standard forms, with fields
that are not relevant removed, fields that are service-related on
the same tab, and user-defined fields easily accessible.
This requirement can be easily implemented using a
UI configuration template that contains the set of
simplified forms.
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▪ Service is paramount to OEC Computers. To improve the efficiency of service calls, customer
support staff must be able to quickly scan key information in documents and master data. They
need a simplified version of the standard forms, with fields that are service-related consolidated
together on the same tab, with unused fields removed from the form, and with user-defined fields
easily accessible. Users need a user interface that is streamlined and easy to work with.
▪ Standard forms can be easily simplified to meet the needs of a group of users. These edited forms
are grouped into UI configuration templates which can be assigned to end users according to their
role.
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Simplifying Forms

Hide or
deactivate
unwanted
fields

Move userdefined fields

Move fields from
tab to main part
of form

Move fields or
buttons to more
convenient part of
form
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Instead of working with the standard forms, you can make them fit your requirements by hiding or
deactivating unused fields, moving fields or buttons to a more convenient part of the form, moving
fields from another tab onto the main tab for ease of access, and moving user-defined fields from the
side window.
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UI Configuration Templates

▪ The first part of this topic explains the purpose of a UI configuration template.
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Authorizations for UI Changes

To edit a form for personal use, user needs general authorization:
 General Edit Form UI
To modify forms for other users, user needs general authorization:
 Administration Utilities  UI Configuration Template

Requirement

Menu Path

Authorization

Edit a form for
personal use

Tools > Edit Form UI

General  Edit Form UI

Edit forms for others in Administration > Utilities >
a UI template
UI Configuration Template
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Administration Utilities 
UI Configuration Template

249

▪ Authorized users can edit and modify forms for personal use using the Edit Form UI tool. The tools
menu will become active when the user opens an eligible form. The authorization required for
editing a form is found under the General subject area in the general authorizations window.
▪ Authorized users are able to modify forms for other users by creating a UI configuration template.
The required general authorization is found under the Administration > Utilities subject area in the
general authorizations.
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UI Configuration Template
Administration > Utilities > UI Configuration Template
▪

UI configuration template is a
collection of forms edited for needs
of end users

▪

To create a new template, open the
UI Configuration Template window
and select Data > Add
List of edited
forms for a group
of users

© 2018 SAP SE or an SAP affiliate company. All rights reserved. ǀ PUBLIC

250

▪ A UI configuration template is a collection of forms that have been simplified and/or modified to
meet the common needs of a set of end users. In SAP Business One all forms and documents can
be modified.
▪ To create a UI configuration template, choose the menu path shown in the slide, then choose Data
> Add from the menu bar.
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Adding Forms

▪

Individual forms are selected
from dropdown list and then
edited to meet user
requirements

▪

Additional UI templates can
be created for different sets
of users

Note: Some edit functionality
overlaps with form settings.
Users can still make further
changes to their own forms
using form settings

Select forms to go
into template
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▪ The individual forms are selected from a dropdown list on the Forms tab, and then individually
edited.
▪ Additional UI templates can be created for different sets of end users.
▪ Note: Some of the edit functionality, such as hiding fields, can also be achieved using form settings.
Users can still make further changes to a form for personal use using form settings.
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Edit UI Mode
▪

Select a form and choose the Edit Form UI button

▪

In edit mode the form has a distinctive black title
area

▪

Clicked field is highlighted for editing
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To edit a form, select the row for the form in the template then choose the Edit Form UI button. Note
that this button does not become active until you select a form.
When you press the Edit Form UI button you enter edit mode. The form has a distinctive black title
area. The title of the form changes to include the text “UI Edit Mode”.
Now you are ready to make design changes!
When you click on a field it is immediately highlighted and you can perform an action on the field such
as hiding it or moving it.
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Assigning Users to the UI Template
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▪

Users can be
assigned to the UI
template individually
or by user group

▪

After the assignment,
the modified forms
will automatically
open instead of the
standard forms when
the assigned user
next logs in
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▪ After the set of forms has been edited, the UI configuration template is assigned to users:
▪ Individually by name on the Assigned Users tab
▪ As a user group on the Assigned Groups tab. The user group must be of type UI Configuration
Templates or Cross All Types. See the companion course Users and User Groups for more
information on user groups.
▪ These modified forms will automatically open instead of the standard forms when the assigned user
next logs in.
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Making the Changes

▪ In this section we show you how to edit and simplify forms.
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Hide and Disable Fields

In UI Edit mode, select a field or
multiple fields, and open the
context menu to see edit options:
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•

Hide: removes the field and
description from the form

•

Disable: an editable field
becomes gray and cannot be
changed by the user

255

▪ In edit mode, you can select a single field or multiple fields, and open the context menu by rightmouse clicking.
▪ If the field is editable, the context menu will allow you to hide or disable the selected field or fields.
When you hide a field a space is left in the form. When you disable a field it becomes gray and
cannot be changed by the user.
▪ If the field is inactive, (displayed in gray), the context menu will only allow you to hide the field.
▪ In the example the business partner master data form is shown, however, the same editing rules
apply to all eligible forms.
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Using Drag and Drop

▪

Make use of white space in the
form by moving fields to a more
convenient position

▪

To move a field, select field and
drag to new position

▪

Can move field from a tab to form
header, or from one tab to a
different tab
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▪ You can make use of the white space in a form to move fields to a more convenient position.
▪ You can move fields by selecting the fields and dragging and dropping them into position.
▪ You can move a field from a tab onto the main header of the form.
▪ You can also move a field from one tab to a different tab by parking it temporarily in the header area
before you switch to the target tab.
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Aligning Fields

To align moved fields to existing fields, select
the fields then choose Align from the context
menu

Fields
aligned left
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▪ After you have moved fields, you can align them to existing fields by choosing Align from the context
menu.
▪ To align fields with an existing field, select the existing field in addition to the moved fields, then
choose left or right.
▪ To close up any spaces, select an existing field in addition to the moved fields, then choose top or
bottom.
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Moving User-Defined Fields
To move a user-defined field (UDF)
from the side window to the main
form area:
▪

Select and hold your mouse
on the field until a black
border appears (1)

▪

Drag the black rectangle to
the main area (2)

▪

Move into position and
release (3)

1

2
3
3
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▪ A key advantage of editing a form is to move user-defined fields from the side window to the main
header of the form or to a tab within the form. This is especially useful for UDFs added to marketing
documents. Since you edit each document type separately, you can move user-defined fields
relevant only for that document type without the need to use UDF categories in the side window.
▪ Only one UDF field can be moved at a time. To move a UDF:
▪ Select the field, not the label, and hold with your mouse until a black border appears (see
screenshot 1).
▪ Drag the field to the main form (see screenshot 2).

▪ Position the UDF on the main form (see screenshot 3).
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Save and Restore Default

After you have made the editing
changes, click anywhere in the
form white space and open the
context menu to:
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•

Save: commits the changes

•

Restore Default: backs out all
changes and restores fields to
the original out-of-box format
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▪ After you have made the changes, you need to save them. Click anywhere in the form white space
and open the context menu. Choose Save to commit the changes. If you close the UI Edit window
without saving you will lose the changes.
▪ The Restore Default option on the context menu acts as an “undo” button. So if you have hidden a
field, it will be restored on the form in the original position.
▪ Be aware that the action of restoring defaults changes all fields in the form back to the original outof-box format. Even if you have saved and closed the UI template, when you restore the form it will
be set back to the original settings. Tip: If you decide to change an already heavily-modified
document that is in use by several users, first make a copy of the UI template. This gives you the
ability to restore the document, if necessary, from the copy, instead of having to restore it to the
original settings.
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Adding Tabs
Select Add Tab from the white space context menu to add a new tab to a form
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▪ If the form or document contains tabs, you can add a new tab. Select the option from the context
menu. You can move existing fields to the new tab, including user-defined fields.
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Form Settings in UI Edit Mode
▪

When you open form settings in UI Edit Mode, UI Elements tab
lists every header field, and every field on each tab

▪

You can hide and disable fields by deselecting Visible and
Active checkboxes (equivalent to context menu hide and
disable)
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▪ In UI Edit Mode, when you open the form settings window you will see an additional tab called UI
Elements. This tab shows every field shown on the header and each tab of the document, and you
can hide and disable fields from this window using the Visible and Active columns. This is
equivalent to hiding and disabling fields using the context menu.
▪ Note that the UI Elements tab only appears when form settings is opened from a form in UI Edit
Mode. End users never see the UI Elements tab.
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Hiding a Tab using Form Settings
▪

Option to hide tab by making the tab entry invisible in
the UI Elements
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▪ You can also hide an entire tab by making the tab entry invisible in the UI Elements tab.
▪ In the example, we want to hide the Planning Data and Properties tabs from the item master data
since they are not used in the company. In the form settings we deselect the relevant checkboxes
for the Planning Data and Properties tabs. As a result the tabs no longer appear in the item master
data form.
▪ The Header and General tabs in master data forms are grayed out in the form settings and cannot
be hidden. In marketing documents the Contents tab cannot be hidden.
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Summary
UI Edit
Mode

UI Elements
tab

Form
Settings

Move a field (drag and drop)



Move a field to another tab



Move a user-defined field to
main form



Align and compact fields



Hide a field







Disable a field







Add a tab





Hide a tab
© 2018 SAP SE or an SAP affiliate company. All rights reserved. ǀ PUBLIC

263

▪ The slide shows a comparison of the edit actions that can be done using UI Edit Mode, the form
settings window using the UI Elements tab, and the standard form settings window.
▪ Note that the standard form settings window is only available for certain forms, such as marketing
documents.
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Managing UI Configuration Templates

▪ The next part of this topic looks at how you can manage UI configuration templates.
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Copying Edited Forms to Other UI Templates

Multiple UI configuration templates can
be created and assigned to different
sets of users
To save time, you can copy edited
forms from one UI template to another
UI template. Select one or more forms
and choose Copy To button
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▪ Often there is a need to create multiple UI configuration templates and assign to different sets of
users.
▪ Once you have made the changes to a form in one UI configuration template, you can copy the
changes to another UI configuration template.
▪ To do this, select the rows for the forms you want to copy, choose the Copy To button, and select
the target UI template.
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Default UI Template
▪

Option to designate a default UI configuration template in
General Settings

▪

Default template will apply to all new users and to existing
users who are not assigned to any other UI template

▪

If a user is later assigned to a different UI template, the new UI
template will take precedence over the default UI template

▪

Example: A new UI template Sales group 2 is created. What
will happen when this is set as a default template?
Result:
Already assigned
to Sales group 1
UI template

Not assigned to
any UI template

Still assigned to sales group 1
template

Assigned to sales group 2
template
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▪ Instead of assigning a UI template to every user, you can designate a default UI template on the
Display tab of the General Settings.
▪ The default template forms will be automatically applied to all new users created after the default
template was set, and will also apply to existing users who are not currently assigned to a UI
template.
▪ If a new user is later assigned to a UI template that is not the default template, the assigned
template forms will take precedence over the default UI template.
▪ Let us examine how designating a default UI template affects existing users who may or may not
have already been assigned to a UI template.
▪ In this example, we have an existing UI template Sales group 1. We create a new UI template
Sales group 2 and set this as a default.
▪
User A, who was previously assigned by name to the Sales group 1 template, is not affected
by the default template. User A will still see the forms from the Sales group 1 template.
▪
User B, who was not assigned to any template, is affected and will now see the forms from the
Sales group 2 template.
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User Perspective
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Form Settings
▪

User can show
and hide fields
using form
settings

▪

If the form is
assigned to the
user in a UI
configuration
template, the
name of the
template appears
in the form
settings window

▪

The user can still
make changes
using form
settings
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Any user can show and hide fields in a marketing document form using the form settings icon (if they
have the authorization General > Document Settings).
If the user presses the form settings icon for a form that they are assigned to in a UI configuration
template, the name of the UI template appears in the form settings window. The user can still make
changes to the form.
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Multiple UI Templates

If user is assigned to multiple UI
templates with overlapping forms:
▪

First assigned template considered
highest priority

▪

User has option to apply a different UI
template in form settings
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▪ The system allows you to assign multiple UI templates to a user. Since the templates could contain
overlapping forms, how does the system know which one to use?
▪ The first template assigned to a user is considered the highest priority.
▪ The user has the option to choose a different UI template from a dropdown list in the form settings
window, and switch to the forms in that template by choosing the Apply button.
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Summary
Key points from this topic:
▪ Simplifying frequently used forms and documents can increase user productivity and
reduce errors when processing forms
▪ A UI configuration template is a collection of forms that have been simplified and/or
modified to meet the needs of end users
▪ You can create different UI templates for different sets of users
▪ All forms and documents in the system can be modified
▪ Changes include: rearranging fields using drag and drop, moving fields to a new tab,
hiding and disabling fields, aligning fields, adding and removing tabs, moving userdefined fields from the side window
▪ You can assign users to the UI template individually or from a user group

▪ In the General Settings you can set a default UI template for all new users

270
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These are the key points from this topic:
▪ Simplifying frequently used forms and documents can increase user productivity and reduce
errors when processing forms
▪ A UI configuration template is a set of forms that have been simplified and/or modified to meet
the needs of end users
▪ You can create different UI templates for different sets of users
▪ All forms and documents in the system can be modified

▪ Changes include rearranging fields using drag and drop, moving fields to a new tab, hiding and
disabling fields, aligning fields, adding and removing tabs, moving user-defined fields from the
side window
▪ You can assign users to the UI template individually by name, or from a user group.
▪ In the General Settings you can set a default UI template to apply to all new users
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Customization Tools:
Queries
SAP Business One Version 9.3

PUBLIC

▪ This topic introduces you to the tools that SAP Business One provides
for creating SQL queries.
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Objectives

Objectives:
▪

Create SQL queries using the query tools provided in SAP
Business One

▪

Identify database field and table names in a form or
document using System Information

▪

Save, manage, execute and control access to saved queries
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▪ In this topic, you will learn to create SQL queries using the query tools
provided in SAP Business One.
▪ You will learn how to identify database field and table names in a form
or document using System Information.
▪ You will also see how to save, manage, execute and control access to
saved queries.
▪ Note that the query examples provided in this course are written for
SAP Business One version for SAP HANA.
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Business Scenario
Queries give you the ability to quickly display data from SAP Business One
company database tables. You can use queries to:
▪ Produce ad hoc reports (User Queries)
▪ Create user-defined alerts and approval processes
▪ Populate the contents of a field, including user-defined fields. The query is
added to the field as user-defined values (UDVs)
▪ Show dynamic information for analytics in dashboards and KPIs
▪ Validate the values imported into a table or field during data migration

You are not allowed to use the query tools to insert, update or delete
standard table fields.
273
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▪ Queries enable you to quickly display and format data from an SAP
Business One company database. You can use queries in several
ways, for example:
▪ To produce ad hoc reports that can be run over and over again. These are
known as User Queries.
▪ Create user-defined alerts and approval processes in SAP Business One. The
query can check for conditions that are not covered by predefined alerts or
standard approval procedures.
▪ Populate the contents of a field, including user-defined fields. The query is
added to the field as user-defined values (formatted searches) and can populate
the field value from the query results.
▪ To show dynamic information for analytics in dashboards and KPIs
▪ To validate the values imported into a table or field during data migration.

▪ You should understand that the query tools are not designed to
produce complex, fully formatted reports or print layouts; you should
use Crystal Reports for these purposes. And you are not allowed to
use the query tools to insert, update or delete standard table fields.
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System Information

▪ In order to run queries you need to know the names of the SAP
Business One tables and fields. This information is displayed when you
enable System Information.
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Objects and Tables
▪

An object can span multiple tables in
the database

▪

For example, the business partner
master data object is held in several
database tables including:
▪

OCRD

▪

OCPR

▪

CRD1

▪

OSLP
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An object can span multiple tables in the SAP Business One database.
For example, the business partner master data object is held in multiple tables in the
database, including the header table OCRD. There are related child tables, such as
OCPR, CRD1, OSLP, etc. These child tables hold the data that you see on the
various tabs of the business partner record.
In SAP Business One table names are 4 characters long.

System Information
View > System Information (Ctrl+Shift+I)
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▪

System Information shows the table and
field names for a form that you are
viewing

▪

To see the table and field name, enable
System Information from the View menu
(or press Ctrl +Shift +I)

▪

When you move your mouse over a
field, the information shows in the status
bar

▪

Example: If you hover over the Name
field in the Business Partner Master
Data, you see that the table is OCRD
and field name CardName
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To develop a SQL query you need to know the database table and field name for
selection.
When you open an object in SAP Business One, you can find out the table name for
a field by enabling System Information from the View menu. You can also use the
keyboard shortcut Ctrl + Shift + I.
Then, when you hold your mouse over a field in the object, the relevant table
information for the field is shown in the status bar at the bottom of the window.
You now have the table name and field name to enter in your SQL query.
Other information about the field is displayed, such as the maximum length of the
field.
The business partner master data object is shown in the slide. If you hover over the
Name field you will see that the table is OCRD and the field name is CardName.

Documents and Objects
▪

Sales and purchasing documents are also
represented as objects

▪

Each document type (sales order, sales
delivery, A/R invoice, purchase order, A/P
invoice, and so on) has the same structure and
is based on several objects including:

▪

▪

Documents object (the header parts)

▪

Document_Lines object (the matrix or row
part)

Header

Rows

A document, such as the sales order document
shown here, spans multiple tables, for
example:
▪

ORDR

▪

CRD1

Header
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Sales and purchasing documents, such as orders, quotations, and
invoices, all have the same structure and are based on two main objects:
• The Documents object for the header parts of the document
• The Document_Lines object for the matrix or row section of the
document
A document type, such as a sales order, spans multiple tables. The
tables will be different for each document type, so that the set of tables
for a purchase order is different from the set of tables for a sales order.
For example, the sales order uses the database table ORDR for the
header and the table CRD1 for the rows.
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System Information - Item and Column Numbers
System information also shows:
▪

The item number for a header
field

▪

The item, column and row
number for a row-based field

▪

Item and column number for a
field is same across similar
document types

▪

Since all marketing documents
have the same item and
column number for a field, you
can write queries that work
across different document
types by referencing the item
and column numbers

Item number
for header field

Item, column
and row number
for row field

278
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▪ The system information also shows, in addition to the table and field name, the
item number for a header field, and the item, column and row number for a rowbased field.
▪ For example, in a sales order, the item number for the CardCode field is 4. The
column number for the CardCode field is not displayed, since this is a header field
in table ORDR and the column number for all header fields is 0.
▪ If you open other marketing documents, you will see that the CardCode field is
always 4.
▪ Why is this important? The item number for a field is common across all document
types that have the same structure, such as sales and purchasing documents. In
these documents, the item numbers are the same, but the table names are
different. Using the item number instead of the field name allows you to write
queries that can work across multiple document types, by referencing the same
item number.
▪ In the lower screenshot on the slide, you can see that the ItemCode field in the
sales order document matrix has item number 38 and column number 1. The row
number 1 denotes the first row in the document (that is, row numbers start at 1).
▪ You will notice that the item and column number for a row field is the same across
similar document types, for example, the ItemCode has item number 38 and
column number 1 in all sales and purchasing documents.
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System Information - Calculated Fields
▪

Table and field names are not
displayed in System Information
for fields that include the currency
symbol in the document display
(for example, totals and tax)

▪

To use these fields in a query:
▪

Use the item number

▪

See the Database Tables
Reference

279
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▪ You will find that the table and field name is not displayed for some fields, including
the unit price and calculated fields such as totals and taxes. These fields are
shown in the document concatenated with the currency symbol, whereas in the
database the amount is stored without the currency symbol.
▪ You can still use these fields in a query. You can use the item number to refer to
the field, or you can get the database field name from the Database Tables
Reference.
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Database Tables Reference

© 2018 SAP SE or an SAP affiliate company. All rights reserved. ǀ PUBLIC

▪

Access REFDB file from
the SAP Business One
SDK > Help folder or
from the DTW help
menu

▪

Shows:
▪

Maximum length of a
field

▪

Type

▪

Default value (if any)

▪

Constraints
(permitted values)
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You can find the Database Tables Reference file REFDB in the SAP Business One
SDK > Help folder, or, if you have installed the installed Data Transfer Workbench you
can open it from the Help menu.
In addition to the field names for an object, the reference file provides:
•
The description
•
The type of field (for example, Int, VarChar, Numeric, Text, etc.).
•
The maximum length of a field
•
If the field is a foreign key there is a link to the related table
•
A default value if one exists
•
Constraints on the field values
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Query Tools

▪ SAP provides two query tools assist you in developing the query
syntax.
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Query Tools
Tools for creating user queries are located under the Tools > Queries menu

▪

Query Generator

▪

Query Wizard

282
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▪ Tools for creating and managing user queries are located under the Tools menu in
the top menu bar of the client application.
▪ SAP Business One provides two tools, the Query Generator and the Query Wizard
to assist you in creating queries using the structured query language (SQL). SQL is
a standardized set of commands for accessing and formatting data in relational
databases. Both tools produce the same results in the end, and it is mainly a
matter of your own preference as to which tool you use.
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Query Wizard
Multi-step wizard

Choose Finish
to show and
run the query
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▪ As its name suggests, the Query Wizard guides you step-by-step through the
process of creating a query without you having to write SQL commands and
syntax. You should use this tool if you do not have much experience with SQL. The
query wizard is a multi-step wizard.
▪ To run a query from the query wizard, in the final step choose the Finish button.
▪ The generated query and the results of the query appear in the query preview
window.
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Query Example with Query Wizard
To generate the query using the
wizard:
▪

Press Tab to view and select
the table name

▪

In the next step press Tab on
each row to select a field from
the list

▪

In the final step of the wizard
the query is generated

Generated query:
SELECT T0."DocNum" AS “Document Number",
T0."CardCode" AS "Customer/Vendor Code",
T0."CardName" AS "Customer/Vendor Name",
T0."DocTotal" AS "Document Total"
FROM “OPOR" T0
284
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▪ In the first step of the wizard you press Tab to view the list of database tables and
select the required table (related tables are shown and can be selected).
▪ Then in the next step you press Tab to view and select the fields. All fields from the
table are shown and you can enter partial names in the Find field. Double-click a
field to select it for the query. Select each field on a separate row in the wizard
step.
▪ The system generates the SQL statements in the background so you do not
require precise SQL syntax knowledge. However, because this is done by a wizard
it takes several steps to produce the query.
▪ You will find the Query Wizard easier to use if you do not have much familiarity
with SAP Business One tables and how they are related to each other. When you
select a table, the Query Wizard will show you all tables that are related to your
chosen table, allowing you to select data from multiple tables. If you select multiple
tables for your query, the wizard will take care of the table joins.
▪ The generated query syntax is shown in the slide.
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Query Generator
Single-step interface for building query

Choose Execute
to run the query
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▪ The second tool, the Query Generator, allows you to create the SQL in a single
screen. If you have some basic SQL knowledge, you will find the Query Generator
much faster than the Query Wizard.
▪ You select the tables and then the fields, and the query is shown in the right-hand
side of the window.
▪ To run the assembled query in the query generator, choose the Execute button.
▪ The query results appear in the query preview window.
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Query Example with Query Generator
To generate the query using the query
generator:
▪

Enter the table name, or press Tab to
see the list of tables

▪

Double-click to select each field from
the displayed list – the elements of the
query are built and shown on the right

SELECT T0."DocNum", T0."CardCode", T0."CardName",
T0."DocTotal" FROM OPOR T0 WHERE T0."DocStatus"
='O' ORDER BY T0."DocDate"

286

© 2018 SAP SE or an SAP affiliate company. All rights reserved. ǀ PUBLIC

▪
▪
▪

To generate the query, enter the table name in the text box in the top-left of the
window, or press Tab in this box to see the complete list of tables.
Press Tab again to see a list of all fields in the table. Double-click to select each
field from the displayed list. The elements of the query are built and shown on the
right-hand side of the tool window.
Like the Query Wizard, the Query Generator will automatically supply the inner
join when you select more than one table for a query. Although it does not show
you the list of tables related to your chosen table, fields that are keys to related
tables are shown in bold. You can drag and drop the bolded field to the table
selection column and the Query Generator will open the related table, allowing
you to select fields from that table.
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Query Preview Window
The Query Preview window
displays the query syntax
and the results
The SQL syntax generated
by the in-built query tools
depends on the underlying
database, either SQL Server
database or SAP HANA.
However, the results will be
the same.
In the Query Preview you
have an option to edit the
query, or write your own
query from scratch
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The Query Preview window displays the query syntax and the results
The SQL syntax generated by the in-built query tools depends on the underlying
database, either SQL Server database or SAP HANA. However, the results will be the
same.
From the query preview window you have the option to edit the built query. Click the
“pencil” icon to edit the query syntax. In edit mode you can write and run your own
query from scratch.
The query preview window also allows you to save queries for reuse. This will be
discussed later in this course.

287

Query Syntax

▪ The two query tools assist you in developing the query, but you also need some
basic understanding of the elements that make up the SQL query syntax.
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Basic Elements of a Query
Select statement
▪ Select (fields or calculation)

SELECT T0."DocNum", T0."CardCode", T0."CardName", T0."DocTotal"
FROM OPOR T0

▪ Conditions (Where) (optional)

WHERE T0."DocStatus" ='O’

▪ Sort (Order by) (optional)
▪ Group by (optional)

ORDER BY T0."DocDate"

Note: SQL is not case
sensitive, therefore
commands do not have
to be upper case
All examples shown in
this course are for SAP
HANA

Ctrl + double click to add total of rows
289
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A query, or the underlying SQL statement, contains one or more of the basic
elements listed on the slide:
▪ Selection of fields. You can also specify calculation fields that display the result of
an addition, subtraction, multiplication, or division of two fields.
▪ Conditions for selection (where clause)
▪ Sort order (order by clause)
▪ Grouping and summarizing (group by clause)

The sample query shown in the top right part of the screen will show information for
open purchase orders that have been added in the last week. The query selects data
from the purchase order table OPOR. The results of the query, a simple snapshot
from the database, is shown. The total of the rows is not shown, but you can add this
to the report by holding the Ctrl key and clicking twice with your mouse.
Note that SQL is not case sensitive, therefore the commands do not have to be upper
case. For table names and field names that contain lower case letters, in SAP HANA
syntax you are required to add double quotation marks around the field names.
All query examples shown in this course are for SAP HANA. For a list of differences
in SQL syntax for SAP HANA, see the document Best Practices of SQL in the SAP
HANA Database
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Query Elements – Where Clause
▪ Conditions (Where) (optional)
▪ Fixed conditions
▪ Calculations and functions
▪ Variables
▪

AND / OR operators can be
used to link multiple conditions

SELECT T0."DocNum", T0."CardCode", T0."CardName", T0."DocTotal"
FROM OPOR T0
WHERE T0."DocStatus" = 'O’ and T0."DocDate" >
ADD_DAYS(Current_Date, -7)
ORDER BY T0."DocDate“

Note: To find out the possible values for a field such as DocStatus, you can:
▪ Run a query on the table and select the field name. In the results you will see possible values that are
already stored in the database, or
▪ See the Database Tables Reference for a list of the allowed values (constraints).
290
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▪ The optional Where clause lets you filter only records that meet specified criteria.
Although the query tools will help you assemble the basic elements of the query,
you will need some knowledge of SQL syntax to complete the Where clause.
▪ In the Where clause you can include:
▪ Fixed conditions as comparisons. For example, in our sample query, only
purchase orders that are open (DocStatus ‘O’) will be displayed.
▪ Calculations and functions. In the sample query, we have added a calculation to
include only purchase orders that were posted in the last 7 days. We match the
posting date value (DocDate) to the current date – 7. The function ADD_DAYS
is used to calculate the current date minus 7.
▪ Variables. Variables are specified as [%0], [%1], [%2], etc. When you include a
variable, the user will be prompted to enter a value as a parameter when the
query runs.
▪ AND and OR operators can be used to link multiple conditions. In the sample
query we use the AND operator since both criteria must be met.
Note: The sample query shown uses the DocStatus field as criteria. In the database
this field has a fixed list of permitted values (constraints). To find out the possible
values for a field such as DocStatus, you have two options:
▪ Run a query on the table and select the field name. In the results you will see the
possible values that are already stored in the database.
▪ See the Database Tables Reference for a list of the allowed values (constraints).
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Query Elements – Where Clause (cont.)
▪ Variables for parameters
[%0] [%1] etc.

SELECT T0."DocNum", T0."CardCode", T0."CardName", T0."DocTotal"
FROM OPOR T0
WHERE T0."DocStatus" = 'O’ and T0."DocDate" > [%0]
ORDER BY T0."DocDate“
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▪ Variables give the user the flexibility to change the parameters when they run the
query.
▪ Variables are simply defined in square brackets with %0 as the first variable, %1
the second variable, and so on.
▪ In the example, the posting date DocDate is used as a filter but we have added a
variable condition. When the user runs the query they are prompted to enter the
posting date. The date entered by the user is used in the Where clause and
compared with the posting date from the purchase order. Only record where the
posting data is greater than the parameter date will be included in the query
results.
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Query Elements - Sort
▪ Sort (Order by) (optional)
▪ ASC / DESC

SELECT T0."DocNum", T0."CardCode", T0."CardName", T0."DocTotal"
FROM OPOR T0
WHERE T0."DocStatus" ='O‘ and T0."DocDate" >
ADD_DAYS(Current_Date, -7)
ORDER BY T0."DocDate“ ASC
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▪ You can optionally sort the query results by adding the Order By
clause to the query.
▪ The results will be sorted by default in ascending sequence (ASC)
using the specified field. In this example the rows of results (purchase
orders) will be sorted by posting date (DocDate).
▪ You can sort by descending sequence by adding the keyword DESC
▪ You can sort by multiple fields, and these fields can be either part of
the select clause or other fields in any of the tables of the query.
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Query Elements - Group By Clause
Query with addition of Group By clause

Original query
SELECT T0."DocNum", T0."CardCode",
T0."CardName", T0."DocTotal" FROM OPOR
T0

SELECT Count (T0."DocNum") as "Total # of POs", T0."CardCode",
T0."CardName", SUM(T0."DocTotal") as "Total Amount" FROM
OPOR T0

WHERE T0."DocStatus" ='O‘ and
T0."DocDate" > ADD_DAYS(Current_Date, -7)

WHERE T0."DocStatus" ='O' and T0."DocDate"
>ADD_DAYS(Current_Date, -7)

ORDER BY T0."DocDate"

GROUP BY T0."CardCode", T0."CardName"

The results are consolidated
by vendor (CardCode), with
one row for each vendor with
the count and the total
amount of all open purchase
orders
293
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▪

The optional Group By clause allows you to display the query results grouped or
summarized by a specified field, for example, by business partner. In our example, the
original query has been rewritten to use the Group By element and is shown beside the
original query on the slide.

▪ The grouped results are collected into sets using the Group By field or
fields as the common value.
▪ Group by is usually used in conjunction with a mathematical function such
as Count or Sum. In the sample query the Count function counts the
number of POs and the SUM function calculates the document total from
each PO.
▪ The selected fields are consolidated according to the fields specified in the
Group by clause, so in the sample query the results are consolidated by
vendor (CardCode), and the query shows one consolidated row for each
vendor with the count and the total amount of all open purchase orders for
the vendor.
▪ Notice that we need to supply the column headings for the fields that are
counted and summed, since the column headings for these fields are not in
the database.
▪ When using the Group by clause, fields that you use in the Select
statement must also appear in either the Group By clause or the aggregate
function (Count or SUM). For this reason, we have specified the CardName
field in the Group by clause.
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Table Aliases and Joins
▪

When you use more than
one table in a query, you
normally need to create joins
between the tables

▪

The query tools automatically
supply joins for you

▪

An alias is added (T0, T1,
etc.) to identify each table

SELECT T0."DocNum", T0."CardCode", T0."CardName", T0."DocTotal",
T1."Balance", T1."ListNum"
FROM OPOR T0 INNER JOIN OCRD T1 ON T0."CardCode" =
T1."CardCode"
WHERE T0."DocStatus" = 'O'
From OCRD
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▪ When you specify more than one table in your query, you normally
need to create joins between each table. The Query Wizard and Query
Generator tools make this easy for you by automatically supplying the
inner join when you select more than one table for a query. For
example, if you select the purchase orders table (OPOR) and also
select the business partners master data table (OCRD), the query tools
will link these tables using the business partner code which is common
to both tables.
▪ The query tools automatically add an alias for each table, for example,
T0, T1, etc. If the query references more than one table this helps you
to identify the relevant table for a field.
▪ When you select a table, the Query Wizard will show you all tables that
are related to your chosen table. In the Query Generator, fields that are
keys to related tables are shown in bold. You can drag and drop the
bolded field to the table selection column and the Query Generator will
open the related table, allowing you to select fields from that table.
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Report Column Headings
When a query runs, headings for report columns are taken from the database column names:

To change the default column heading in the
Query Generator, use the “as” keyword in the
query with the new heading text in double quotes

To change the default column heading in the Query
Wizard, type the desired text in the Heading column

Query
wizard

Query
generator
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▪ When a query runs, headings for the report columns are taken from the
database column names. To change a column heading in the query
report:
▪ In the Query Wizard, simply type in the desired text in the Heading column of
the wizard screen.
▪ In the Query Generator, use the “as” keyword followed by the new heading text
in double quotes. Enter this text directly in the Select box.
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Query Syntax – Active Window

▪

Queries that will be used in approval
processes and with user-defined values
need to reference fields in the active
window that the user is working on

▪

To refer to a field in the active window,
include a $ sign and square brackets
around the table and field name

Active Window

Example:
Select T0."Balance" FROM OCRD T0
INNER JOIN ORDR T1 ON T0."CardCode" = T1."CardCode"
WHERE ($[ORDR."CardCode"] = T0."CardCode")
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▪ In many situations, the query needs to reference fields in the active
window. In the example, the active window is identified by a blue line on the
top of the form or document.
▪ This is true for queries used in approval procedures and with user-defined
values. In these two situations the query runs while a document is being
processed by the user in the active window.
▪ If a query needs to refer to a field in the active window instead of from the
database, you must include a $ sign and place square brackets around the
table and field name to indicate the field is in the active window.
▪ In the example shown, you have added a query as user-defined values to a
field in the sales order. The query will fetch the customer’s account balance
from the master data record and show the balance in a user-defined field in
the sales order. The sales order is the active window because the user is
working on it, therefore the reference to CardCode includes the special
syntax. The query matches the CardCode from the active window to the
CardCode in the master data.
▪ The master data record in this example is not in the active window. Fields
that are accessed from the database, such as the balance field from the
master data record, do not need the $ sign.
▪ For more information on queries and approval processes, see the Approval
Processes course. For more information on queries and user-defined
values, see the User-Defined Values course.
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Syntax for Reference to Active Window
▪

Item and
Column
Number

Table and
Field Name

For referencing fields in the active window, you can use
either the table and field name, or the item and column
number syntax

[... Item= ## Column= ## …. Table Name, Field Name]

Status Bar

Table and Field Name Example:

This query can be used in an
approval template for approval
of purchase orders
In SAP HANA SQL, if there is no
FROM clause in the statement,
use FROM DUMMY.

SELECT ‘true’ from DUMMY
WHERE
$[OPOR.DocType] = ‘S’ and
$[OPOR.DocTotal] > 500
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▪ When you reference a field in the active window, you can use either the
table and field name syntax or the item and column number syntax.
▪ In the slide is an example of a query used in an approval process. If you
use the table and field name syntax for the active window, the query
includes the table name so can only be used with a single document type.
In this case the query can only be run to approve purchase orders since
the OPOR table is explicitly included in the query.
Note: Queries used in approval processes always need to select a true
result. In SAP HANA SQL, if there is no FROM clause in the statement, use
FROM DUMMY.

Syntax for Reference to Active Window
▪

Item and
Column
Number

Table and
Field Name

[... Item= ## Column= ## …. Table Name, Field Name]

If you use the item and column syntax, the field
is returned as a string and you need to specify
an alternate format after the column number:
$[$ Item Number. Column Number.0]
.Number]
.Currency]
.Date]

Item and Column Number Example:

This query can be used in an
approval template for approval
of multiple sales and/or
purchasing documents
In SAP HANA SQL, if there is no
FROM clause in the statement,
use FROM DUMMY.
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SELECT ‘true’ from DUMMY
WHERE
$[$3.0.0] = ‘S’ and
$[$29.0.number] > 500
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▪ If you instead use the item number and column syntax, the query can be
used with multiple document types of a similar structure. For example, this
query can be used in an approval process where multiple sales and
purchasing marketing documents are selected in the approval template.
▪ The system uniquely identifies each field of a document using the field’s
index and column number.
▪ When you reference a header field using the item and column syntax, set
the column number as 0.
▪ The field is fetched as a string, so if you need a different format you need
to specify the format after the column number:
▪ 0 - which is the default string format
▪ Number – which returns the result as a numeric that you can use in calculation or
comparison operators. In the slide example, the result is compared to 500. Since the
DocTotal field holds both the amount and the currency symbol, specifying numeric
here will extract the amount.
▪ Currency – which returns the currency symbol from a field that holds both the
amount and the currency symbol, such as the DocTotal.
▪ Date – which should only be used if the field is a date field. The date is retuned in a
format for use in calculation or comparison operators.

Saving and Managing Queries

▪ After you create a query you may want to save it for reuse.
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Saving a Query
▪ Query can be saved from the query preview
window
▪ Saved queries can be run from: Tools > User
Queries > Category > Query Name

Save the
query

Provide a name,
select a category,
and Save
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▪ You can save a query from the query preview window. When you save
a query you must select a category. The General category is provided
for you, but if you plan on adding many user queries you should create
additional categories to manage the queries.
▪ Queries that you save are located as User Queries. To run a saved
user query, choose the Tools menu in SAP Business One, and then
select the category and the query name.
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Query Manager
Tools > Queries > Query Manager
▪

Save and organize queries by category

▪

Remove queries

Create a new
category

301
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▪ As the name implies, the Query Manager allows you to manage user
queries that you save.
▪ You can save and organize queries by category. You can also delete
queries.
▪ The System category is for SAP supplied queries. The General
category is provided for you to save user queries, and you can create
additional categories.
▪ To create a new category, choose the Manage Categories button. Then
choose Add to add the new category and save your query. In the
example here we will create a new category called Purchasing.
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Query Authorization Groups
Query Categories


General



Sales

Query Authorization
Groups

User Authorization

Bill, Donna

Orders by Sales Employees

Sophie, Tim


Purchasing
Stock Near Low Threshold
Service POs over 5000
POs for last week
...



Julie, Juan

Alerts
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▪ When you create a new category, you must assign it to at least one
query authorization group, or you will not be able to save the new
category.
▪ Only users given access to a query authorization group can run the
queries saved for the category. This provides a way to control which
users can access and run the saved user query.
Let us look at the example provided here:
▪ You can see that query authorization groups 1 and 2 are assigned to
the query category Sales. Query authorization groups 2 and 3 are
assigned to the category Purchasing.
▪ Users Bill and Donna are assigned to query authorization group 1.
▪ Users Sophie and Tim are assigned to query authorization group 2.
▪ Julie and Juan are assigned to query authorization group 3.
▪ So, Bill and Donna can run all queries saved in the Sales category
through its association with query authorization group 1. Sophie and
Tim can run all queries saved in both the Sales and Purchasing
categories because both categories are associated with query
authorization group 2. And Julie and Juan can run all queries saved in
the Purchasing category which is associated with query authorization
group 3.
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User Authorization to Query Category


In the General Authorizations window, assign each user to the category’s group - the authorization is:
Reports > Query Generator > Saved Queries – Group No. 1-15

▪

There are 15 predefined query
authorization groups

▪

You can add your own authorization
groups using Query Manager

▪

Since authorization is granted at the
category level, the user bob can run
any query that is saved in a category
that is associated with one of the
selected authorization groups
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A user is granted authorization to a query authorization group in the General
Authorizations window. You can find this authorization under Reports > Query
Generator. You can see 15 query authorizations - Saved Queries – Group No
1 -15. These are provided for you out-of-box. You can create additional query
authorization groups in the Query Manager.
In the slide example, the user bob is granted permission to query authorization
groups 1 and 2 at read only. The same user is also granted full authorization to
the group called “User queries for Alerts”, which is a new authorization group
that has been added to the list.
Since authorization is granted at the category level, the user bob can run any
query that is saved in a category that is associated with one of these selected
authorization groups.
If you want you secure access to saved user queries you need to carefully
plan query categories and query authorization groups.
Be aware that query authorization groups are not the same as the
authorization user groups used to assign general authorizations to multiple
users. To learn more about general authorizations, see the related course
General Authorizations and User Groups. You can also assign the
authorization simultaneously to multiple users from a User Group.
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Other Query Authorizations

General authorizations are
also required to:
▪

Create new queries (Query
Generator)

▪

Create and edit query
categories

▪

Use the Query Wizard tool

▪

Run the Query Manager

▪

Schedule running of a
saved user query
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New users, unless they are super users, have no authorization to create new user
queries or query categories. This is designed to protect information in the database.
The required authorizations are:
•
New Queries: create new queries using the Query Generator
•
Create/Edit Categories: create and edit categories in the Query Manager
•
Query Wizard: use the query tool
•
Query Manager: use Query Manager to manage saved queries
•
Report Scheduling: schedule a saved query as a report
Note: To view dashboards and interactive views in SAP HANA, authorizations must
be set for the Analytics subject area.
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Key Points
Key points from this topic:
▪ SQL queries can be used for ad hoc reports, with user alerts and approval procedures,
and to validate migrated data in tables
▪ View  System Information can help you to identify table and field names, or item and
column numbers, for use in queries
▪ There are two tools to help you create SQL queries – the Query Wizard and the Query
Generator
▪ You can save queries as user queries and organize them by category
▪ Users need authorization to run saved user queries. First select a query authorization
group for the category, then assign a user to the category’s query authorization group in
the general authorizations window
▪ Special syntax is used for queries that run while a document is being processed in the
active window.
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▪ Here are some key points to take away from this session. Please take
a minute to review these key points:
▪ SQL queries can be used to produce ad hoc reports, as the first step to design a
more complicated report, with user alerts and approval procedures, and during
the implementation project to validate migrated data imported into tables.
▪ System information can help identify table and field names, or item and column
numbers. Use the View > System information command to enable the system
information display.
▪ Two tools exist to help you create SQL queries – the Query Wizard and the
Query Generator. Try both tools to see which you prefer.
▪ You can save queries as user queries and organize them by category. The
query Manager allows you to organize and manage saved user queries.
▪ Users need authorization to run saved user queries. First you select a query
authorization group for the category in which the query was saved, then assign
a user to the category’s query authorization group in the general authorizations
window.
▪ Special syntax is used for queries that run while a document is being processed
in the active window. This applies mainly to queries used in approval processes.
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Customization Tools:
Alerts
SAP Business One Version 9.3

PUBLIC

▪ This topic introduces the alerts feature of SAP Business One.
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Topic Objective

Objectives:
▪

Describe the business situations covered by predefined alerts

▪

Set up and run the two types of alerts in SAP Business One:
▪ Pre-defined alerts
▪ User-defined alerts
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▪ In this topic, we cover the alert mechanism provided in the SAP Business One application.
▪ You will be able to describe the business situations covered by predefined alerts, and set up and
run the two types of alerts – pre-defined alerts and user-defined alerts.
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Alerts: Business Scenario
▪

The purchasing manager wants to be notified automatically as soon as an inventory item
falls below the minimum stock quantity. On receiving the notification, the manager can
decide whether to reorder stock.

Solution: Use the predefined alert Minimum Stock Deviation.
Optional solution: Create a user alert to send the manager a report of low inventory
items and schedule the report to run daily or weekly.
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▪ Let us look at a business example for an alert. In the example shown
here, the purchasing manager wants to be notified automatically as
soon as an inventory item falls below a the minimum stock quantity. On
receiving the notification, the manager can decide whether to reorder
stock.
▪ This example is a fairly simple requirement and can easily be set up
using a predefined alert in the system.
▪ SAP Business One can also support more complex requirements with
the addition of user queries. A creative use of alerts is as a task list or
work order for a person. For example, if the purchasing manager in this
scenario does not need to know immediately about the low stock, then
you can create a user alert based on a query to provide a list of lowinventory items on a scheduled basis, such as once a day or once a
week.
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Alerts
Administration > Alerts Management

▪

Alerts notify users instantly when a specific
business event or condition occurs

▪

Alerts do not prevent the event from occurring. The
alert notifies you that the event has happened.

▪

Internal, email, text and fax mechanisms are
supported

▪

To receive an alert, user must have a user account;
however the user can receive notifications even if
not logged in
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▪

The alert mechanism in SAP Business One informs one or more users
instantly when a certain event or condition occurs.

▪

It is important to realize that alerts do not prevent the event from
occurring. The alert notifies you after the event has happened.

▪

Four types of notification mechanisms are supported: internal, email, text and fax.
Internal notifications appear in the SAP Business One client.

▪

To receive an alert, a user must have a user account in SAP Business One.
However, the user does not have to be logged into SAP Business One to receive
email, text and fax notifications.
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Setting Up Alerts
Administration > Alerts Management

Predefined Alerts

To set up alerts, a user needs the general
authorization Alerts Management
▪

Predefined with SAP Business One

▪

Only need to activate and configure
the alert

▪

Instant notification to recipient

User-defined Alerts
▪

Write your own using a query

▪

The alert will trigger when the query
runs and if there are any results from
the query

▪

Query can be scheduled
310
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To set up alerts, you need the general authorization to Alerts
Management.
There are two ways to set up an alert:
▪ You can use one of the predefined alerts supplied with SAP Business
One. In this case you simply need to configure and activate the alert
The alert will provide instant notification to users when an event
occurs.
▪ Or, you can create your own alert based on a query. In this case the
alert will trigger when the query runs and will provide the results of a
query to the users. The query can be scheduled to run at a specific
time and frequency.
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Alert Service
▪

Alert service is managed in Job Service area of
the System Landscape Directory (SLD)
https://<server>:<port>/ControlCenter/

▪

Alert Settings are accessed from link in the Job
Service. In the Alert Settings, the alert service is
selectable by database

▪

Alert service must be RUNNING at all times for
alerts to work

▪

The AlertSvc user is a predefined technical user
and is used to connect to the company database
to execute alerts

Note: In a SAP HANA environment the alert
service is dependent on the Service Layer.
Service Layer must be installed in same
landscape and bound with the database server
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▪ The alert mechanism runs as a service and is managed in the Job
Service area of the System Landscape Directory (SLD). The SLD is
installed with the server components during the SAP Business One
installation. To access the System Landscape Directory, use the path
shown in the slide, then login to the SLD using the site user credentials
and select the link for Job Service.
▪ The settings for alerts are accessed from the link provided in the Job
Service.
▪ In the Alert Settings, the alert service is selectable by company database
▪ The alert service must be running at all times in order for alerts to work
▪ The AlertSvc user is a predefined user in SAP Business One and is
automatically defined in the alert settings and functions as a technical user for
connecting to the company database in order to execute alerts.

▪ Note: in a SAP HANA environment, the alert service additionally
requires the Service Layer to be installed in the landscape and bound
with the database server. For more details about the alert server and
service layer requirement, see the SAP Business One
Administrator’s Guide, version for SAP HANA.
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Predefined Alerts

312

Predefined Alerts
Administration > Alerts Management
▪

A fixed number of
predefined alerts cover
common business
situations

▪

To see the list of
predefined alerts, choose
Administration > Alerts
Management, then type *
in the Name field, and
choose Find
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▪

A fixed number of predefined alerts are provided for you. These cover
common business situations where alerts are typically used.

▪

To see the list of predefined alerts, open the Alerts Management
window, then type * in the Name field, and choose Find. You will see
the list of alerts, and whether any of them are active.
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Predefined Alerts

▪

Predefined alerts for sales documents:
▪

Deviation from % of Gross Profit

▪

Deviation from Commitment Limit

▪

Deviation from Credit Limit

▪

Deviation from Discount (in %)

▪

Deviation from Budget

▪

Minimum Stock Deviation

▪

MRP Recommendation Due
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▪

The deviation from gross profit, deviation from commitment and credit
limits, and discount alerts can be applied to sales documents.

▪

The gross profit deviation is checked at the document level. The
commitment and credit limit are checked against the document total.
The discount limit is also checked against the document total.
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Predefined Alerts

▪

Predefined alerts for purchasing documents,
payments and journal entries:
▪

Deviation from % of Gross Profit

▪

Deviation from Commitment Limit

▪

Deviation from Credit Limit

▪

Deviation from Discount (in %)

▪

Deviation from Budget

▪

Minimum Stock Deviation

▪

MRP Recommendation Due
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▪

The predefined alert for budget deviation can be applied to purchasing
documents, payments, and journal entries. This alert is independent of
the budget warning set in the General Settings.
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Predefined Alerts

▪

Predefined alerts for inventory:
▪

Deviation from % of Gross Profit

▪

Deviation from Commitment Limit

▪

Deviation from Credit Limit

▪

Deviation from Discount (in %)

▪

Deviation from Budget

▪

Minimum Stock Deviation

▪

MRP Recommendation Due

316
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▪

The minimum stock deviation alert applies when a release document is
added that takes the stock level below the minimum defined in the item
master data. This alert is not issued if inventory blocking is enabled in
the Document Settings.

▪

The MRP alert provides a reminder if you have not released MRP
recommendations into documents in time to fulfill the inventory
demands. The alert is issued if the current system date is the
recommendation release date.
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Configuring a Predefined Alert
▪

Choose alert from list

▪

Set priority (default is normal)

▪

Select each recipient and one
or more notification methods
internal, email, text and fax)

▪

Activate the alert

Instead of
selecting
individual users
you have the
option to select
a predefined
user group

317
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▪ To use a predefined alert, double-click to select the alert from the predefined list.
▪ You can optionally assign a priority to an alert (default is normal priority). When the
message is received in the recipient’s messages/alerts window or Microsoft
Outlook window, high priority messages are flagged in red.
▪ Then select each recipient and one or more preferred notification methods. You
can choose an internal message, email, text, and fax. Instead of selecting each
user individually you can switch to the Groups tab, and select a predefined user
group (group type must be Alerts or Cross All Types). For more information on user
groups, see the Users and User Defaults course.
▪ In addition, select the notification checkbox for the predefined user called AlertSvc.
This will ensure the alert is sent to a recipient even if the recipient is not logged
into the SAP Business One client.
▪ The email and fax mechanisms require the integration of these services with SAP
Business One. The SMS mechanism requires the SAP Business One integration
framework with the mobile scenario activated. The email addresses and phone
numbers must be set up in the user account.
▪ Finally, you must activate the alert for it to take effect, using the checkbox. You
can also use this checkbox to deactivate an alert at any time.
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Predefined Alert Conditions
▪

You can set conditions for the
alert (exception is the minimum
stock deviation alert)

▪

The condition varies according to
the alert

▪

You can also select which
documents are covered by the
alert

318
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▪

For the predefined alerts, with the exception of minimum stock
deviation, you can select conditions for the alert situation.

▪

The conditions are different for each predefined alert. For example, the
condition for the gross profit deviation is the profit percentage, and the
condition for the budget deviation is the amount.

▪

For the predefined alerts, with the exception of minimum stock
deviation, you can also select the documents for the alert situation.

▪

The available documents depend on the chosen alert. The alert will
trigger immediately after the document is added to the system.
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Alert Notifications
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▪

Internal alerts appear in the
Messages/Alerts Overview popup
window

▪

This window can also be opened
from the cockpit widget

▪

Select the alert to access the
document details

▪

Options to Forward, Reply or Delete
the alert

▪

Option to set out-of-office and
forward alert to email, SMS or fax
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▪ Internal alerts appear in the Messages/Alerts popup window in the SAP Business One client, and
you can also access this window from the cockpit widget.
▪ Select the alert row to access the document details.
▪ The recipient of the alert has options to:
▪ Forward the alert to another user
▪ Send a reply to the user who caused the alert
▪ Delete the alert row from the popup window
▪ Set an out-of-office and optionally forward the alert to your email, SMS or fax
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User Settings for Alerts

In General Settings and User – Setup:
▪

Send Alert for Activities Scheduled for Today

▪

Display Inbox When New Message Arrives

▪

Update Messages (interval)
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In the setup for a user, there are settings that affect alerts.
• Send Alert for Activities Scheduled for Today. If set, when the user
logs on they will receive an alert listing all activities scheduled for
today. This is not a predefined alert, but if checked the activities will
appear in the Messages/Alerts window, and the user can process
activities directly from the alert message.
• Display Inbox When New Message Arrives. This is set by default for a
new user and automatically opens the Messages/Alerts window
whenever a new alert is generated for the user.
• Update Messages (Min.). This defines in minutes how often the
system checks for updates to the alert inbox. The default value for a
new user is 5 minutes. If you set this value to 0 the user will receive
the alert notification immediately.
If not defined in the user setup screen, the settings are taken from the
General Settings: Service tab.
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User-Defined Alerts

If the predefined alerts do not meet business requirements, you can add user alerts.
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Use Cases for User-Defined Alerts
User alerts are based on a saved user query and the query can check for multiple
or unique business conditions
The alert can provide worklists to a user on a daily, weekly or monthly basis, for
example:
▪

Purchase orders over a specific limit issued for the day or week

▪

Overdue sales quotations

Another use is to check the consistency and quality of master data or documents,
for example:
▪

Missing fields in new business partner master data, such as tax id, credit limit,
contact person, or sales employee

▪

Sales orders with missing or incorrect tax codes
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User alerts are based on a saved user query and the query can check for
multiple or unique business conditions.

As such, they can provide worklists to a user on a daily, weekly or
monthly basis, for example:
▪

Purchase orders over a specific limit issues for the day or week

▪

Overdue sales quotations

Another use for alerts based on queries is to check the consistency and
quality of new master data or documents, for example:
▪

Missing fields in new business partner master data, such as tax id,
credit limit, contact person, or sales employee

▪

Sales orders with missing or incorrect tax codes

Before you create a user alert, check to see if there is a system report
that produces similar results, as you can copy the query as the basis for
your alert query. Choose Tools > Queries > System Queries.
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User-defined Alerts
To add a user alert:
▪

Use the provided query tools to
create and save the query

▪

In Alerts Management window,
switch to Add mode

▪

Provide a name for the alert

▪

Open the saved user query

▪

Select recipients, notification
mechanisms and priority, in the
same way as for a predefined
alert

▪

Set the frequency for running the
query: minutes, hours, days,
weeks or months
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▪ You can use the provided query tools Query Wizard and Query
Generator to create and save the query. Using the query you can
check multiple conditions or unique conditions specific to a business.
For example, you can send the budget manager a daily list of purchase
invoices created today.
▪ To create a new alert, switch to Add mode in the Alerts Management
window (choose Ctrl + A).
▪ Provide a name for the new alert. Then select the saved user query.
See the Queries topic for information on creating and saving queries.
▪ In the Alerts Management window, select the recipients and the
notification mechanisms, as well as the notification priority, in the same
way as for predefined alerts.
▪ You need to set the frequency for running the query (in minutes, hours,
days, weeks or months). Unlike a predefined alert, a user-defined alert
is not triggered when a document is added to the system. A userdefined alert is triggered when the query runs and if there are results
from the query. If there are no results from the query, a notification is
not sent.
▪

If the frequency is days, weeks, or months you can additionally set a
time of day.
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Accessing the Query Results

▪

User alerts pop up in the
Messages/Alerts Overview window

▪

To see the query results, double-click
the alert row

▪

You can also copy the results to
Microsoft Excel by choosing Copy
Table from the context menu
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User alerts display in the user’s Messages / Alerts Overview window. The
query results will show directly in this window, or you can double-click the
alert row to see the results in a new window.
You can copy the results to Microsoft Excel if desired, by selecting Copy
Table from the window’s context menu.
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User-defined Alerts – Save History Checkbox
The Save History checkbox
controls the display of alerts in the
Messages/Alerts Overview
window
▪

If checked, a new alert is added
on a separate row each time
query triggers alert

▪

If not checked, new alert
overwrites previous alert on
same row and shows in bold
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▪

For user alerts, there is a Save History checkbox in the setup window. This
checkbox controls how user alerts are displayed to the user in the Messages/Alerts
window.

▪

If you select the Save History checkbox, a new alert message is added on a
separate row each time the query runs and triggers an alert. This can quickly fill up
the alerts window if the frequency of the alert is set to minutes. This is shown in
the sample screenshot.

▪

If you do not check Save History checkbox, each new alert will overwrite the
previous alert on the same row in the Messages / Alerts Overview window, so you
will only see one row for the alert. The alert will change to bold to inform the user
that a new alert has occurred.
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Writing Queries for User-defined Alerts
▪
▪

When you develop queries for alerts, you may need to match the query to the frequency you
select
Example: For a report of new orders that runs daily, the query should only select documents
added on that day

Query

Frequency

Results

SELECT T0."DocNum", T0."CardCode",
T0."CardName"

Once a day at 23:30
hours

List of Purchase Orders >
5000 posted on the
current day

FROM OPOR T0
WHERE T0."DocTotal" > 5000 and (T0."DocDate" =
CURRENT_DATE)
Query shows HANA SQL syntax
326
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▪ When you develop queries for alerts, you may need to consider
matching the query to the frequency you select for running the query.
▪ For example, if you want a report of new orders added for today, the
query should only select documents added on the current day.
Otherwise the report will include all documents in the database that
meet the query criteria.
▪ In such a case, the document posting date is compared to the current
date.
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Troubleshooting User Alerts
▪

Check the query to
make sure it produces
results

▪

Make sure the alert
service is running in the
System Landscape
Directory

▪

Make sure the Service
Layer is active for SAP
HANA

▪

Run a query on table
OALT to see the overall
configuration of active
alerts
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If the alert does not trigger:
• Run the query independently to make sure it produces results
• Make sure the SAP Business One alert service is running in the
System Landscape Directory and the correct database is selected in
the alert settings
• For SAP HANA environments, make sure the Service Layer is active
on the SAP HANA server. To check the Service Layer, use the url
https://<server>:50000. If the service layer is installed you will see a
link to documentation.
• Run a query on the OALT table to see all the configured alerts on
your system, including predefined alerts.
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Key Points
Key points from this topic:
▪ There are two ways to use alerts: configure one of the predefined alerts or define a user alert based
on a query

▪ All predefined alerts (with the exception of Minimum Stock Deviation) are triggered after an applicable
document is added, so do not prevent documents being added to the system. In contrast, an approval
process will prevent a document being added until it is approved.
▪ Alerts can be sent internally, by e-mail, text and fax.
▪ The alert job service must run all the time so that alerts can be triggered. For SAP HANA, there is a
dependency on the Service Layer being installed and bound to the database server.
▪ User-defined alerts are based on saved user queries. User alerts provide a way to create routine task
lists for users, or to check the consistency of data.
▪ User-defined alerts are triggered when the base query is run. You must set the frequency for running
the query. An alert triggers only if the query produces results. The query results appear in the alert
window.
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▪ Please take a minute to review these key points:
▪ There are two ways to use alerts: configure one of the predefined alerts or
define a user alert based on a query.
▪ All predefined alerts (with the exception of the Minimum Stock Deviation alert)
have conditions and are triggered when an applicable document is added to the
system. So alerts do not prevent documents being added to the system. In
contrast, an approval process will prevent a document being added until it is
approved.
▪ Alerts can be sent internally to a user in SAP Business One, or can be sent by
e-mail, text and/or fax.
▪ The alert job service must run all the time so that alerts can be triggered. For
SAP HANA, there is a dependency on the Service Layer being installed and
bound to the database server.
▪ User-defined alerts are based on saved user queries. User alerts provide a way
to create routine task lists for users, or to check the consistency of data.
▪ User-defined alerts are triggered when the base query is run, so you must set
the frequency. An alert triggers only if the query runs produces results. The
query results appear with the alert in the Alerts/Messages window.
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Customization Tools:
Approval Processes
SAP Business One Version 9.3

PUBLIC

▪ This topic covers the setup and use of approval procedures.
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Objectives

Objective:
▪

Describe the business process flow when an
approval process is used

▪

Set up an approval process in SAP Business One

▪

Explain the status of a document during an approval
process and how updates to documents pending
approval are managed

▪

Discuss the special requirements for writing a query
for an approval procedure
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▪ After completing this topic, you will be able to:
▪ Describe the business process flow when an approval process is used
▪ Set up a new approval process in SAP Business One
▪ Explain the status of a document during an approval process and how updates to documents
pending approval are managed
▪ Discuss the special requirements for writing a query for an approval procedure.
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Business Scenario

▪

In order to control costs, the company now requires all internal purchases
and expenses over a certain limit to be approved by a manager before they
can be processed.

▪ Solution: Define an approval procedure. If the value of the document
exceeds the limit, the approval procedure will automatically block the
document until it is approved or changed.

Purchase
Order

Goods
Receipt PO

A\P Invoice

Outgoing
Payment
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▪ An approval process can be set up for sales, purchasing and inventory documents. In the business
scenario shown here, there is a requirement to approve internal purchases and expenses over a
certain limit. The purchase requests or purchase orders for these expenses should be approved by
the a manager before they can be added.
▪ Approval processes can be established for a wide range of documents in SAP Business One. You
can use an approval procedure whenever the work procedure requires an approval before a user
can generate certain documents, for example, purchase requests or purchase orders.
▪ If the value of the document exceeds the limit, the approval procedure will block the document until
it is approved.
▪ Approval procedures can also be used in the sales process, in outgoing payment processing, in
inventory receipt and transfers, and in stock counting.
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Basic Approval Workflow
Originator
Approval
needed?

Yes

Approval Process

Add

No

No

Approved?
Yes

Access and
Modify Draft

Yes

Approval
needed?

New
Approval
Process

No

[Approved]
© 2018 SAP SE or an SAP affiliate company. All rights reserved. ǀ PUBLIC

•
•
•

•

332

In the approval process, a user who is subject to an approval procedure is known as the originator.
When the originator adds a document that meets predefined approval conditions, the originator is
notified and the document is saved as a draft. The document has the status Draft [Pending].
The originator will not see this draft document when browsing through records, but can access it
from the Document Drafts report.
The draft document must be approved before it can be generated as a document. An internal
request is sent to the pre-defined approvers. This request appears in the Messages/Alerts Overview
popup window and the approver can drill-down to view the draft document. If the mobile application
is integrated, approvals can be done from a mobile phone.
• If the approver rejects the document, an internal message goes back to the originator with a link
to the rejected document. The originator can modify the document, and if the approval condition
is no longer met, the document can be added to the system as a normal document. If the
approval condition is still met, another approval procedure will start.
• If the document is approved at the first approval stage, an approval request is sent to the next
approval stage (if applicable). If the document is approved at the final approval stage, an internal
message goes back to the originator with a link to the draft document. The originator can now
add the document.
After a document has been approved, it has the status Approved in the title.
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Setting Up an Approval Process

▪ In this section you will see how to set up an approval process.
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Activation
General Settings
▪

Approval process functionality is enabled in the General Settings

▪

Once enabled, you cannot disable the functionality if there are active approval templates

▪

Checkbox to enable approval process for DI API

▪

Additional checkboxes permit updating generated documents and/or documents still awaiting approval
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You first need to first activate approval process functionality in the system. In the General Settings,
choose the BP tab and select the Enable Approval Process checkbox.
Note that this is a system-wide setting - once you have created and activated any approval templates,
you cannot disable the approval functionality from here but you can deactivate the individual approval
templates.
In this window you can also optionally enable approval process functionality for the DI API. This is of
most interest to providers of add-ons. The DI API provides methods to trigger an approval process and
save the draft document. You can also use the DI API to approve draft documents.
Two further checkboxes permit updating documents that have been generated by an approval process,
and/or documents that are still in an approval process and waiting for an approval. These will be
covered later in this course.
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Approval Templates and Stages
Approval Stages

Approval Template

First level
approvers

Originators

To set up an approval process you define
approval stages and approval templates:
▪

Approval stage is a list of named approvers
who can approve a document at the same
level

▪

Approval template combines the
originators, the documents, the criteria for
approval, and one or more approval levels

▪

The stages are separate from the approval
template and you can reuse approval
stages in other templates

▪

You can define multiple approval templates
for different sets of users and/or
documents, and with different criteria.

Approval
Stages
Second
level
approvers

Documents

Criteria
(Terms)
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To set up an approval process you define approval stages and approval templates:
▪
Approval stage is a list of named approvers who can approve a document at the same level
▪
Approval template combines the originators, the documents that require approval, the criteria for
approval, and one or more approval levels
The approval stages are separate from the approval template and you can reuse approval stages in
other templates.
The approval template allows you to model an entire approval process. You can define multiple
approval templates for different sets of users or documents, and with different criteria. Only the
document types selected in the approval template will trigger an approval process, and only when
added by an originator.

335

Approval Process Authorizations
Permission to define approval
process stages and templates is
set by General Authorizations
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To set up an approval process, you need the general authorizations as shown here under the subject
Approval Process:
•
Approval stages - to define and maintain approval stages
•
Approval Templates - to define and maintain approval templates
•
Approval Status Report - to view pending approval requests
•
Approval Decision report - to view and approve pending approval requests
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Setup – Approval Stages
Administration > System Initialization >Approval Process >
Approval Stages
▪

All approvers must first be defined as users in SAP Business One

▪

Include more than one user in a stage to allow for staff absences.
Specify a minimum number of approvals for the stage

▪

Stages can be combined in any order to create a multi-stage
approval procedure. When you combine stages, make sure the
same user is not in multiple stages

If you define more than one approver
for a stage, you can set the minimum
number of required approvals or
required rejections before the approval
process moves to the next stage
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Before you create an approval template you should define the approval stages.
All approvers must first be defined as users in SAP Business One.
It is a good practice to include more than one user in a stage to allow for staff absences and holidays.
You can specify a minimum number of approvals required from the pool of approvers.
The approval stage is saved in the system and can later be combined with other approval stages to
create a multi-stage approval procedure. When you combine stages, make sure the same user is not
defined in multiple stages.
In the slide example, we have defined two approval stages. In the first stage there are two purchasing
users who can approve a purchasing document, but we only need an approval from one of them.
Similarly in the second stage there are again two approvers but approval is required from only one of
them.
The two stages are independent but we can combine them in the correct order in the approval
template.
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Setup - Approval Templates
Administration > System Initialization >Approval Process > Approval Templates
Originators tab
▪

Specify the users who are subject to
approval when they create certain
documents

▪

Only users specified here are subject to
approval process

▪

User cannot modify approval template if
selected as an originator in the template

▪

The approval process also applies to an
originator who runs the Document
Generation Wizard
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▪ On the Originators tab, select the users who are subject to approval when they create documents.
All originators must be first defined as users in SAP Business One.
▪ Only users specified here are subject to an approval process. A user who is not specified as an
originator can add or update a document with no approval.
▪ Note that the system prevents a user from modifying an approval template if they are selected as an
originator in the template. This does not apply to super users.
▪ Note: The approval process also applies when an originator generates documents by batch using
the document generation wizard. One approval request is sent for each document that needs
approval; in other words, each document follows its own approval process.
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Setup - Approval Templates
Documents tab
▪

Select the documents that require approval
(when created by the originators)

▪

The approval will apply to every instance of
the document if it meets the approval terms:
▪

Sales and purchasing document types
can be selected in one template;
however you will need to create separate
approval templates if the terms or
approvers are different

▪

Cannot combine marketing documents
with inventory or payment document
types in same template
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▪ In the Documents tab, you select the document types that require approval when added by an
originator. The approval process will apply to every instance of the document type selected here,
when created by a user specified on the Originators tab.
▪ Both sales and purchasing document types can be selected in one template; however, if the
conditions on the terms tab or the approvers will be different you should create separate approval
templates.
▪ The system will not allow you to combine sales and purchasing document types with inventory or
payment document types in the same template. You will need to create separate templates.
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Setup - Approval Templates
Stages tab
▪

Include the predefined approval stages

▪

The sequence of the stages in the template
is the order for a multi-level approval
process

▪

You can rearrange the sequence using the
arrows
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▪ In the Stages tab, you include one or more of the predefined stages.
▪ The sequence that the stages are listed in the template becomes the order for a multi-level approval
process.
▪ You can rearrange the sequence using the up and down arrows.
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Approval Templates – Terms Tab
Approval criteria:
▪

Always (no terms)

▪

Predefined terms (vary according to selected
document types)

▪

User queries

Note: Predefined terms operate only on the header
level of a document, not on the row level. For
example: discount and total appear on each row as
well as on the document header, but the approval
template only considers the header fields
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In the Terms tab, you set the criteria for the approval:
▪ The default is Always. The selected document types will always go for approval when created by
the originator.
▪ You can choose a predefined term. The predefined terms available in the template vary
according the document types selected, but they cover common situations, such as a discount
or total that exceeds a set value. In this example, we have specified the condition that the
document total is over 500.
▪ You can choose to add your own conditions using a user query. This allows you to model more
complex approval conditions.
Note that the predefined terms for discount and total operate only on the header level of the document,
not at the row level.
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Using Predefined Terms
▪

Select an operator (greater than, less than, equal, etc.) and enter value

▪

Select range (In range, Not in range) and enter range from low to high, separate by hyphen

Predefined
Term
Total
Quantity

Ratio

Greater than
Less than
Equal
Doesthan
not equal
Greater
range
LessInthan
Not in range
Equal
. . not
. equal
Does
In range
Not in range
...

Value
500
5-200

▪

Multiple predefined terms
evaluated using “or” logic

▪

Approval process will
apply if just one of the
predefined terms is met.
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▪ When using a predefined term, you can select an operator such as “greater than” or “equal”, and
enter a value for comparison.
▪ You can also select “In range” or “Not in range” as the ratio, and enter two values for the range,
from low to high, separated by a hyphen.
▪ You can select more than one predefined term. In this case an approval process will be triggered if
just one of the predefined terms is met. In the example shown here, that means if the total amount
of the document is greater than 500, or the quantity is between 5 and 200.
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Activating an Approval Template
▪ The Active checkbox is set by default:
 Deselect if you want to set up the template
now and activate later
 You can also deselect to deactivate an
existing approval process (make sure all
documents are approved)
▪ The Active when Updating Documents Not
Generated by Approval Process checkbox is also set
by default:
- It covers the condition whereby an originator
updates a document that did not originally go
through an approval process
- If the checkbox is selected, an approval process
will be triggered if the update causes the
document to now meet approval criteria
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The Active checkbox in the approval template is set by default. You can deselect this checkbox if you
want to set up the approval process now and activate it at a later time. You can deactivate an approval
process at any time by deselecting the checkbox, although you should make sure there are no current
documents pending approval.
The Active when Updating Documents Not Generated by Approval Process checkbox is also checked
by default. This covers the condition whereby an originator updates a document that was not originally
generated upon approval. This could be because it was created by another user not specified as an
originator, or because it did not meet the approval criteria when the originator first added it.
If you set this checkbox an approval process will be triggered if the update causes the document to
meet the approval criteria. For example: the originator creates and saves a sales quotation normally,
with no discount. Later the originator updates the sales quotation to add discount and this requires an
approval.
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Managing the Approval Process

▪ This section covers the flow and status of a document during an approval process.
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Document Status During Approval Process

Status[Draft Pending]

Status [Approved]

Request for
Approving Document
Generation

Status [Draft Approved]

Originator adds
draft document to
system

Document
Generation
Approved
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▪ The originator receives a popup window when they add a document that triggers an approval
process. In this window the originator can optionally enter remarks for the approvers.
▪ The document is saved with status [Draft Pending] and a request for approval is sent to each of the
approvers.
▪ The approvers are notified in the Messages/Alerts Overview popup window. From this window they
can open the approval request, drill-down to view the draft document, and either approve or reject
the document.
▪ If the document is approved the status becomes [Draft Approved] until the originator adds the
document, when the status becomes [Approved].
▪ If the document is rejected the status is [Draft Rejected]. The originator can access and update the
draft.
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Monitoring an Approval Process
Approver view

Originator view
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▪
▪

346

During an approval process, the originator can monitor their approval requests using the Approval
Status Report.
Approvers can use the Approval Decision Report to see all documents that require their approval.
From this report they can approve or reject multiple documents.

.
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Canceling an Approval Process
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If, for example, a document error is noticed after the document was sent for approval, the approval
process can be cancelled.
The Approval Status Report permits an originator (or an approver) to request a cancelation of a current
approval process. Select the row for the document and right-click then choose Cancel from the context
menu. You can also cancel the approval process by choosing the Data > Cancel menu.
After this, the document cannot be added to the system and cannot be updated.
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Summary of Document Statuses
Document Status

Comment

Draft [Pending]

▪

Document is in approval process

Draft [Approved]

▪

Document was approved but has not yet been saved by
originator

Draft [Rejected]

▪

Document was rejected by approvers. It can be updated
by the originator. If it still meets approval criteria another
approval process will be launched.

Draft [Canceled]

▪

Document in approval process was canceled by originator
or approver. The draft cannot be added or updated.

[Approved]

▪

Document was approved and saved by originator. It
cannot be updated by originator unless checkbox set in
General Settings

Draft for Document Update [Pending]

▪

Originator updates a document that was not previously
approved, and now meets criteria for an approval process

Draft for Document Update [Approved]

▪

Draft for Document Update was approved and can be
added.
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This slide shows a summary of the document statuses that can be set during an approval process.
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Document Numbering and Draft Keys
▪

▪

A draft document number
is assigned to a document
when it is saved as a draft,
pending approval

Draft number 731

Since the originator can
continue to work on other
documents, the actual
document number can
change when the
document is finally added
to the system after
approval

Actual number 733

© 2018 SAP SE or an SAP affiliate company. All rights reserved. ǀ PUBLIC

349

When a draft document is saved pending approval, it is assigned a document number. This is simply a
draft document number and the actual document number is assigned only when the draft is approved
and saved by the originator.
Since there can be a time lag before the document is approved, and the originator can work on other
documents, the actual document number will often differ from the draft document number. For
example, a sales order is assigned draft key 731 and sent for approval. The originator then creates
sales orders 731 and 732 which do not require approval. When the first sales order is approved and
the originator saves it, it will be assigned the next available number in series, for example, 733.
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Document Updates During Approval Process
▪

A document in the approval
process can be accessed from the
Document Drafts Report

▪

Safeguards are in place to prevent an originator from
updating a document with [Draft Pending], [Draft Approved]
or [Approved] status

▪

Checkboxes in the General Settings control updates to
documents with these statuses:
▪

Updating an [Approved] document is only possible if the
checkbox Enable Updating the Document Generated/Updated by
Approval Process checkbox is set

▪

Updating a [Draft Pending] or [Draft Approved] document is only
possible if the checkbox Enable Updating the Document Draft in
Pending/Approved Status checkbox is set

General Settings
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•

A document that is pending approval has the status Draft [Pending]. An originator can make
changes to this draft document, even when it is pending approval, if the checkbox ‘Enable
Updating the Document Draft in Pending/Approved Status’ is set in the General Settings. If the
updated document still meets the approval criteria a new approval process will be started and the
current approval process will be cancelled. If the updated document no longer meets the approval
criteria (for example changing the discount % from 15 – 13%) the document can be added as a
normal document, without the status [Approved].
•
A document that has been approved by an approval process has the status Draft [Approved].
When the originator adds this document to the system, the status will change to [Approved]. An
originator can update this approved document if the checkbox ‘Enable Updating the Document
Generated/Updated by Approval Process’ is set in the General Settings. If the updated document
still meets the approval criteria a new approval process will be started.
Note: If the checkboxes are NOT set, the originator can change certain fields in the draft document,
including: Document remarks, Journal entry remarks, Opening and Closing remarks (in right-click
menu), attachments and UI elements.
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Multiple Approvers in a Stage

Example: minimum number of approvers
is 1

Time
Jane
John

Approve ✓
Reject 

Result: Since only one approval is required for the
stage, the rejection is ignored and the document is
approved and can be added to the system
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▪
▪
▪
▪

When you specify multiple approvers at the same stage, they have equal authorization level.
You need to consider the effect of multiple approvers at the same stage.
In this example, the minimum required number of approvers is 1.
One of the approvers approves the document. Later on, another approver rejects the same
document.
▪ But this rejection has no effect if it happens after the first approval. Since only one approval is
required, the document is approved and can be added to the system.
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Multiple Approvers in a Stage (Cont.)

Time

Example: minimum number of approvers
is 1

Jane

John

Reject 

Approve ✓

Result: document held pending until another
approver responds
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▪ In the second scenario, one of the approvers rejects the document. The document is held as
pending until the other approvers respond.
▪ If all the approvers reject the document, the originator is alerted that the document has been
rejected.
▪ But if another approver approves the document, and the minimum number of required approvers is
reached, then the document is approved and the originator can add the document to the system.
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Print Preferences
▪

Print preferences can be set on a per document
basis for a document that is in the approval
process

▪

Can prevent document being exported, printed
or faxed

353
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▪ When a document is in an approval process, you can prevent it from being exported, printed,
emailed or faxed. These preferences are set on a per document basis in the Print Preferences
window (Per Document tab).
▪ The user will get an error message when they attempt to perform a function if the checkbox is set.
▪ Note that the checkboxes are not checked by default.
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Using Queries in Approval Processes

▪ You can define your own approval criteria using saved user queries.
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Using Queries as Terms

Terms Tab:
▪ Saved user queries can be added to approval
templates
▪ Queries can be used instead of, or together
with predefined terms
▪ Allows you to develop customized approval
scenarios
Example:
We want an approval process for item type purchase
orders over 500 AND service type purchase orders over
250.

355

© 2018 SAP SE or an SAP affiliate company. All rights reserved. ǀ PUBLIC

▪ You can add saved user queries to the terms for an approval process. The queries are added at the
bottom of the approval templates form and can be used instead of the predefined terms, or together
with predefined terms. This allows you to develop customized approval scenarios with much more
granular conditions.
▪ For example, if we want an approval process to apply to item type purchase orders over 500 and to
service type purchase orders over 250, we can write a query to check for both conditions. The
predefined terms do not apply at this level of granularity as they do not distinguish between the type
of document.
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Combining Predefined Terms and Queries

Terms Tab
▪ When predefined terms are combined with a
query, the approval process will start if just
one of the conditions is met – evaluated using
OR logic

In the example, an approval process will start if
▪

Document puts budget over 500

Or
▪

If document meets the conditions of the query
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▪ When predefined terms are combined with a query in an approval template, the approval process
will start if just one of the conditions is met. In other words, the conditions are evaluated using OR
logic.
▪ For example, if we combine the predefined term “Deviation from Budget” with the query previously
mentioned for item and service type purchase orders, then the approval process will trigger if the
document puts the budget over 500 or if one of the query conditions is met.
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Query Syntax for Approval Procedures
A query used in an approval process has special requirements:
▪

It references the current document in active window

▪

To refer to a field in the active window, you must include a $ sign
in front of the field with square brackets

▪

Query must use SELECT DISTINCT ‘True’

▪

Query cannot reference row level fields

Active Window

SELECT distinct 'true' from OPOR T0 where
Example: Approval for purchase
orders with:
▪

Service type AND total > 250 OR

▪

Item type AND total > 500

($[OPOR."DocType"] = 'S' and CAST($[OPOR."DocTotal"] as
DECIMAL) > 250)
OR
($[OPOR."DocType"] = 'I' and CAST($[OPOR."DocTotal"] as
DECIMAL) > 500)
357
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▪ When you write a query to be used in an approval process, the query must reference the current
document in the active window. The active window is the one the originator is working in as the
document has not yet been saved to the database.
▪ To refer to a field in the active window, you must include a $ sign in front of the field and surround
the field with square brackets.
▪ The query can also refer to fields from records in the database, for example, to select a field from
the current document’s business partner master data. In this case the $ sign is not needed for these
fields as they are picked up from the database.
▪ The query must also use the SELECT DISTINCT ‘TRUE’ clause, so that the result is a TRUE
statement if there are results from the query. A TRUE statement will trigger an approval process; a
FALSE statement will not.
▪ The query can only reference fields in the document header, not at the row level. Row level fields
require a stored procedure in the database.
▪ In the query shown here there are two conditions, and a $ sign is used with the DocType and
DocTotal fields in the active purchase order document. The sample query is shown for SAP HANA
syntax.
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Queries for Multiple Document Types
If multiple document types are selected in the
approval template, the query must be able to
work with the multiple similar document types
Use the item number and column syntax
instead of the table and field name syntax:
$[$Item.Column.0]
$[$Item.Column.Number]
$[$Item.Column.Currency]
$[$Item.Column.Date]
In this syntax a second $ sign is added before
the item number. The column number is
always 0 since the query can only reference
header fields
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If you use a query in an approval template with multiple document types selected, then the query must
be able to work with the multiple document types (for example, all sales and purchase documents).
▪ If you use the table and field name syntax, the query includes the table name so can only be used
with a single document type.
▪ If you use the item number and column syntax, the query does not include the table name and can
be used with multiple document types of a similar structure, for example, all sales and purchasing
documents.
▪ To use the item number syntax, add a second $ sign in front of the item number, within the
brackets, to indicate that the item syntax is used. The column number is always 0 in approval
procedure queries, since the query can only refer to fields in the header of a document.
▪ When using the item number and column syntax, the field is fetched as a string so if you need the
result in a different format you need to specify the format after the column number. The formats are:
▪ 0 - which is the default string format
▪ Number – which returns the result as a numeric that you can use in calculation or comparison
operators.
▪ Currency – which returns the currency symbol from a field that holds both the amount and the
currency symbol, such as the DocTotal.
▪ Date – which should only be used if the field is a date field. The date is returned in a format for
use in calculation or comparison operators.
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Active Window Query Examples

Item and
Column
Number

View > System information

Table and
Field Name

Ctrl +Shift+I

[... Item= ## Column= ## …. Table Name, Field Name]

Table and field syntax
$[Table Name. Field Name]

SELECT distinct ‘true’ FROM OPOR T0
WHERE
$[OPOR."DocType"] = ‘S’ and
CAST($[OPOR."DocTotal"] as DECIMAL) >
250
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Row=1

Status Bar

Item number and column syntax
$[$ Item Number. Column Number.0]

SELECT distinct ‘true’ FROM DUMMY
WHERE
$[$3.0.0] = ‘S’ and
$[$29.0.number] > 250

.Number]
.Currency]
.Date]
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▪ When you reference a field in the active window, you can use either the table and field name or the
item and column number syntax. To see the item and column number, and the table and field name,
for a field in a document or form, use System Information.
▪ In the example on the left, the query can only be run on a purchase order in the active window since
the purchase order table name OPOR is included in the query.
▪ The query on the right can be used in an approval template where multiple marketing documents
are selected. The query works because the document type field is always item number 3 and the
document total is always item number 29 in all marketing documents. The column number is always
0 for header fields. In the slide example, the result is compared to 250. Since the DocTotal field in
the active window includes the currency symbol, specifying .number after the column number will
extract just the amount for the comparison operation.
▪ For more information on System Information and the query syntax, see the Queries topic in this
unit.

Testing a Query for Approval Procedures
Active window

Tools > Queries > User Queries > Category Name >
Query

To test query, keep document
in the active window and run
the query from the Tools menu

360
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▪ It is a good practice to test a new query before you include it in the approval template.
▪ To test a query that refers to the active window, create a document that meets the approval
conditions. Keep this document in the active window and run the query from the Tools menu. The
query should return a true result.
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Key Points
Key points from this topic:
▪

Approval processes can be established for sales, purchasing, inventory and payment documents.

▪

To set up an approval process, enable the functionality, then define approval stages and approval
templates. All originators and approvers must be SAP Business One users.

▪

To create a multi-level approval procedure, combine multiple predefined stages in the approval
template.

▪

In the approval template, you can select one or more predefined conditions, and/or select a saved user
query.

▪

Safeguards are in place to prevent documents from being updated after approval or while pending
approval. Checkboxes are available to permit these actions. You can also trigger approval processing
when an originator updates a document that was added without need for approval.

▪

An approval process can be cancelled by the originator or approver.

▪

Queries used in approval procedures reference the current document in the active window and must
select a true response. To use the same query with multiple document types of the same structure, use
the index and column syntax.
361
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▪ Please take a minute to review these key points:
▪ Approval processes can be established for various sales, purchasing, inventory and payment
documents
▪ To set up an approval process, first enable the functionality in the General Settings, then define
approval stages and approval templates. All originators and approvers must be SAP Business
One users
▪ To create a multi-level approval procedure, combine multiple predefined stages in the approval
template.
▪ In the approval template you can set conditions for an approval process:
▪ If you choose “always”, an approval will be launched for every document type selected in the
template.
▪ You can select a predefined condition, and/or add your own user query containing the
conditions.
▪ Safeguards are in place to prevent documents from being updated after approval or while
pending approval. There are checkboxes in the General Settings to permit these updates. In the
approval template there is a checkbox to trigger an approval process when an originator updates
a document that did not go through an approval process originally
▪ An approval process can be cancelled by an originator or approver
▪ When you write a query for an approval template, you reference the current document in the
active window (it has not yet been saved to the database) and the query must select a true
response. To reference fields in the active window, include a $ sign in front of the square
brackets. If the query needs to work with multiple document types with the same structure, use
the item and column number syntax and include an additional $ sign within the square brackets.
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Customization Tools:
User-Defined Fields
SAP Business One Version 9.3

PUBLIC

▪

Welcome to the topic on User-Defined Fields.
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Objectives

Objectives:
▪

Add user fields to objects in the SAP Business One
database

▪

Define fields with different types and structure, including
mandatory fields

▪

Set validation rules, default values, and lists of values
for data entry
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▪ On completion of this topic, you will be able to add your own fields to objects in the SAP Business
One database. You will be able to defined fields with different types and structure, including
mandatory fields, and set validation rules, default values, and lists of values to assist users in data
entry.
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Business Scenario

▪ There is a need to track a status level for each customer – gold, silver, and
bronze.
▪ The salesperson needs to record the customer’s preferred delivery
instructions when processing a sales order.

Solution: These requirements can be implemented with user-defined fields.

Sales Order

Delivery

A\R Invoice
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Incoming
Payment
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▪ Additional fields are often added to master data and documents to implement a customer’s business
process. Here are two business requirements that can be implemented with user-defined fields.
▪ There is a need to track a status level for each customer – gold, silver, and bronze. You can add
a user-defined field to the customer master data to hold and track the status value.
▪ Additionally, the salesperson needs to record the customer’s preferred delivery instructions
when processing a sales order. You can add a user-defined field to the sales order document,
and record the delivery instructions in this field.
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Adding User-Defined Fields

▪ In the first part of this topic, we cover how to add user-defined fields.

365

User-Defined Fields
Tools → Customization Tools → User-Defined Fields – Management
▪

New fields can be added to
most business objects,
including master data and
marketing documents

▪

General authorization
required: Customization
Tools > User-Defined Fields
– Management
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▪ You can add new fields to most business objects, including business partner and item master data,
and marketing documents. These fields are stored in the database and table of the business object.
▪ Only authorized users can add user-defined fields. The general authorization is Customization Tools
> User-Defined Fields – Management.

366

Marketing Document Row and Header Fields

▪

Fields can be added to both header
(title) and rows of marketing
documents

▪

New field is added to all logistics
document types

Header (Title)

Row
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▪ You can add fields to both the header area and to the rows of marketing documents.
▪ When you add a user-defined field to the marketing documents object, the new field is added to all
logistics document types, including all sales and purchasing document types, and some inventory
documents such as Goods Receipt and Goods Issue.
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User-Defined Fields – Header Level
▪

UDFs added at the header
level initially appear in a
separate window

▪

To open this window, use the
View menu and select UserDefined Fields, or press
Ctrl+Shift+U

Object (e.g., Sales Order)

View
✓ User-Defined Fields
Ctrl+Shift+U
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▪ When you add user-defined fields (UDFs) at the header level, the new fields appear in a separate
window positioned by default to the right of the existing document window.
▪ This window is not visible immediately. To open this window, choose View > User-Defined Fields
from the top menu bar, or use the key sequence Ctrl+Shift+U. You can reposition this window to
the left or bottom of the existing window.
▪ If the user-defined fields are not used in a marketing document, the new window can remain closed.
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Moving User-Defined Fields – Header Level
▪

Authorized users can use the
Tools > Edit Form UI function
to drag UDFs to the main form
area, dispensing with the side Object (e.g., Sales Order)
window

▪

General authorization required
– General > Edit Form UI

▪

Authorized users can make
this change for their own use
or for other users through a UI
Configuration template

Tools
Edit Form UI …
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▪ Authorized users can use the Tools > Edit Form UI function to drag relevant user-defined fields from
the side window to the main form area, thus dispensing with the side window.
▪ Authorized users can make this change just for their own use or for other users by creating a UI
Configuration template. In the UI configuration template, select the form that has the UDFs added,
then drag the fields into position. The template can then be assigned to users. For more information
on UI configuration templates, see the UI Configuration Templates course in the System Setup and
Administration unit.
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Settings for User-Defined Fields
▪

If you decide to keep UDFs in
the side window, you can
manage them using the
settings window

▪

The settings window is
different from the standard
form settings window. To open
the settings window:
▪

Ctrl+Shift+B

▪

Tools → Customization
Tools → Settings
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▪ If you decide to keep user-defined fields in the side window, you can manage them using the
settings window. The settings window is different to the standard form settings window, but works in
a similar way. To open the settings window for user-defined fields, press Ctrl+Shift+B, or choose
Tools > Customization Tools > Settings. The menu only shows active when you select a form with
user-defined fields.
▪ The user can make the user-defined fields visible or invisible, and active or inactive, in the userdefined fields side window. For example, you can make all the fields relevant for a sales order
invisible in a purchase order.
▪ There is also the option to define new categories to group related fields and only display the fields
for a category.
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Copying UDF Values in Marketing Documents
▪

When you generate a
document from a base
document using Copy To/
Copy From, the value
entered in a user-defined
field is transferred to target
document

▪

This also applies to the
Document Generation
Wizard

▪

If multiple base documents
are copied, with different
values in a UDF, value is not
copied

Object (e.g., Sales Order)

Object (e.g., Delivery)

Value entered into user-defined
field is transferred to target
document using Copy To/Copy
From
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▪ When using the Copy To/ Copy From function to generate a new document from a base document,
the value of a user-defined field is transferred to the target document. This also applies to
documents generated through the Document Generation Wizard.
▪ If multiple base documents are copied to a target document, and the user-defined field has different
values in these base documents, the field value is not copied.
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User-Defined Fields – Row Level
▪

UDFs added at the row level are visible
and active by default

▪

Use standard form settings to position
on row
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▪ When you add a field at the row level, the system adds this field as an additional column in the row.
The field is visible and active by default.
▪ You can change these settings or move the field to a new position on the row using standard form
settings.

372

Properties and Structure of User-Defined Fields

373

Properties of User-Defined Fields
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▪

UDFs are added to the object’s
table and have prefix “U_”

▪

UDFs retained during upgrade, and
can be copied to a new company

▪

New field is added to all document
instances, including records already
saved in the database

▪

UDFs function as normal fields and
can be used in queries and reports

▪

Can import data into user-defined
fields using Data Transfer
Workbench.

374

▪ User-defined fields are added to the respective database table for the object. They can be quickly
identified in the table, since they have the prefix “U_”. In the slide example you can see two new
fields added to the order row table RDR1.
▪ User-defined fields are retained during an upgrade to a new release. When you create a new
company, you have the option to copy user-defined fields from the current company to the new
company.
▪ An important point about user-defined fields is that when you add a new field to an object, the new
field is added to all instances of the object, including records already saved in the database.
▪ UDFs function as normal fields and can therefore be used in queries and reports.
▪ You can also import data into user-defined fields using the Data Transfer Workbench. In the DTW
template, simply add these fields at the end of the spreadsheet. Enter the name of the field in the
header row and enter the value as you would for a standard field.
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Properties of User-Defined Fields (Cont.)
▪

When you add a new field, the database
structure is updated

▪

If other users are logged in, you have
option to:
▪ Wait for users to log off
▪ Force close open documents for
connected users
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▪ It is important to remember that, when you add a user-defined field, the database structure is
updated. Therefore you should only add new fields when no other users are logged in.
▪ If you try to add a new field, the system will warn you if there are logged in users. You have the
option to:
▪ Try Again – you can notify the users close their work and wait until they have logged out of the
system
▪ Ignore - the system will force close all open documents for all connected users

375

Type and Structure

▪

You can select a Type and optionally a
Structure for each user-defined field

▪

The Structure is dependent on the Type
and influences the format of the field

Note: you cannot change the type and
structure after you have added the field to
the database. If you choose the wrong
type or structure, remove the field and start
again.
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▪ When you create a user-defined field you can select a Type and optionally a Structure for each
user-defined field.
▪ The Structure is dependent on the Type and influences the format of the field.
▪ Be aware that you cannot change the type and structure after you have added the field to the
database. If you mistakenly choose the wrong type or structure, you can remove the field and start
again.
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Type and Structure
Type

Structure

Maximum Length

Alphanumeric

▪
▪
▪
▪

254

Numeric

-

Date/Time

▪ Date
▪ Hour

Units and Totals

▪
▪
▪
▪
▪
▪

General

▪ Link
▪ Image

Regular
Address
Telephone No.
Text

2GB (header) / 255KB row

Rate
Amount
Price
Quantity
Percents
Measure
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▪ Fields with Alphanumeric type can have one of the structures shown here. A Regular structure can
hold up to a maximum of 254 characters. A Text structure can accommodate 2 GB of text in header
fields and 255 KB of text in row fields.
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Type and Structure
Type

Structure

Maximum Length

Alphanumeric

▪
▪
▪
▪

254

Numeric

-

Date/Time

▪ Date
▪ Hour

Units and Totals

▪
▪
▪
▪
▪
▪

General

▪ Link
▪ Image

Regular
Address
Telephone No.
Text

2GB (header) / 255KB row

Rate
Amount
Price
Quantity
Percents
Measure
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▪ Fields with Numeric type can only hold integers, therefore there is no structure.

378

Type and Structure
Type

Structure

Maximum Length

Alphanumeric

▪
▪
▪
▪

254

Numeric

-

Date/Time

▪ Date
▪ Hour

Units and Totals

▪
▪
▪
▪
▪
▪

General

▪ Link
▪ Image

Regular
Address
Telephone No.
Text

2GB (header) / 255KB row

Rate
Amount
Price
Quantity
Percents
Measure
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▪ Fields selected with the Date/Time type can have Date or Hour as the structure.
▪ These fields behave in exactly the same way as other date and time fields in the system; for
example, the calendar icon is available in a field with the date structure.
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Type and Structure
Type

Structure

Maximum Length

Alphanumeric

▪
▪
▪
▪

254

Numeric

-

Date/Time

▪ Date
▪ Hour

Units and Totals

▪
▪
▪
▪
▪
▪

General

▪ Link
▪ Image

Regular
Address
Telephone No.
Text

2GB (header) / 255KB row

Rate
Amount
Price
Quantity
Percents
Measure
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▪ To enter fractions as well as integer numbers in the new field, use the Units and Totals type and
select one of the structures shown here.
▪ Decimal places will display in the new field according to the initialization settings on the Display tab
of the General Settings.
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Type and Structure
Type

Structure

Maximum Length

Alphanumeric

▪
▪
▪
▪

254

Numeric

-

Date/Time

▪ Date
▪ Hour

Units and Totals

▪
▪
▪
▪
▪
▪

General

▪ Link
▪ Image

Regular
Address
Telephone No.
Text

Rate
Amount
Price
Quantity
Percents
Measure

2GB (header) / 255KB row

Need to define path to Attachments or
Pictures folder in General Settings (Path
tab).
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▪ If you select the General type, the new field can hold links or graphics.
▪ Fields with the Link structure can link to a file or to a web address. You must first define the
default path to the Attachments folder. This is done in the General Settings. This default path is
opened when the user double-clicks the new field. The user can either select a file from the
default folder, or enter a web address in place of the file name.
▪ Fields with the Image structure can accommodate pictures. You must first define the default path
to the Pictures folder, in the General Settings. If this default path is not defined, an error will
occur when the image field is used. When the user double-clicks the image field, the default
folder opens, enabling them to select an image file. The user can then change to a different
folder to locate the image.
▪ The user can, at any time, change an image or web address by pressing the Ctrl key and doubleclicking the image or web address.

381

Validation Options

▪

Option to define validation rules for entering
data in user-defined field:
Linked to Entities
Valid Values
Advanced
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▪ In addition to the type and structure for a user-defined field, you have the option of specifying
validation options.

382

Validation Options
Option
Linked to Entities Link user-defined field in a form to a system
object, a user-defined table, or a user-defined
object
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▪ The option Linked to Entities allows you to set up a direct link between a user-defined field in a form
and a system object, a user-defined table, or a user-defined object. In the example we have linked a
user-defined field in the service contract form with the A/R invoice object.
▪ The link is actually established by the user who creates the form. In the user-defined field the user
will be shown all the instances of the chosen object and can select one to create the direct link. For
example, when creating a service contract for customer C40000 the user can select the invoice paid
by this customer for the service item. After the link is established the user can open the A/R invoice
directly from the user-defined field.
▪ Be aware that the user must select the correct instance, since the system shows all rows stored in
the database for the chosen object.
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Validation Options
Option
Valid Values

Define a list of possible values
for a user-defined field
User selects value from
predefined list
User cannot update or add
values to list
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▪ If valid values is chosen, you can define a list of possible values for the user-defined field. This
definition is made when you add the user-defined field.
▪ In the example, you can see that there are three possible values for the field - silver, gold and
platinum.
▪ This list is available in the document as a dropdown list, allowing the user to select one of the
values.
▪ The user cannot update the values in the list. The list values can only be updated by the authorized
user from the User-Defined Fields – Management window.

384

Validation Options
Option
Advanced

Define validation rules for
values entered in UDF
User can only enter values that
meet the rule
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▪ If the Advanced option is selected the system lets you set some simple validation rules for when the
user enters data in the user-defined field.
▪ The validation rules apply to all UDF types with the exception of General type.
▪ The validation controls vary according to the type and structure of the user-defined fields. For
example, for alphanumeric type the rules can check which characters the user can enter in the field,
and how many characters. For units and totals the rules can check that the amount entered falls in
a certain range.
▪ Other rules allow you to validate that the value entered is equal to, less than, or greater than a value
entered when you add the user-defined field.
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User-Defined Field with User-Defined Values Added
Sales Order

Tools > User-Defined Values
▪

Using user-defined values, you can link
a query to a user-defined field

▪

Query can automatically populate the
field value based on query result

▪

Query can be set to run manually by the
user or automatically triggered when
another field is entered, for instance, the
customer code
Example:
SELECT T0."Balance" FROM OCRD T0
WHERE T0."CardCode" = $[$4.0.0]
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▪ A flexible way of using a user-defined field is to link a query to the field using user-defined values.
▪ The query can automatically populate the field value based on the result of the query.
▪ In the example shown, a query is added to a user-defined field in the header of a sales order. The
query fetches the customer’s account balance from the business partner master data table OCRD.
The query runs automatically when the user selects the customer code when they first create the
sales order.
▪ User-defined values functionality is covered in the companion course User-Defined Values.
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Default and Mandatory Fields

▪

Default value can be set for any user-defined
field
▪ Default value will appear in all new instances
of the object
▪

Option to set user-defined field as
mandatory. If field is mandatory, user will not
be able to add record without entering field
value
▪ To set field as mandatory, you initially need
to supply a default value, but you can
remove the default value after you add the
user-defined field to the database
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▪ You can optionally set a default value for any user-defined field.
▪ In the example, we have selected a default time from the list of valid values.
▪ The default value set for a field will appear in all new instances of the object.
▪ You can optionally set the user-defined field as mandatory. The user will not be able to add a new
record without entering data into the mandatory field.
▪ When you set a user-defined field as mandatory, you need to initially supply a default value, to
maintain the integrity of the database. After you have added the user-defined field you can remove
the default value.
▪ If you update a user-defined field to make it mandatory, and the field already has a default value,
the system will prompt you to choose if the default value should be inserted into all existing
instances of the object, or whether to only insert the default value into new instances.
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User-Defined Fields: Key Points
Key points from this topic:
▪ You can add user-defined fields (UDFs) to most objects
▪ User-defined fields are added to the object’s table in the database, and have prefix “U_”
▪ Fields can be added to marketing documents at the header (title) and row level
▪ User-defined fields at the header level appear initially in a separate side window. Use the
View menu to open this side window.
▪ You can move the fields from the side window to the main area of the document using the
Edit Form UI function and assign to users in a UI configuration template
▪ A value entered into a user-defined field is transferred to a target document using Copy
To/Copy From
▪ UDFs can have various types and structures. The choice of structure affects the type of
data you can enter in the field. You can add a list of valid values to a UDF, link it to a
system object, define rules for data entry, set a default value, or make it mandatory.
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▪ Here are some points to take away regarding user-defined fields and tables:
▪ You can add user-defined fields to most objects.
▪ User-defined fields are added to the table for the selected object in the database, and have
prefix “U_”.
▪ For marketing documents, you can add fields to the header (title) area or to the rows.
▪ User-defined fields added at the header level of a marketing document initially appear in a
separate window to the side. You can use the View menu to open this window.
▪ You can move user-defined fields from the side window to the main area of the document using
the Edit Form UI function. You can then make the edited document available to users in a UI
Configuration template.
▪ A value entered into a user-defined fields is transferred to a target document using the Copy
to/Copy from function.
▪ User-defined fields can have various types and structures, such as alphanumeric and regular.
The choice of structure affects the maximum field length and the type of data you can enter in
the field.
▪ You can optionally add a list of valid values to a UDF, link it to a system object, define rules for
validating data entry in the field, set a default value, or make it mandatory. You can also link the
user-defined field to a user-defined table or user-defined object.
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Customization Tools:
User-Defined Values
SAP Business One Version 9.3

PUBLIC

▪

Welcome to the topic on User-Defined Values.

389

Objectives

Objectives:
▪

Add user-defined values to fields in forms and documents to
assist and expedite data entry by end users:
▪

Add a list of values as user-defined values

▪

Use a query as user-defined values
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▪ On completion of this topic, you will be able to add user-defined values to fields in forms and
documents to assist and expedite data entry by end users. You will learn how to add a list of values
as user-defined values, and how to use a query as user-defined values.

390

Business Scenario

▪ The company wants to have the delivery date automatically calculated in sales orders,
so that the salesperson does not have to manually enter the date. In the business
process, the delivery date is not significant since orders are dispatched immediately.
▪ The salesperson needs the ability to instantly view a customer’s account balance when
processing a new sales order over the phone.

Solution: These requirements can be implemented using user-defined values.

Sales Order

Delivery

A\R Invoice

Incoming
Payment

391

© 2018 SAP SE or an SAP affiliate company. All rights reserved. ǀ PUBLIC

▪ Here are two examples of requirements that can be met by adding user-defined values to form
fields:
▪ In the first example, the company wants to have the delivery date, which is a mandatory field,
automatically calculated in sales orders, so that the salesperson does not have to manually
enter the date. In the business process the delivery date is not used, since sales orders are
dispatched immediately for delivery.
▪ In the second example, the salesperson needs the ability to instantly view a customer’s up-todate account balance when processing a new sales order over the phone. With user-defined
values, the salesperson does not have to manually drill-down to the master data.

391

User-Defined Values
Sales Order

▪

▪
▪

User-defined values (UDVs) can
be added to any editable field in
a document or form
UDVs added at the row level
apply to each row
UDVs can be in the form of:
▪ List of values
▪ User query

UDVs can be added to any
editable field at the header or
row level, and to user-defined
fields

392
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▪ You can add user-defined values to any editable header field in a document or form, and to row
level fields. You can also add UDVs to user-defined fields.
▪ If added at the row level, user-defined values apply to each row.
▪ User-defined values can be added to a field as:
▪ List of values. The user chooses from a list of predefined values for the field.
▪ User query. When the query runs, the query results are stored in the field. In the example, a
query has been added to the delivery date field. The query will calculate a valid date for the
delivery. Using a query is the most flexible option as the query can be set up to run manually or
automatically.

392

Indicator for User-Defined Values
View  Pickers Display  User-Defined Values
▪

Magnifying glass icon indicates that user-defined values have been added to field

▪

Toggle on and off from View  Pickers Display  User-Defined Values

393
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▪ A magnifying glass icon indicates that user-defined values have been added to the field.
▪ Users can toggle the display of this icon on and off, using the menu View > Pickers Display > UserDefined Values.
▪ In the example, we can see that user-defined values have been added to the Delivery Date field,
and to a user-defined field called Source.
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Adding User-Defined Values
▪

Alt+Shift+F2

▪

To add user-defined values to a
field, select the field in the
document or form and:
▪

Press Alt+Shift+F2, or

▪

Choose Tools >
Customization Tools >
User-Defined Values Setup

General authorization required –
“User-Defined Values – Setup”

394
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▪ To add user-defined values to a field, select the field in the document or form and press the key
combination Alt+Shift+F2, or choose the menu path Tools > Customization Tools > User-Defined
Values - Setup.
▪ The setup screen for user-defined values will open.
▪ Only authorized users can add UDVs. The authorization is located in the General Authorizations
window by navigating to Customization Tools > User-Defined Values – Setup.

394

Removing User-Defined Values

To remove user-defined values from
field:
▪

Select the field and press
Alt+Shift+F2

▪

In the setup window, choose
Without Search in User-Defined
Values

Alt+Shift+F2
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▪ In the setup window for user-defined values, use the option Without Search in User-Defined Values
to remove user-defined values from the field.
▪ There are no restrictions on removing user-defined values from a field. After you remove the userdefined values, documents saved in the system retain the values entered in the fields.
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List of Values

▪ You can add a list of values to a field using user-defined values.

396

Adding a List of Values
Choose the option Search in Existing User-Defined Values



Alt+Shift+F2

Make sure the
value entered
does not exceed
the field length

397
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▪ To add a list of values to a field, choose the option Search in existing user-defined values. Select
the browse icon in the setup screen, and enter the values for the list.
▪ When defining the values, make sure that the value does not exceed the field length as defined in
the database. In this example, a list of values has been added to a user-defined field called Source.
If the length of the field Source is 15 characters, and you enter a value with16 characters, the last
character will be truncated.
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Adding a List of Values (cont.)

▪

To open the list of values,
the user can select the
magnifying glass in the
field, or can select the field
and press Shift+F2
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▪ To open the list of values when processing a form, the user can select the magnifying glass
indicator or press Shift+F2 in the field. The user then selects a value from the list. Furthermore, the
user can add new values to the list by choosing the New button.
▪ This example shows a list of values added to a user-defined field. Note that a list of values can also
be defined when you initially create a user-defined field using the User-Defined Fields –
Management window. The difference is that the user cannot add new values to the list. The list can
only be maintained from the User-Defined Fields – Management window.

398

Marketing Documents and UDVs
▪ User-defined values are not inherited by other document types, therefore you need to
add them to each document type as required
▪ The value entered into a field with user-defined values is transferred to target
Sales
Order From
document using Copy
To/Copy

User-Defined Values - Setup

Value entered in field using
UDVs is transferred to target
document using Copy to/Copy
From

399
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▪ Note that, when you add user-defined values to a specific marketing document type, such as a
sales order, other similar document types such as deliveries and invoices are unaffected. In other
words, user-defined values behave differently to user-defined fields and are not inherited by other
document types. Therefore you need to add user-defined values to each specific document type as
required.
▪ However, the value entered in a field with user-defined values is transferred to a target document
using the Copy To/ Copy From function.

399

Attaching a User Query

▪ You can attach a query to a field using user-defined values.

400

Adding a Query to a Field
Choose the option Search in Existing User-Defined Values According to Saved Query

401
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▪ The option Search in existing user-defined values according to saved query lets you attach a query
to the field.
▪ This option is very powerful, since the field is populated with the results of the query.
▪ The query can set a value in the field, or store the results of a calculation in the field, or fetch
another field value from the database to go in the field.
▪ The query can also use a variable to prompt the user for a parameter, and use the parameter to
calculate the results.
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Adding a Query to a Field (cont.)
Choose the option Search in Existing User-Defined Values According to Saved Query

Saved user query
Example:
SELECT ADD_DAYS($[ORDR."DocDate"], 7)
FROM DUMMY
▪

When the query runs
the result is
populated in the field

402
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▪ When you use a query, make sure the query result matches the field type in the document, and
does not exceed the size of the field. For example, do not return an alphanumeric string result into a
field that is defined as numeric.
▪ In the example shown here, a query is used to set the delivery date in a sales order. The query adds
7 days to the current date (DocDate) and stores the result as the delivery date. The query refers to
the DocDate field in the current active document therefore it uses the $ and square brackets.
▪ The query is written using SAP HANA syntax and requires the clause “FROM DUMMY” since there
is no FROM clause in the query.
▪ For more information on creating queries using the query tools see the course Queries.
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Adding a Query to a Field (cont.)

You can decide how the query will be triggered to run:
▪

If you do not select Auto Refresh When Field Changes,
the user must select the magnifying glass icon or select
the fields and press Shift+F2

▪

If you select Auto Refresh When Field Changes, the
query will run automatically with no user involvement

403
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▪ When you select the option to use a query as user-defined values, you can decide if you want the
query to automatically run without user involvement.
▪ The Auto Refresh When Field Changes checkbox determines if the query runs automatically.
▪ If you do not select this checkbox, the query is not automatic and only runs when the user clicks the
magnifying glass or presses Shift+F2 in the field.
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Auto Refresh

Delivery Date

▪

To have the query run automatically you select a
depended field

▪

When the depended field is selected or changed,
the query runs

▪

In marketing documents, the customer or vendor
code is often selected as the dependent field

Select dependent field

404
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▪ If you select the Auto Refresh When Field Changes checkbox, you are prompted to select a
dependent field. The query runs automatically when the dependent field changes in value or the
user enters a value in the dependent field.
▪ In marketing documents, the customer or vendor code is often selected as the dependent field.
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Auto Refresh – Refresh Frequency
 Auto Refresh When Field Changes

▪ Display Saved User-Defined Values (default) –
query runs once then retains the result in the field
▪ Refresh Regularly – query runs each time the
dependent field changes or is selected in a
document

405
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▪ When you choose Auto Refresh When Field Changes, two further options appear. These options
determine if the query runs only once, or if the query runs whenever the dependent field changes.
▪
The default option is Display Saved User-Defined Values and is recommended since it
maintains the initial result of the query. The query runs once when the dependent field
changes, and will not run again even if the dependent field changes. An example is a query
added to the Delivery Date in a document. The query calculates a delivery date based on the
system date. You only want the query to run once. If the query ran multiple times, the delivery
date might be incorrectly updated.
▪
If you choose Refresh Regularly, the query will run each time the dependent field changes or
is selected in a document. You should use this option with caution since it can result in the
field value changing when not expected. When the query runs, the document status will
change to Update mode, and you must save the changes if you want to record the new query
results. An example of using Refresh Regularly is a query that shows the up-to-date account
balance of a business partner. You want the query to run whenever you browse or open the
document so you can always see the latest balance. However, you will still be prompted to
update the document if you want to save the query results.
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Auto Refresh - Example
Sales Order

▪ Query is added to userdefined field Account
Balance
▪ Customer code is set as the
dependent field

▪ Auto Refresh is selected
with Refresh Regularly
Result:
▪ Query will run when user
selects a business partner
code in a new sales order
▪ Query will also run if user
browses through old
documents
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▪ Here is an example to illustrate how the auto refresh function works.
▪ A query is added to a user-defined field in the sales order. The query access the customer’s
account balance from the business partner master data.
▪ The Customer/Vendor Code is selected as the dependent field. When the user selects the business
partner code in a new sales order, this action triggers the query to run.
▪ This is typically the first action when a user processes a new marketing document. Therefore it is a
common practice to use the Customer/Vendor Code as a dependent field to trigger the query to run.
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Auto Refresh on Row-level Fields

▪ For a query added to a header
field, you can only select another
header field as a dependent field
▪ For a query added to a row-level
field, you can select either a
header field or a row-level field as
a dependent field:
▪ Choose When Field Changes if
you want to use a header field
as the dependent field
▪ Choose When Exiting Altered
Column if you want to use
another row field as the
dependent field

407
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▪ For a query added to a header field in a document, you can only select another header field as the
dependent field. This includes all fields in the document that are not in the row table.
▪ For a query added to a row-level field, you can select either a header or a row-level field as the
dependent field. When you add user-defined values to a row field and choose Auto Refresh, you
have two choices:
▪
Select When Field Changes if you want to use a header field as the dependent field for a rowlevel query.
▪
Select When Exiting Altered Column if you want to use another row-level field as the
dependent field for a row-level query.
▪ In the example a query is added to a row field called Warranty and the item number is selected as
the dependent field. The query will run when the item number is selected on the row.
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User-Defined Values: Key Points
Key points from this topic:
▪

User-defined values can assist users with data entry by using a list of values or a query to
populate a field value

▪

You can add UDVs to editable header and row-level fields, and to user-defined fields. To
add UDVs, select the field and press Alt+Shift+F2

▪

Magnifying glass indicator shows if UDVs exist for a field – View > Pickers Display

▪

User can open list of values or run query manually by selecting the indicator or pressing
Shift+F2 in the field

▪

To set a query to run automatically, use auto refresh and select a dependent field. Then
select either:
▪
Refresh Regularly – query will run each time the dependent field changes or is
selected
▪
Display Saved User-Defined Values – query runs once then retains the result in the
field
Queries should be written to reference the active window

▪
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▪
▪
▪
▪
▪
▪
▪

▪

Please take a minute to review these key points:
User-defined values (UDVs) can assist users with data entry by using a list of values or a
query to populate a field value.
You can add UDVs to editable header and row level fields, and to any user-defined field. To
add UDVs, select the field, then press Alt+Shift+F2.
A magnifying glass indicator shows if user-defined values exist for a field. You can enable this
from the View > Pickers Display menu.
User-defined values can be set up as a list of values, or, more commonly, as a user query.
A user can opens the list of values or run a query manually by selecting the magnifying glass
indicator or pressing Shift+F2 in the field.
If a query is used, the results of the query are saved in the target field. To set the query to run
automatically with no user involvement, use the the auto refresh option and select a
dependent field. Two further options are available for running the query:
▪
If you select Refresh Regularly, the query will run each time the dependent field changes or
is selected, or when browsing records. This could lead to inconsistent results, depending on
the query, or could cause a performance degradation when browsing through records.
▪
If you select Display Saved User-Defined Values, the query will run once and retain the
result in the field. This option is recommended since it maintains the initial value of the field,
but the choice of this option depends on the business need and the query.
Queries should be written to reference the active window, where needed.
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Customization Tools:
User-Defined Tables
SAP Business One Version 9.3

PUBLIC

▪

Welcome to the topic on User-Defined Tables.

409

Objectives

Objectives:
▪

Add a user-defined table (UDT) to the SAP Business One
database and make it accessible in a document or form

▪

Create a user-defined object (UDO) from a user-defined table
and make the object accessible from the main menu
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▪ On completion of this topic, you will be able to:
▪ Add a user-defined table (UDT) to the SAP Business One company database, and make the
user-defined table accessible in a document or form.
▪ Create a user-defined object (UDO) from a user-table and make the object accessible from the
main menu.
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Business Scenario

▪

The company wants to assign a delivery driver to delivery documents. The delivery
drivers can be maintained in a user-defined table which is accessed from the delivery
document.

▪

The table can be maintained by users.

Sales Order

Delivery

A\R Invoice
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Incoming
Payment
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▪ A company wants the ability to assign a delivery vehicle to delivery documents.
▪ The delivery fleet can be maintained as a user-defined table and made available to the delivery
document.
▪ Users can manage the fleet entries in the table.
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User-Defined Tables
Tools → Customization Tools → User-Defined Tables - Setup
▪

User-defined tables (UDTs) store
related sets of data

▪

User tables have the prefix @

▪

Option to copy UDTs when creating
new company

@Drivers
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▪ In addition to user-defined fields, you can add new tables to the database. User-defined tables
(UDTs) give you the ability to store additional, related sets of data.
▪ The user-defined table becomes part of the company database. The system identifies user-defined
tables by the ‘@’ prefix so you can easily distinguish them from system tables.
▪ When you create a new company, you have the option to copy user-defined tables from the
currently selected company to the new company.
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Object type for User-Defined Tables
Tools → Customization Tools → User-Defined Tables - Setup
▪

Object Type:

To set up table, enter name and description, and
select object type

To link table to user-defined field (UDF) in a
document or form, choose:
▪

No Object

▪

No Object with Auto. Increment

To link table to a user-defined object (UDO)
choose:
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•

Master Data

•

Master Data Rows

•

Document

•

Document Rows
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▪ User-defined tables can be linked to a user-defined field (UDF) in a document or form. To do this
you must choose the correct object type when you create the table.
▪ To link to a UDF choose No Object or No Object with Auto Increment.
▪ To link to a user-defined object (UDO) choose one of the other options:
▪
Choose Master Data if the object will hold master data. You can also create child tables by
selecting Master Data Rows as the object type.
▪
Choose Document if the object will hold transactional data. You can also create child tables by
selecting Document Rows as the object type.
▪ Note that you cannot change the Object Type after you have added the user table to the system.
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Information about User-Defined Tables

▪

Information about new tables is stored in OUTB table
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▪ Information about each new table is stored in the OUTB system table. Information includes the
object type.
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Linking a User-Defined Table to a UDF

▪ To link table to user-defined field (UDF) in a document or form, you create the table with the object
type No Object.

415

Accessing a New Table
Tools → User-Defined Windows

▪

Access new table from the Tools
menu

▪

Table initially contains two columns –
code and name
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▪ You access a newly created user-defined table by selecting the table from the Tools menu.
▪ The table initially contains two columns, code and name.
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Entering Data in a New Table

▪

If object type No Object,
Code field is editable

▪

If object type No Object with
Auto Increment, Code field
not editable and is auto
incremented

▪

Code is primary key and
Name must be unique in
each row
Primary key
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Unique
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▪ In our scenario, we want to use the table in a user-defined field in a delivery document. Therefore
when we set up the table we could choose either No Object or No Object with Auto Increment as
the object type.
▪ If you choose No Object as the object type when you create the table, the Code column is
editable and you can enter a unique value for each row.
▪ If you choose No Object with Auto Increment as the object type, the Code column is not editable
and the value will be auto incremented for each row of data you enter. We chose this option so
the primary key is updated for us.
▪ The Code is the primary key and the Name must be unique for each row that you add to the table.
In addition, you have the option to select any field or combination of fields from the user table as a
new key. This option can speed up searches.
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Adding Columns to a UDT
Tools → Customization Tools → User-Defined Fields - Management
▪

To add columns to table, select the table and
choose Add

© 2018 SAP SE or an SAP affiliate company. All rights reserved. ǀ PUBLIC

418

▪ To be useful, a user-defined table needs additional columns. Each column is added as a userdefined field.
▪ Select the name of the table in the user-defined fields management window. Then add a userdefined field for each column.
▪ In the example, we have added four additional columns – Name, Shift, Available, and Location to
the Delivery Drivers table. In these fields we will record the name of the driver, the hours they work,
if they are available for assignment, and their location. With this information, a user will be able to
select the best driver for the delivery.
▪ For information about user-defined fields, see the related course User-Defined Fields.
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Viewing the Columns Added to a UDT
Tools → User-Defined Windows
Additional Columns
▪

To enter data in the additional
columns, or add new rows to the
table, open the table from the
Tools menu

▪

If new columns are not visible in
window, adjust width of columns
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▪ After the additional columns have been added to the table, you can enter data or add new rows by
choosing then menu Tools > User-Defined Windows. Choose and select the table. If the new
columns are not visible in the window, you may need to adjust the width of the columns to bring the
new fields into view.
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Queries

▪

The user-defined table is not yet attached to a
form or document, but can be used in queries

▪

Table name starts with @

▪

Columns are UDFs so start with U_

▪

You can also import data into the table using the
Data Transfer Workbench.
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▪

420

At this point the user-defined table is not attached to any form or document so is not accessible to
the user; however, you can use the table in queries, and you can import data into the table using
the Data Transfer Workbench.
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Linking the Table to a UDF
Tools → Customization Tools → User-Defined Fields - Management
▪

To make the table accessible to users, link it
to a UDF in a document or form

▪

UDF must be Alphanumeric type

Note: You can link the same user-defined table to
multiple user-defined fields.
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▪ To make a user table directly visible to users in a form or document, you link the table to a userdefined field in the document or form.
▪ Note that user tables can only be linked to UDFs with the Alphanumeric type and Regular structure.
▪ In the example, a user-defined field called Drivers is added to the title area of the marketing
documents object. When you add the user-defined field choose the Set Linked Table validation
option. Then select the user-defined table from the dropdown list.
▪ You can link the same user-defined table to multiple user-defined fields in different objects, at both
the header and the row level. For example, you could link the trucks table to a user-defined field in
the pick list document in addition to the delivery document.

421

Using the UDT in a Document

▪

To view and access all columns,
choose Define New

© 2018 SAP SE or an SAP affiliate company. All rights reserved. ǀ PUBLIC

422

▪ When you select the user-defined field, you can see the first two columns. Choose Define New to
view and access all columns in the table.
▪ The user can edit and add rows to the table.

422

Selecting the Value from the UDT

Value selected in user-defined table is
stored in the user-defined field
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▪ In this example, the customer has requested an evening delivery, therefore a driver is selected who
is available in for an evening delivery. The Name from the user-defined table is now stored in the
user-defined field in the document.
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Linking a UDT as a User-Defined Object

▪ To link a user table as a user-defined object (UDO) you create the table with the object type Master
Data or Document.
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Adding Fields to User Table for UDO
Tools → Customization Tools → User-Defined Fields - Management
▪

User-defined object (UDO)
consists of UDT and added
UDFs

▪

These fields will hold the
data for the new business
object

▪

To add user-defined fields
to user table, use the path
shown here or you can use
the DI API
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▪ A user-defined object consists of a user-defined table and added user-defined fields. These fields
will hold the data for the new business object.
▪ You can add user-defined fields using the SAP Business One application or via the DI API. In this
example we have created a user table called Company Cars, as a master data object.
▪ We have added 4 user-defined fields.
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Registering the New Table as an Object
Tools → Customization Tools → Objects Registration Wizard
▪

Use the registration wizard to register user
tables as user-defined objects

▪

The registration is per company

▪

Enter a unique ID and select the table

▪

Select the services for the object, such as:
▪ Add

▪
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▪

Update

▪

Find

▪

Delete

Optionally select child table as rows
426

▪ Once you have created the user table with the user-defined fields you need to register it as an
object in SAP Business One using the Objects Registration Wizard. The registration is per
company.
▪ Enter a unique ID and select the user-defined table name.
▪ As you progress through the wizard you will be prompted to select the services for the object, for
example, Add, Update, Find, Delete. Add and Update are basic services and cannot be deselected.
▪ You can optionally select a child table, that will appear as rows in the master data or document
object. Child tables are created by selecting the object type as Document Rows or Master Data
Rows.

426

Adding the Object to the Main Menu

▪

To add the object as a
menu item, select the
Menu Item checkbox,
then select the module
and position
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▪ You can add the object to the main menu by selecting the Menu Item checkbox in the wizard. You
then select the module from the selection form, and the position within the module menu.

427

Style of the New Table

Header Line Style

Matrix Style
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▪ You can select either Header Line Style or Matrix Style in the wizard. This affects how the table
displays when the user access it. Examples are shown here.
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User-Defined Tables: Key Points
Key points from this topic:
▪ You can add user-defined tables (UDTs) to the database to hold additional, related sets of
information
▪ User-defined tables have the prefix “@”
▪ To link a user-defined table to a user-defined field in a document or form:
▪

Select Object Type as No Object or No Object with Auto. Increment

▪

The table is initially created with two columns, code and name. Add user-defined
fields as additional columns in the table

▪

To make the table available in a document or form, link the table to a user-defined
field in the document or form (choose the Set Linked Table option).

▪ To use a table as a user-defined object:
▪

Select Object Type as Master Data or Document

▪

Add user-defined fields as columns

▪

Run the objects registration wizard to create the user-defined object, select the object
services, select child tables for rows, and add the object to the main menu.
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▪ Here are some points to take away regarding user-defined tables:
▪ You can add your own user-defined tables to the database. These tables can hold additional,
related sets of information.
▪ User-defined tables can be identified with the prefix “@”.
▪ To be able to link a user-defined table to a user-defined field in a document or form, select the
Object Type as No Object or No Object with Auto. Increment.
▪ The table is initially created with two columns, code and name. User-defined fields can be
added as additional columns in the table.
▪ To make a UDT accessible to a user in a document or form, create a user-defined field in the
document or form, then choose the Set Linked Table option to link the table to the UDF. Only
UDTs with Object Type No Object or No Object with Auto. Increment can be linked to a UDF.
End users can access the table through the UDF, and have the ability to add rows to the table,
and enter data in the user-defined field columns.
▪ To use a table as a user-defined object (UDO), select the Object Type as Master Data or
Document.
▪ Add user-defined fields to the table as columns.
▪ Run the objects registration wizard to create the object, select the services for the object, select
any child tables for rows in the object, and add the object to the main menu. Users can access
and maintain the object from the menu, and browse through records.
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Customization Tools:
Introduction to Analytics
SAP Business One Version 9.3

PUBLIC

▪

Welcome to Introduction to Analytics.

430

Objectives

Objectives:
▪

List the mechanisms for displaying analytics in a user’s cockpit

▪

Describe the semantic layer and calculation views in SAP HANA

▪

Explain how dimensions and measures are used in the analytical tools

▪

Create a pervasive dashboard with actions

This course is intended to provide implementation consultants with an introduction to SAP HANA
analytics. Further, more in-depth training on analytics is provided in other courses from SAP.
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On completion of this topic, you will be able to:
▪

List the mechanisms for displaying analytics in a user’s cockpit

▪

Describe the semantic layer and calculation views in SAP HANA

▪

Explain how dimensions and measures are used in the analytical tools

▪

Create a pervasive dashboard with actions

Note that this course is only intended provide implementation consultants with an introduction to SAP
HANA analytics. Further, more in-depth training on analytics is provided in other courses from SAP.
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Business Intelligence in SAP Business One

Pervasive Dashboards
(in cockpit and in
document sidebars)

Reports and Queries:

KPIs (in
cockpit)

Advanced
Dashboards

Semantic Layer
Views

▪

Crystal Reports

▪

System and User queries

Excel Report and Interactive
Analysis Designer

Crystal
Dashboards
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The semantic layer in the SAP HANA database contains views (models) of operational data. Each view
integrates fields from different source tables to model a comprehensive business scenario, for
example, financial, logistics, sales, purchasing, and so on. The view insulates the user from the
technical details of the underlying tables and the need for joins.
In SAP Business One, insight into key business metrics is extracted using queries on the views and
provided to users in real-time through several mechanisms:
• Pervasive analytics dashboards in the user’s cockpit or in the sidebar of marketing documents
• Key Performance Indicators(KPIs) in the user’s cockpit
• Advanced dashboards in the user’s cockpit
• Dashboards created with Crystal Reports Designer
SAP provides pre-built pervasive dashboards, KPIs and advanced dashboards, and partners can
create additional pervasive dashboards, KPIs, advanced dashboards, and Crystal dashboards.
Additionally, end users can access the semantic views using the Excel Report and Interactive Analysis
Designer add-in for Microsoft Excel to create reports and analyses.
Users can use the SAP Business One Query Generator as well as Crystal Reports to access the views
using SQL queries.

432

Example View: Dimensions and Measures

Customer
Dimension

Product Dimension

Customer
Product
Employee
Date
Sales Employee
Dimension

Sales Total
Gross Profit
Quantity

Date Dimension
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A view pulls data from multiple tables and calculates results that are used for reporting and analysis.
No actual data is held in the view, it is simply a model that structures the data for queries. When the
query is run, the data is pulled from the physical tables.
Let us look at a hypothetical calculation view of a sales order transaction in SAP HANA. The view pulls
together fields from many tables that are involved in the sales order, including, as you might expect,
ORDR, RDR1, OSHP, OCRD, OCPR, OITM, ITM1, and so on.
The view pulls together two types of data: dimensions and measures:
•
The dimensional data are the descriptive data such as the document number, business partner
code, sales employee, product, date, and so on. This tells you who, when and what but does not
give any quantifiable fields.
•
The measurable data are the quantifiable fields that can be calculated, such as total amounts,
gross profit, tax and quantities. Using a query, you can SUM these fields.
The customer dimension represents the customer attributes referenced in the sales order, such as
document number and business partner code. The product dimension represents the item and the
characteristics for that item. The date dimension represents various dates such as Document Date,
Posting Date and Delivery Date. The sales employee dimension represents the sales employee code
in the sales order. Using a query, you can GROUP and SUM document totals by different attributes,
such as by business partner or by sales employee, or use the date dimension to aggregate data by
time.

To see a full list of the views, reference the how-to guide How to Work with Sematic Layers.
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Cockpit Analytics
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Pervasive Dashboard

Pervasive dashboard is
designed using queries on the
calculation views
Here is a example of a
pervasive dashboard for
measuring opportunities
Users can:
▪ Mouse over a section to see
a dimension and its
associated measure

C42000
45050

▪ Right-click to open a context
menu with actions
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A sample, pervasive dashboard is shown in the slide. The pervasive dashboard is built from a
predefined query or calculation view and shows a dimension (business partner code) and a measure
(total).
This particular dashboard measures customer opportunities. You can easily create a pervasive
dashboard to meet a specific requirement and show the data visually in charts and graphs.
The data in the pervasive dashboard is read-only and is refreshed so that the data presented to the
user is always up-to-date.
Once created, you can add the pervasive dashboard to a user’s cockpit or to an advanced dashboard.
Here, users can mouse over sections in the dashboard to see the dimension values (in this case
customer numbers) and the associated measure (in this case the potential value in opportunities).
You can also add actions to allow the user to perform related tasks, such as opening a related
document or master data record. In the example the user can launch 3 actions from the context menu.
Later in this course, you will see how to create this pervasive dashboard and actions.

Key Performance Indicator (KPI)
▪ Key performance indicator
widgets allow you to visually
evaluate the status of your
business.

Name

KPI value with color
indicates that this KPI
has reached its goal

▪ SAP provides prebuilt KPIs and
you can also design your own.
▪ You can base your KPI on:
▪ Calculation view

KPI shows an upward trend.
The arrow’s color indicates a
positive trend

▪ User-defined query
▪ Multiple KPI widgets can display
in a user’s cockpit or advanced
dashboard

The date range
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Key performance indicators show a key metric that enables users to evaluate the status of their
business at any time. A KPI is built based on a calculation view or a user-defined query that exists in
the system. A KPI has a goal and an optional trend and tracks the progress towards the goal.
In the example, the metric is total assets, which is one of the predefined KPIs provided by SAP. The
KPI value appears in the center. Colors can be used to show if the KPI is meeting its goal. In this KPI,
the green color indicates that this KPI has reached its goal.
In the bottom right, you can the KPI trend. This KPI shows an upward trend. Once again, you can
choose colors to indicate whether the trend is good or bad.

In the bottom left, you see the date range for the KPI.
You can display KPI widgets in the user’s cockpit or inside an advanced dashboard.
SAP provides a large number of prebuilt KPIs but you can also design your own.
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Advanced Dashboard
▪

Supplementary, multipage dashboard
complements a pervasive
dashboard or KPI

▪

Built by selecting preexisting widgets:

▪

▪

Pervasive dashboards

▪

KPIs

▪

Count widgets

▪

Business partner info

Can be launched by user
from pervasive dashboard
or KPI
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You can create supplementary cockpits (called advanced dashboards) that allow a user to display data
related to a pervasive dashboard or a KPI. The advanced dashboard can have multiple pages and
provides quick access to multiple, related business analytics widgets.
The user launches an advanced dashboard from a pervasive dashboard or KPI widget in their cockpit.
In the example you can see the Customer 360 advanced dashboard, which is one of the predefined
advanced dashboards from SAP. This dashboard has 4 pages. Note: the Customer 360 dashboard is
hardcoded to be launched from an open business partner master data, and is NOT launched from a
pervasive dashboard or KPI.
The advanced dashboard is built by selecting pre-existing widgets:
•
Pervasive dashboards
•
KPIs
•
Count widgets, and
•
Business partner address and contact information
The dashboards and KPIs in your advanced dashboard can contain actions. Additionally you can add
filters to specific widgets to screen out unnecessary data.
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Crystal Reports Dashboards
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▪

Dashboards created in Crystal
Dashboard Designer support
multiple panes and multiple
data sources

▪

Can be based on SAP HANA
view or other data sources
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Crystal Reports dashboards are created in the Crystal Dashboard Designer. Crystal dashboards
support visual what-if analysis and multiple panes with multiple data sources.
A separate Crystal Designer license is needed. You can use other data sources in addition to the SAP
HANA views. The dashboards are created externally and need to be imported into SAP Business One.
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Authorizations for Viewing and Creating Dashboards
▪ To create dashboards or KPIs, you need authorization to:
▪ The Pervasive Analytics Designer tool, and
▪ The Semantic Layer or semantic layer view, plus
▪ The base query for the dashboard or KPI
▪ End users also need authorization:
▪ To view the content inside pervasive dashboards and
KPIs, users must have authorization for the objects
displayed.
▪ If a user does not have access to the query category for
the query or the view in the semantic layer behind the
dashboard, they will not be able to see data.
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Administration > System
Initialization > Authorizations
> General Authorizations
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Various authorizations are required to work with analytics. Generally the authorizations are found
under the Analytics subject area in the authorizations window.
To create dashboards or KPIs, you need authorization to:
• The Pervasive Analytics Designer tool, and
• The Semantic Layer or semantic layer view
Additionally you need authorization to the base query for the dashboard or KPI. Authorization to
queries are provided through categories in the Query Manager. For more information, see the Queries
course in this training.
To view the content inside pervasive dashboards and KPIs, users must have authorization for the
objects displayed. In addition, users need authorization to the query category or to the semantic layer
view, or they will not see data in the dashboard or KPI.
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Initializing SAP HANA Analytics
To use the analytical features in SAP
Business One, you need to deploy the
SAP HANA views (models) in the
company database:
•

Open the SAP Business One
Analytics Administration console
using the URL

•

Login with the B1SiteUser password

•

Initialize the company database. The
initialization will deploy the
predefined SAP HANA models for
Semantics Layers, allowing you to
work with KPIs, Pervasive
Dashboards, Interactive Analytics,
Crystal Report and SAP Lumira.

URLhttps://<Server>:40000/Enablement
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To use the analytical features in SAP Business One, you need to initialize the company database in the
SAP Business One Analytics Administration Console. This is normally done during the software
installation, in the post-installation activities. For more details, see the SAP Business One
Administrator’s Guide, version for SAP HANA.
You can access the console using the URL shown. You will be prompted to provide the B1SiteUser
password. In the console you can check whether the company is initialized for analytics.
The initialization will deploy the predefined SAP HANA models for Semantics Layers, allowing you to
work with KPIs, Pervasive Dashboards, Interactive Analytics, Crystal Report and SAP Lumira.
Note that 40000 is the default port number for all SAP Business One services.
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Analytics Reports
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Excel Report and Interactive Analysis Designer Add-In
Tools > Excel Report and Interactive Analysis Designer

▪

Excel Report and Interactive Analysis Designer is an add-in for Microsoft
Excel
▪ The add-in adds two tabs to the Microsoft Excel menu bar:
▪

Excel Report: users can build reports based on semantic layers

▪

Interactive Analysis: users can perform ad hoc pivot table analyses
based on the semantic layers

▪

Users can launch Microsoft Excel from Tools menu in the client, or can use
the Microsoft Windows Start menu

▪

Users need valid SAP Business One license and authorizations to the
semantic layer
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Excel Report and Interactive Analysis Designer add-in allows users to access the semantic layer using
a familiar tool - Microsoft Excel.
The add-in is automatically integrated into Microsoft Excel when you install the client component (see
the Administrator’s Guide for SAP HANA).
The add-in adds two tabs to the Microsoft Excel menu bar:
•
On the Excel Report tab, users can create reports intuitively, and in real-time, using the sematic
layer views
•
On the Interactive Analysis tab, users can use pivot tables to do ad hoc analysis on the semantic
layers.
Users can launch Microsoft Excel from the SAP Business One client using the Tools menu, and
thereby access the two tabs. Or they can use the Microsoft Windows Start menu. If they use the start
menu, they will need to login to the company database and enter the address of the SAP HANA
database server.
Important: All users need a valid SAP Business One license appropriate to the type of data they will
access, and they need authorizations in SAP Business One to the semantic layer.
To see prerequisites for Microsoft Excel, reference the how to guide “How to Work with Excel Report
and Interactive Analysis”.
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Excel Report Tool
▪

On this tab the user can
open pre-built reports
and create new reports
based on the semantic
layer views

▪

Typically these reports
are saved and run on a
regular basis

▪

Repository
management function to
save reports for reuse

Data Source

Measures and Dimensions

▪

Choose data source then
drag measures and
dimensions onto worksheet

▪

Add calculations,
parameters and time
functions to go in report

Steps for creating reports are documented in the how to guide “How to Work
with Excel Report and Interactive Analysis”.
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On the Excel Report tab, users can build new reports and charts. They can also open and edit the
existing, predefined analytical reports from SAP.
To open or create a report, first choose the data source. You can select from the deployed calculation
views in the semantic layer. When you choose a view, the measures and dimensions are shown and
you can select and drag measures and dimensions on to the worksheet. For the measure or
dimension, it is important to designate the report section as a row group, a column group, or a field.
You can also add calculations, parameters and time functions.
Using the repository management function, you can save the new report in one of the analytics
categories. Reports can be rerun from the Tools > Excel Report and Interactive Analysis menu in the
client.
Steps for creating reports are documented in the how to guide “How to Work with Excel Report and
Interactive Analysis”.

443

Interactive Analysis Tool
▪

Interactive analysis tab is
used for ad hoc
exploration and analysis
on the semantic views

▪

The analysis is performed
in using Microsoft Excel
pivot tables and standard
pivot table tools

▪

Save and manage pivot
tables using Repository
management

▪

Choose data source,
measures and dimensions
for pivot table

▪

Then use pivot table fields
for report

Steps for creating interactive analyses are
documented in the how to guide “How to
Work with Excel Report and Interactive
Analysis”.
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In contrast to the Excel tab, the Interactive Analysis tab is designed for ad hoc analyses on the
semantic layers. Users can create new pivot tables or open existing pivot tables.
For a new pivot table the user selects one of the pre-defined semantic layers as a data source. The
measures and dimensions for the selected view appear in the Pivot Table Fields for selection. You can
then use the standard pivot table commands.
The measures you choose will appear in the values box and the attributes will appear as row labels.
You can move an attribute field from the Row Label box to the Column Label box, and the data will
automatically adjust to the new format. You can select fields to use a filter, either by dragging a field to
the Report Filter box or by using the filter function of MS Excel pivot tables.
Steps for creating interactive analyses are documented in the how to guide “How to Work with Excel
Report and Interactive Analysis”.
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Analytical Portal
URLhttps://<Server>:40000/Portal
▪

Publishes reports to users in a web
browser

▪

Supported by modern web browsers

▪

User needs an account on SAP
Business One

▪

Uses SAML to authenticate the user –
user logs in with account credentials

▪

For each user, the portal shows only
the reports they have authorization to
run

▪

User can: run and export reports, set
reports as favorites, schedule and
distribute reports, download report
output and view report running history
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The Analytical Portal publishes reports to users in real time through a web browser.
Reports developed in Crystal Reports and in the Excel Report and Interactive Analysis Designer are
available, as well as pre-defined analytical reports from SAP.
It is most useful for users on the move who do not have the SAP Business One client or Microsoft
Excel on their device. All users still need a user account on SAP Business One.
Users can access the portal using modern web browsers such as Microsoft Edge, Google Chrome,
Firefox and Safari. Microsoft Internet Explorer is not supported.
When a user accesses the portal using the URL shown in the slide, they are redirected using SAML to
login to the company using their user account credentials. Users can use single sign-on (SSO) if that is
set up.
From the portal a user can:
• Run a Crystal report or Excel report
• Export the report to PDF, HTML or Microsoft Excel
• Set reports as favorites so they display on a separate Favorites tab
• Schedule reports to run automatically
• Distribute reports via email
• Download report results to a local machine
• View the running history for reports that they have run
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Report Availability on the Analytical Portal
▪

Excel Report and Interactive Analysis reports are available after being saved in SAP Business One

▪

Crystal reports are available after being imported as *.rpt files using the Report and Layout Manager

▪

Each user sees only reports
for which they are
authorized

▪

See the General
Authorization topic for
details on report
authorizations
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New reports are made available in the portal as follows:
•
Reports created in the Excel Report and Interactive Analysis designer are available in the portal
after being saved to SAP Business One. Anyone with authorization for these reports can view
them in the Analytic Portal.
•
Reports created in Crystal Designer need to be imported into SAP Business One as *.rpt files
using the Report and Layout Manager. Then authorized users can view these reports in the
Analytic Portal.
Each user only sees the reports for which they are authorized. The user must additionally have
authorization to the objects and semantic views contained in the reports. See the General
Authorizations topic for information on report authorizations.
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Authorizations for Imported Reports

Set Authorization button
allows you to set the
authorization when you
import a new report
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When you import a report using the Report and Layout Manager, you can set the authorization by
choosing the Set Authorization button. This opens the Authorizations window where you can select the
authorization for the report.
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Creating a Pervasive Dashboard

448

Creating a Pervasive Dashboard

© 2018 SAP SE or an SAP affiliate company. All rights reserved. ǀ PUBLIC

449

In this section, you will see the steps to create a pervasive dashboard with three actions to:
•
Perform an enterprise search for customer information
•
Open a business partner master
•
Open the Customer 360 advanced dashboard

449

Pervasive Analytics Designer

The Pervasive Analytics
Designer is the common
tool for creating pervasive
dashboards, key
performance indicators
(KPIs) and advanced
dashboards.
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The Pervasive Analytics Designer is the common tool for creating pervasive dashboards, key
performance indicators, and advanced dashboards.
To access the tool, choose the icon in the icon toolbar in the SAP Business One client.
Note: authorizations are required both to the Pervasive Analytics Designer and to the view data.
To create a new pervasive dashboard, choose New Dashboard.
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Select the Data Source

The first step is to select the base
data source.
You can open a list of available
sources by choosing the Select Base
Data Source icon.

When you click on a data source,
the definition of the data source
and its results appear.
Choose OK to select it.

© 2018 SAP SE or an SAP affiliate company. All rights reserved. ǀ PUBLIC

451

The first step to select the base data source.
You can open a list of available data sources by choosing the Select Base Data Source icon.
Data sources for user-created pervasive dashboards can be user-defined queries or semantic layer
calculation views.
When you choose a data source, the definition of the data source appears with its results.
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Choose Measures and Dimensions

▪ The measures and dimensions of the data
source appear.
▪ Drag measures and dimensions to the target
area for your dashboard.
▪ For measures, select a calculation method:
Sum, Average, or Original.
▪ Sort the data of the measures: ascending or
descending
▪ Drag dimensions up or down to change their
display order.
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The measures and dimensions from the data source appear on the Basic Settings tab. We choose
which measures and dimensions to use for the dashboard and drag them to the target area.
In our example, we drag the potential sales amount to the target measures area and drag the BP Code
to the target dimensions area. For measures, we have the option to select a calculation method: Sum,
Average, or Original. In our example, we will use Sum.
You can sort the data of the measure by ascending or descending. If you have multiple dimensions,
you can drag the dimensions up or down to change their display order.
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Choose Chart Type

▪ The next step is to choose a
chart type that will represent data
well for this dashboard
▪ As you choose the measures and
dimensions, a chart appears on
the right of the Basic Settings
tab.
▪ Use the dropdown to change the
chart type for the best display for
your data.
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The next step on the Basic Settings tab is to choose a chart type that represent data well for this
dashboard.
As you choose the measures and dimensions, a chart will appear on the right side of the Basic Settings
tab.
You can use the dropdown to change the chart type. In our example we will use a pie chart.
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Strategy Type

▪ Strategy Types allow you to do further analysis on your chart.
▪ Examples of Strategy Types:
▪ Forecasts
(for date dimensions)
▪ ABC Analysis
▪ K-means Clustering
▪ Use the dropdown menu to
add a Strategy Type
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The Strategy Type option allows you to use an algorithm to do further analysis on your chart. We will
not use this option in our example.
Examples of strategy types are:
•
Forecast (only for charts with date dimensions)
•
ABC Analysis
•
K-means Clustering
Use the dropdown menu to choose a Strategy Type.
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Limit Results

Using the Limit to Top bar, you can set
the number of results to show between 5
and 300 top values.
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Another useful option on the Basic Settings tab is the ability to limit the number of results shown.
Using the Limit to Top bar, you can set the number of results to show between 5 and 300 top values.
In our examples, we will set the chart to display the top 5 business partners in terms of the number of
opportunities.
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Filters and Parameters

▪ In our business example, we will not use any filters
or parameters.
▪ However, if you wished to include them, you could
do so on the Filter and Parameter tab.
▪ To set up a filter, drag a dimension to the filter area
▪ A window appears where you can select a filtering
value or range.
▪ To set up a parameter, just drag a dimension over
to the parameter area, then specify the default
value.
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In our business example, we will not use any filters or parameters. However, if you wished to include
them, you could do so on the Filter and Parameter tab.
To set up a filter, drag a dimension to the filter area A window appears to edit the filter where you can
select a filtering value or range.
To set up a parameter, just drag a dimension over to the parameter area, then specify the default
value.
In the graphic, you can see what happens when the sales employee dimension is dragged into the filter
area. The Filter Editor opens to allow you to specify filter values.
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Save the dashboard and assign to the cockpit

Save the dashboard

Add the new dashboard to a cockpit

Save a copy of the dashboard
(Save As)
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Save the dashboard by using the checkmark. The checkmark with an arrow is for Save As.
You can reopen an existing dashboard for editing by choosing it from the list of dashboards.
Once the dashboard is saved, it can be added to a user’s cockpit.

457

Adding Actions to a Pervasive Dashboard
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Actions in Pervasive Dashboards
There are 3 possible actions you can add to a
dashboard:
▪

Open a specific window in SAP Business One

▪

Trigger the enterprise search

▪

Open an advanced dashboard

The list of actions appears when the user rightclicks on the data in a pervasive dashboard
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There are 3 possible actions you can add to a dashboard:
▪

Open a specific window in SAP Business One

▪

Trigger the enterprise search

▪

Open an advanced dashboard

The list of actions appears when the user right-clicks on the data in a pervasive dashboard.
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Action 1: Enterprise Search
To set up the action:
1. Choose the link for Actions.
2. Choose Actions to be Triggered.
3. Choose the radio button for
triggering an Enterprise Search

1
2

3

4. Give the action a name that will
appear in the context menu

4
5

5. Choose a dashboard dimension that
will supply the value for the search
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In our business example, we would like to add an action to launch an Enterprise Search to see all the
data associated with a customer whose data appears in the dashboard.
To the right of the chart, there is a link for adding actions. Click on the link to open the Action window.
Then choose Actions to be Triggered to open the Edit Action (Dashboard) window appears.
First we choose the radio button for triggering an Enterprise Search.
Then we give the action a name. This is the name a user will see for the action when it appears in the
context menu of the dashboard.
Lastly we choose the dimension from our dashboard chart that will supply the value to be used in the
search.
In our example, we have only one dimension, the customer dimension, in our chart, therefore we see
only one dashboard dimension checkbox available.
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Launching the Search Action

▪ A user can right-click on the chart and launch the Enterprise Search from a list of actions
▪ The customer code associated with that pie chart section is then passed into the Enterprise Search

C42000
45050
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When a user views the dashboard in their new role-based cockpit, they can right-click on the chart in
the dashboard and launch the Enterprise Search from a list of actions. The customer code associated
with that pie chart section is then passed into the Enterprise Search.
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Action 2: Open a window

▪

Choose the Action link

▪

Choose Actions to be Triggered to open
the Edit Action (Dashboard) window

▪

Choose the radio button:
Open SAP Business One window

▪

Give the action a name

▪

Choose the window to open
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In our example, we would also like to add an action to open a Business Partner Master window. We
want to be able to right-click a section of the pie chart and open the business partner master for that
customer.
Once again we open the Edit Action (Dashboard) window.
This time, we choose the radio button to open an SAP Business One window.
Then we give the action a name that will be used in the context menu.
Next we use the dropdown to choose the window we wish to open with the action. In our case we
choose the Business Partner Master Data window.
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Data Binding for an Action

▪ Data binding allows us to specify which
dimension’s value to pass to the window.
▪ We pass the value from the customer
dimension from the chart to the window.
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We need to set up data binding for the action. Data binding allows us to specify which dimension’s
value to pass to the window.
Because our dashboard displays the percentage of opportunities for each customer, the only
dimension with values we can pass is the customer dimension. The main field in the Business Partner
master is the Business Partner Code so we choose to pass that value from the chart to the window.
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Using the action in a cockpit

▪ When a user views the dashboard in the
cockpit, the action appears in the context
menu.

C42000
45050

▪ When the window opens, it displays the
master data for the customer chosen in
the chart.
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When a user views the dashboard in their new role-based cockpit, the action to open the window will
appear in a context menu when a user right-clicks on the graph section of the dashboard. When the
window opens, it displays the master data for the customer chosen in the chart.
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Launching Documents
Setting up an action to launch document windows
is the same as setting up an action for master data
windows.

The difference is that there can be many documents
for a business partner.
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We saw how to open a window for master data but we can open a window for documents as well.
Setting up an action to launch document windows is the same as setting up an action for master data
windows. The difference between these objects is that there can be many documents associated with
a particular business partner.
As you can see in the graphic on the right, we set up the data binding for the business partner field so
that when we launch the action, the business partner value is passed to the sales quotation document
window.
On the right we see the result of launching the action from a chart, the sales quotation window is
opened along with the List of Sales Quotations for the business partner value.
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Action 3: Open an Advanced Dashboard

The sales manager wants his team to
view a page with information for each
customer whose data appears on that
chart.

C42000
45050

We can do that by adding an
action to open an advanced
dashboard.
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The sales manager wants his team to be able to open up and view a page with additional information
for each customer whose data appears on that chart. We can do that by adding an action to open an
advanced dashboard.
An advanced dashboard is basically another set of pages you can open that contain additional
pervasive dashboards and key performance indicators. They are used to give additional insight behind
results found in a dashboard. For example, when the a sales person spots a customer who has a lot of
sales opportunities, she could choose to open an advanced dashboard with additional sales analysis
on that customer that could give her a keener insight on sales patterns for that customer and on top
selling items that she could promote to them.
The Customer 360 Advanced Dashboard is a predefined advanced dashboard. It contains 4 pages of
analytics focused on a specific customer. The pages include general, sales, logistics and receivables
information. It is also possible to design a custom advanced dashboard.
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Setting up an Advanced Dashboard action

1. Choose the radio button.

2
3

2. Give the action a name.
3. Specify which advanced
dashboard to launch.
4. Set up data binding to pass
the value to a filter used in the
advanced dashboard.

4

1
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Setting up the action to launch an advanced dashboard is very similar to setting up other actions.
Once again we choose the appropriate radio button. Then we give the action an appropriate name.
We specify which advanced dashboard we wish to launch. Creating and editing the advanced
dashboard is done elsewhere in the Pervasive Analytics Designer. In our example, we have already
created an advanced dashboard called Sales.
Then we set up data binding to pass the dimensional value to a filter that is used in the dashboard. In
this way, we can filter KPIs or pervasive dashboards in the advanced dashboard to show data related
only the customer we are interested in.
In our advanced dashboard, we have already set up a filter using the customer code field to narrow the
data displayed in the elements of the advanced dashboard. In the data binding area, we choose the
Business Partner Code dimension in our dashboard to pass the customer value into the Customer
Filter.
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Adding a Pervasive Dashboard to a Document
Sidebar

468

Displaying the Dashboard in a Document Sidebar
▪ The Link to B1 Window action will not appear in a
dashboard when it is used in a cockpit.
▪ The process for linking the dashboard to an object is
similar to the other actions.
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Imagine that the sales manager wants to see a dashboard that shows opportunity status for business
partners by using the sales opportunity analysis analytic view.
This can be done using an action to link the dashboard to the Business Partner Master window. The
process for linking the dashboard to an object is similar to the other actions.
Once again you choose the link to open the area where you create and manage actions. Then choose
the option to Display Dashboard in Sidebars. This will open a window where you define the action.
Unlike the other types of actions, this action will not appear in a context menu when the dashboard is
used in a cockpit.
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Create the Dashboard
▪ For our dashboard:
▪ Data Source:
Opportunity Win Rate Analysis
Calculation View
▪ 1 Measure:
▪ Number of Opportunities
(as a sum)
▪ 2 Dimensions:
▪ BP Code
▪ Opportunity Status
▪ Chart type: Column Chart
You must have a dimension in
common between the data source
and target window.
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We create the dashboard using the same process steps we used previously.
We choose the Opportunity Win Rate Analysis for the data source.
For the measure we choose the Number of Opportunities as a Sum, and we add 2 dimensions: the
BPCode and the Opportunity Status.
We set the chart type to a Column Chart.
Now we are ready to add the action to embed analytics in the Business Partner Master. Note that you
must have a dimension in common between the data source and the linked window.
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Create the Link

▪ Choose Option:
Display Dashboard in Sidebars
▪ Process is similar to other actions
▪ Radio button: Link to SAP Business
One Window
▪ Give name to action
▪ Select window where dashboard
should appear
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The next step is to add the action that creates the link.
The only difference is that you choose Display Dashboard in Sidebar.
Otherwise, the process is very similar to creating the actions we created previously.
▪

Select the Link to SAP B1 window radio button.

▪

Give a name to the action.

▪

Select the window where you want the dashboard to appear. In our example, the target window is
the Business Partner Master
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Data Binding

▪ Select the dimension that
corresponds to a field in the
target window.
▪ You can select more than one
dimension/field for the window.
▪ For our example, we choose the
BP Code from the data source
to map to the BP code in the
Business Partner Master
window.
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Next, we need to enter information for data binding.
We select the dimension that corresponds to a field in our target Business One window.
You can add additional data bindings to select more than one dimension and target field for the
window.
For our example, we choose the BP code from a list of available dimensions from our data source that
are listed in the dropdown in the data binding section. We map the BP code from our data source to
the BP Code field in the Business Partner Master window.
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Viewing Embedded Analytics
When we open a customer record, we see a filtered version of the analysis showing the number of
won, lost and open opportunities for that customer.
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After saving the dashboard, we will be able to view the embedded analysis in the Business Partner
master window.
When we open the Business Partner master for one of our customers, we will see a tab on the right of
the window allowing us to open analytics.
For each customer record, we see a filtered version of the analysis that shows the number of won, lost
and open opportunities for that particular customer.
To view embedded analytics, you must have selected the option in General Settings on the Display
tab: Enable sidebar in windows to display recommendations and linked dashboards
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Summary
Here are some key points to take away from this topic:
▪ The semantic layer is an abstraction layer in the SAP HANA database that contains views
(models) of operational data.
▪ Users can access and consume the views using:
•
•
•
•
•

Pervasive analytics dashboards
Key Performance Indicators(KPIs)
Advanced dashboards
Crystal dashboards
Excel Report and Interactive Analysis Designer

▪ Views include dimensions (descriptive data) and measures (quantifiable fields that can be calculated).
▪ The pervasive dashboard is built from a user-defined query or calculation view and shows a dimension
(such as business partner code) and a measure (such as total or quantity).
▪ You can add actions to a pervasive dashboard to open an SAP Business One window, trigger an enterprise
search, or open an advanced dashboard containing related analytics. Data binding is used to filter the data
in the opened window, the enterprise search or the advanced dashboard.
▪ An advanced dashboard can contain pervasive dashboards, KPIs, count widgets, and business partner
address and contact info
▪ The Analytical Portal enables users to access reports through a web browser.
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Here are some key points about this topic:
▪ The semantic layer is an abstraction layer in the SAP HANA database that contains views (models)
of operational data.
▪ Users can access and consume the views using:
• Pervasive analytics dashboards
• Key Performance Indicators (KPIs)
• Advanced dashboards
• Crystal dashboards
• Excel Report and Interactive Analysis Designer
▪ Views include dimensions (descriptive data) and measures (quantifiable fields that can be
calculated).
▪ The pervasive dashboard is built from a user-defined query or calculation view and shows a
dimension (such as business partner code) and a measure (such as total or quantity).
▪ You can add actions to a pervasive dashboard to open an SAP Business One window, trigger an
enterprise search, or open an advanced dashboard containing related analytics. Data binding is
used to filter the data in the opened window, the enterprise search or the advanced dashboard.
▪ An advanced dashboard can contain pervasive dashboards, KPIs, count widgets and business
partner address and contact information
▪ The Analytical Portal enables users to access reports through a web browser.
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Support:
Overview of Support Processes and Tools
SAP Business One Version 9.3

PUBLIC

▪ This course covers the processes and tools for supporting customers.

475

Objectives
Objectives:
▪

Know your support responsibilities to SAP and to the customer

▪

Follow the required process for handling and submitting a support incident to SAP
Support

▪

Describe the usage of the client-based tools and Remote Support Platform (RSP) for
supporting customers
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On completion of this course, you will be able to:
• Know your support responsibilities as a partner to SAP and to the customer
• Follow the required process for handling and submitting a support incident to SAP Support
• Describe the usage of the client-base tools and the Remote Support Platform (RSP) for supporting
customers
Note that this course does not provide instruction on installing and configuring RSP. Partners can find
installation and configuration information on PartnerEdge at:
https://partneredge.sap.com/content/partnerexp/en/products/business-one/support/rsp.html
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The first part of this agenda covers your responsibilities and obligations as a support partner.
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SAP Business One Maintenance Policy
http://sappartneredge.com > Products > SAP Business One > Support > Maintenance Services
The SAP Business One maintenance policy
outlines everything you need to know about
SAP Business One maintenance, including
examples and an overview of what is in and
out of scope:
▪ What can be expected from SAP
regarding maintenance services
▪ What SAP expects from SAP Business
One partners as a prerequisite and
obligation before requesting support
services
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As a support partner or support consultant you must adhere to the SAP Business One Maintenance
Policy. You can access the policy from the Support area of the PartnerEdge portal. Note: the
maintenance policy may be updated periodically by SAP.
The maintenance policy outlines your obligations as a partner support organization including:
▪
what can be expected from SAP regarding maintenance services
▪
what SAP expects from SAP Business One partners as a prerequisite and obligation before
requesting support services
Customers must pay for maintenance in order to receive support from SAP.
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SAP Business One Support Levels
Before logging an incident, check SAP Note 1167635 - L1&2 Obligations for SAP Business One Partners

•
•
•

Partner

Partner

Support L1

Support L2

Initial
troubleshooting
Search for known
issues
Forward to your
Level 2 support

•
•
•
•
•

Analyze the incident
Reproduce the issue
Isolate the issue to
SAP Business One
Propose a
workaround if
available
Create support
incident to SAP
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Support L3

•
•
•
•

Validate support
incident
Diagnose issue
Provide fix or
workaround
Create SAP Note
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The maintenance policy documents the process for working with SAP Support, including the support
levels:
• The partner is responsible for Level 1 and Level 2 support.
• SAP is only responsible for Level 3 support.
After the customer reports an incident to you, you must perform the tasks as outlined in SAP Note
1167635 L1&2 Obligations for SAP Business One Partners. This process is designed to help you and
ensure that you do not create an incident to report a problem that is already known and has a solution:
• Your initial troubleshooting should include searching all available SAP resources and
documentation to check whether a solution already exists (Level 1)
• If you cannot find a known solution, document the research you have done and the steps that led to
the issue, and forward the issue to your Level 2 support. We recommend you set a priority for this
incident now, according to the impact on the customer’s business. This helps you schedule your
support resources.
• In Level 2 support, analyze and reproduce the problem in your own environment, using the demo
database and the latest patch level. If possible, provide a workaround to the customer. If necessary
you must try to reproduce the problem using the customer database, and at the latest patch level of
the latest released version of the software.
• Isolate the issue to a defect in the SAP Business One software by filtering out external factors such
as third-party add-ons or other interfaces. Also ensure that no un-allowed modifications have been
made to the customer’s database (see SAP Note 896891).
At Level 3 support, SAP will validate the incident, analyze, and reproduce the incident, and if
necessary, with your help, will access the customer system or request the customer database to
diagnose the problem. SAP will provide a fix or workaround to get the customer working again. SAP
will document the problem and solution as an SAP Note to assist other partners.
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SAP Business One Incident Billing

Background
▪ SAP partners are required to
perform all Level 1 and Level
2 support for their customers.
▪ A partner’s non-compliance
with this will trigger SAP to
claim "Payment for nonStandard and/or other
Maintenance Services"

Documentation
and Information

Incident
Billing
▪ SAP will bill partners for the
Level 1 and 2 support that
SAP handles on behalf of
the partner.
▪ The partner will be billed on
a quarterly basis, at their
contracted rate.
▪ 5 incidents are free per
quarter
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▪ SAP Note 1167635
▪ Incident Billing for
SAP Business One
Overview
▪ FAQ – Incident
Billing for VAR
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If you do not conduct the Level 1 and Level 2 support tasks, then SAP Business One support will add
note 1167635 to the respective incident to indicate a partner has not fulfilled the required Level 1 and 2
support duties.
A partner’s non-compliance with this requirement will trigger SAP to claim "Payment for non-Standard
and/or other Maintenance Services" (incident billing).
SAP will bill partners for the Level 1 and 2 support that SAP handles on behalf of the partner. These
are incidents which contractually should be handled by the partner directly.
SAP Business One partners will be billed on a quarterly basis, at their contracted rate. Those with 5 or
fewer calls per quarter will not receive a bill for that quarter (i.e. 5 incidents are given for free.)
For documentation on Incident Billing, check:
•
SAP Note 1167635
•
Documentation on Incident Billing
•
FAQ
Press Ctrl+click to access the documentation links from the slide. Access to PartnerEdge is required.
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Preparing Your Customer For Support

As a partner you must provide
your new customer with the
following:
▪

Your support contact details

▪

An s-user account (for access to
SAP Notes)

▪

A link to product documentation

To ensure ongoing support for a
customer with SAP, you must also:
▪

Install and configure Remote Support
Platform (RSP) and submit the System
Status Report to SAP support

▪

Enter and maintain the customer system
data using the Support Launchpad

▪

Ensure a working Internet connection at
the customer’s site for remote support

▪

When you create an incident, upload the
System Status Report and the Health
Check results from RSP to SAP
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As part of your support obligations you must provide your new customer with:
•
Your support contact details (hotline number and support hours).
•
An s-user account so that the customer can access SAP Notes.
•
A link to product documentation on the help portal: http://help.sap.com/businessone
To ensure ongoing support for your customer, you must also:
• Install and setup the Remote Support Platform (RSP) software at the customer site, and run the
System Status Report which gets transmitted to SAP support and is required for the customer to be
eligible for SAP support. SAP Note 1733065
• Enter and maintain the customer’s system data using the Support Launchpad.
• Ensure a working Internet connection at the customer’s site for remote support.
• When you create an incident, upload the current System Status Report and the Health Check
results from RSP to SAP.
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Remote Support Platform
https://partneredge.sap.com/en/products/business-one/support/rsp.html
Customers:

Partner:

Real-time
monitoring of
customers’
installation
health

Create new
tasks using
RSP Studio

▪

Remote Support Platform
(RSP) is the primary
platform for proactively
monitoring the health of
your customer’s systems

▪

Partner also runs RSP
and gets a consolidated
view of all customer
systems

▪

RSP is built around tasks
that are scheduled and
distributed from SAP or
from a partner to the
customer

In-depth view of
own installation’s
health

Tasks

Distribution of
corrective tasks
and tasks for
patches and
upgrades

SAP support:

See SAP Note 1788954 for a full list of tasks
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As a partner you must install and activate Remote Support Platform (RSP) for each new customer
installation, as outlined in the Maintenance Contract for SAP Business One.
Remote Support Platform (RSP) is the primary platform for monitoring the health of your customer’s
systems and is provided with the SAP Business One software installation files. RSP can be
automatically installed with the SAP Business One Server, or can be installed independently. RSP is
automatically updated with automatic software upgrades so that it is always up-to-date.
The partner gets a consolidated view of all customer systems. This allows the partner to proactively
monitor all their customer systems.
RSP is built around the concept of tasks. The partner or SAP can distribute tasks to customers to fix
potential problems before they occur, or during support to transfer a customer database. As a partner
you must ensure that the customer has an internet-enabled data connection in place, which allows
communication of tasks between the customer, the partner and SAP for all support services.
The tasks may execute scripts on the database. To help ensure smooth implementation and usage of
RSP, SAP requires that your customers agree to share the following data:
• Installed hardware and software
• Business configuration and business scenarios
• Installed add-ons for SAP Business One and related information:
• Volume data of processed scenarios
• Additional data required for fast analysis and issue resolution
Any data that is transferred by a task is securely transmitted.
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System Status Report
▪

The System Status Report (SSR) provides a snapshot of the customer’s system

▪

SAP recommends generating and uploading the System Status Report regularly, and before logging an
incident

▪

Report can be used by
partner to proactively
diagnose and prevent
system issues

▪

SAP can identify and
predict issues and send
out healing tasks to
prevent these issues
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The System Status Report is one of the key tasks in RSP. The report provides a snapshot of the
customer’s system, hardware and database health. It enables the partner to proactively diagnose
system bottlenecks and prevent system issues, for example, disk space shortage, or no database
backup performed. The report can also be used by SAP to identify and predict potential issues, and
send out healing tasks to prevent these issues occurring.
SAP recommends you configure RSP to run the report, and upload the results to the partners and SAP
on a weekly basis.
When you create an incident using the Support Launchpad, you should also run and upload the
System Status Report, in order to avoid incident billing.
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Remote Support Platform Console
Partner view
(RSP Studio)
Partners see a consolidated view of all
customers and can drill-down to reports

Customer view
(RSP agent)

Customers see an overview of their
system health and can see tasks
scheduled by the partner and SAP
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Partners can see a consolidated view of all customers using the RSP Studio console. Once RSP is
installed and configured at a customer site, the customer will appear in the console view automatically
when the System Status Report is run.
Partners can drill-down to an overview of each customer, and to the actual system status report.
Partners can also search for the results of a specific task, and create and schedule new tasks for
customers, based on need. An example of a partner-created task might be to monitor an installed addon.
SAP provides templates to help partners to create new tasks.
Customers can view their overall status in the RSP agent console. The customer can also view tasks
sent by the partner or by SAP. Note that RSP can be configured to give the customer the option to
approve the running of a task. Alternately, it can be configured to approve and run tasks automatically.
Partners are able to view the customer’s console if they are authorized and have enabled remote
console support.
For more information on RSP, including how to install and configure it, see the Remote Support landing
page on PartnerEdge.
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Technical User in RSP

▪

For additional security, SAP uses a technical
s-user for transferring data to customer RSP
systems (for example, tasks and task results)

▪

The technical userid is similar to an s-user
and you can request it in the Support
Launchpad

▪

You must request a technical s-user for each
customer site and obtain it before you install
RSP at the customer site
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For additional security, SAP uses a technical s-user for communicating with customer RSP systems.
The technical userid is similar to an s-user and you can request it in the Support Launchpad.
The technical user is only used for data transfer purposes. A technical user is required for each
customer and you must request the technical user before you install RSP at the customer’s site. In
RSP you must activate the new user and supply the technical user credentials when you configure the
SAP channel in RSP setup. The technical user is also required to download tasks from SAP, and
upload task results to SAP.
Note: The partner who requests the technical s-user must have an s-user account with the
authorization Maintain SBO-Users.
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RSP Usage in Support Process
During Level 3 support processing for an incident, SAP may require an online meeting with your customer, or
may request transfer of the customer’s database to SAP support
▪

▪

Use remote connection wizard in RSP agent
to schedule an online meeting with SAP
support (GoToAssist tool is used)
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Upload a customer database to SAP support
using Content Upload task
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During Level 3 support processing for an incident, SAP may require an online meeting with your
customer. On the RSP agent at the customer site you can use the remote connection wizard to
schedule an online meeting with SAP support (the GoToAssist remote support tool is used by SAP). To
make the request in the wizard, enter the customer s-user and system number (make sure you do not
enter the technical user or partner s-user credentials).
During the support process it may be necessary to send the customer database to SAP support, and
you will use RSP to do this. SAP will send a Content Upload Request task to the customer’s RSP
system. This request contains the system number and the incident ticket number. With this information
you can securely use the Content Upload Wizard in the customer’s RSP console to select and transmit
the database. Alternately you can use the RSP agent of the partner test environment if the customer
database has been uploaded previously.
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The next part of this agenda introduces resources for finding solutions to customer-reported problems.

488

Level 1 Support – Information Resources

SAP Business One
Documentation

SAP Business One Notes

SAP Business One
Community
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After the customer reports a problem, the partner should perform an extensive search of the
information resources including:
•
Documentation which includes the on-line help, how-to guides and other technical documentation:
http://help.sap.com/businessone
•
SAP Business One Notes which contain known issues and solutions.
•
SAP Business One Community which allows you to post implementation-related questions and
get answers from other partners: https://www.sap.com/community.html
The SAP Community is a public space where both partners and customers can post questions, and
respond to questions posted by others, and receive points.
The Q&A area is especially useful if a partner has a consulting or implementation related question, for
example, how to write a query syntax, how to set up the system in a certain way, etc. Very likely
another partner will have the answer!
Note that SAP monitors the forum but does not actively answer questions.

The forum has in-built search capability to directly find posts using keywords, and also allows people to
blog.
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Embedded Support Tools
Help > Support Desk
Under the Help menu in the SAP Business
One client, you and your customer can find
several support tools:
▪ Report a Problem: allows customers to
record and share a problem
encountered in the client
▪ Support Launchpad and Note
Search: provides a link to the Support
Launchpad where customers can report
incidents to you, research SAP Notes to
solve problems on their own, and
request licenses. The customer needs
an s-user to access the Support
Launchpad.
▪ Logger Settings: change logging level
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Under the Help menu in the SAP Business One client, you and your customer can find several support
tools:
• The Report a Problem tool allows customers to record and share a problem encountered in the
client.
•

The Support Launchpad and Note Search is a link to the Support Launchpad where customers can
report incidents to you, research SAP Notes to solve problems on their own, and request licenses.
The customer needs an s-user to access the Support Launchpad.

•

Logger Settings: Only partners, super users, and authorized regular users can access the Logger
Settings window. The log files provide useful information for troubleshooting incidents and SAP
Business One creates a new log file on every startup. Logging and tracing of events is done at the
business object level and the system level. During support processing, you may be asked by SAP
support to enable logging or change the verbosity of the logging level. Note: The information at the
business level in the logger settings window is the information displayed to users in the System
Messages Log at the bottom of the client screen.

For more information on logging, refer to the how-to guide How to Work with Logging and Tracing in
SAP Business One.
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Support Launchpad for SAP Business One
For partners: Support Launchpad is main
interface to all support tools and
resources:

What are you looking
for? tiles to access
information resources
such as SAP Notes

▪

Use this direct link or access the
Support Launchpad from the support
page on PartnerEdge

▪

Contains tools for managing and
supporting customers

For customers: Support Launchpad
allows access to SAP Notes and to create
incidents from the client (Help > Support
Desk)

What would you like to
do? create incidents,
request licenses, manage
systems, etc.

Note: when a customer creates an
incident using the Support Launchpad, it
goes directly to the partner
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For support partners, the Support Launchpad for SAP Business One is your overall interface for all
support-related activities. It provides access to all the support resources using a single intuitive
interface:
▪

What are you looking for? Section contains tiles to access information resources such as SAP
Notes

▪

What would you like to do? Section contains tools for managing and supporting customers:
create incidents, request licenses, manage systems and users, etc.
Partners can access the Support Launchpad using the link provided in the slide or from the Support
page on the PartnerEdge portal.
For your customers, they can access the Support Launchpad from the client Help menu.
Note that customers only have access to a limited section of tiles, such as creating incidents and
searching SAP Notes. You should decide if you prefer customers to use the Support Launchpad to
create incidents, or if they should contact you by phone or some other way. When the customer
creates an incident using the Support Launchpad, the incident is sent to the partner queue on Support
Launchpad, and does NOT go to SAP.
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SAP Notes
▪ An SAP Note is a
solution to a known
problem
▪ To use SAP Notes, you
can enter the note
number (if known) or do
a keyword search
▪ You can limit the search
by a timeframe, version
or application
subcomponent
▪ Customers should be
given an s-user to
access SAP Notes
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An SAP Note is basically a solution to a known problem, packaged for partners and customers. To use
SAP Notes, you can enter the note number (if known) or do a keyword search.
You can limit the search by a timeframe, version or application subcomponent. To select a
subcomponent, deselects the checkbox for Application area and choose the + icon, then type SBO- in
the search box. You can then select from the displayed list.
Select the note in the results to see the entire note.
Customers should be given an s-user to access SAP Notes.
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Incident Recording Tool
Help > Support Desk > Report a Problem
▪

Easy to use recording tool
for partner and customer
use during troubleshooting

▪

Records a series of
screenshots for each step
that the user performs

▪

Recording is stored on
share drive and can be
uploaded to partner using
RSP
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The recording tool is a standalone application with no SAP Business One database or SAP Business
One Service dependency. Therefore, it can record issues even when there is no network or client
connectivity.
The tool is easy to use and can be used by customers. The recording is not a video but is a series of
screenshots captured for each step that the user performs (it is an extension of the Microsoft Windows
PSR recording tool).
The recording is saved to the share drive and can be sent to the partner using Remote Support
Platform (RSP).
The tool can also be used outside the SAP Business One client.
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Support User
▪ Predefined support user built into
SAP Business One
▪ Use to login to a customer system to
perform maintenance and support
without needing an additional
license
▪ Restrictions: The support user is
only available if RSP is activated
and an RSP system status report
has been submitted within the last 7
days
▪ All use of the support user account
is tracked and logged
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To diagnose problems on the customer’s system, you may need to access the customer’s system.
You can login with the predefined support user (Support). You can use this account to perform
maintenance and support duties without the need for a software license.
There are some restrictions on the use of this account. The system will not let you login unless the
Remote Support Platform (RSP) tool is activated and an RSP system status report has been submitted
within the last 7 days. RSP is covered later in this course.
All use of the support user account is tracked and logged.
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The next part of this agenda describes the Support Launchpad, which is your overall interface for all
support-related activities.
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Contacting SAP Business One Support
https://partneredge.sap.com/en/products/business-one/support/contact-support.html
There are two ways to contact SAP support on behalf of your customer:
1. Select the customer and create a customer incident in the support launchpad for SAP Business One
(preferred)
2. Dial the universal free-phone hotline number for your country from the SAP-B1-NOW country list
(exceptional circumstances)
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After you have isolated the issue to an SAP Business One defect, there are two ways to contact SAP
support on behalf of your customer:
1.
Select the customer and create a customer incident in the Support Launchpad for SAP Business
One. This is the preferred option.
2.
Dial the universal free-phone number by selecting your country from the SAP-B1-NOW country
list. Only use the support hotline to contact SAP Support in exceptional circumstances, such as if
customer incidents cannot be created or accessed. Hotlines are available Monday to Friday, with
partial coverage on Sundays from 07:30 – 16:30 CEST. A Duty Manager is available on
weekends for high-priority incidents outside normal support hours.
Before creating an incident, please ensure you have met the following prerequisites:
1. Search through available documentation in
2. Adhere to Level 1and Level 2 support obligations (SAP Note 1167635)
3. Install RSP and upload the latest system status report for the customer (SAP Note 1733065)
4. Include all relevant information in the incident
Note: If the customer creates a support incident using the Support Launchpad, it will be automatically
forwarded to you for Level 1 and 2 support. It does not go to SAP. If the customer reports the problem
directly to you by phone, you will create the support incident if you require Level 3 support from SAP.
When communicating with SAP support, English is the preferred language, and a local language is
provided only where available.
A product issue is dealt with by SAP Business One Product Support in accordance with the
maintenance agreement if:
•
There is an error in the software.
•
An error in the software causes subsequent errors.
•
Problems exist when implementing corrections (by implementing the SAP Business One Product
Support correction instructions).
•
Standard functions have incorrect documentation.
General consulting queries and how-to questions must NOT be reported as incidents.
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Incident Creation
When you create an incident you must complete each section of the
form:
▪ Contact Details. Verify or update your contact details
▪ System and Installation. Select the customer’s system (if the
customer has more than one installation)
▪ Classification. Select the priority of the incident. You must assign
a priority to the incident, based on the business impact of the
issue to be reported. Also you must enter the SBO component
(for example, SBO-MRP)
▪ Issue Description. Enter a short description, plus the expected
and actual results. You must also enter any keywords used to
search SAP Notes during Level 1 support
▪ Notes and Attachments. Add any screenshots and log files as
necessary
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Using Support Launchpad, you can create incidents for SAP. You can view and manage incidents
using various filter criteria.
When you create an incident for SAP, be sure to complete all sections of the form:
• Contact Details. Verify or update your contact details. Contact details entered in the master data for
the logged in S-User are automatically detected and selected
• System and Installation. Select the customer’s system (if the customer has more than one
installation)
• Classification. Select the priority of the incident. You must assign a priority to the incident, based on
the business impact of the issue to be reported. Also you must enter the SBO component (for
example, SBO-MRP). Selection of the component ensures the incident is routed to the correct
support department. You can enter the component manually, or enter SBO- to see the full list and
make a selection.
• Issue Description. Enter a short description, plus the expected and actual results. You must also
enter any keywords used to search SAP Notes during Level 1 support.
• Notes and Attachments. Add any screenshots and log files as necessary.
After you have sent the incident to SAP, you should check the incident regularly as SAP may request
additional information from you.
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SAP Business One – Incident Priorities
SAP Note 795206 contains a full definition of the priorities and instructions for proceeding with a very high
priority incident.

Very High

High

The problem has very serious consequences for business transactions, resulting in serious
losses with high business impact.

Business transactions are seriously affected and necessary tasks cannot be performed.
The problem affects functions in the SAP software that are necessary for business
transactions and seriously disrupt parts of the productive business flow.

Medium

Normal business transactions are affected by the problem. The problem causes incorrect or
inoperable functions in the SAP system.

Low

There are few or no effects on normal business transactions. The problem affects functions
in the SAP system that are not required daily, or which are rarely used.
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Fundamentally, the priority of a incident reflects the impact that the issue has on the customer’s
business. To help you assign the correct priority, SAP provides these guidelines:
•

•

•
•

Only use "Very High" priority if the problem has very serious consequences for business
transactions, which could result in serious losses with high business impact. This is generally
caused by the following circumstances:
•
Absolute loss of a system
•
Malfunctions of central SAP software functions in the end user’s production system
•
Delays to a production startup or upgrade that is planned within the next three workdays
Use "High" priority if business transactions are seriously affected and necessary tasks cannot be
performed. The problem causes incorrect or inoperable functions in the SAP software that are
necessary for business transactions and tasks. The problem incident requires immediate
processing because the malfunction can seriously disrupt parts of the productive business flow.
Use "Medium" priority if normal business transactions are affected. The problem causes incorrect
or inoperable functions in the SAP system.
Use "Low“ priority if the problem causes few or no effects on normal business transactions. The
problem affects functions in the SAP system that are not required daily, or which are rarely used.

SAP Note 795206 contains a full definition of the priorities and instructions for proceeding with a very
high priority incident.
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Incident Priorities (Cont.)
*Note: if you select Very High as the
priority, you must provide a detailed
business impact

How would you classify these incidents?

Users cannot print
invoices created
earlier

Users cannot add
invoices to system

An invoice shows
the wrong G/L
account in the
Journal Entry

The system will not
allow a user to
change bill to
address in an
invoice

• Volume: How many documents or transactions are affected?
• Frequency: How often is the error occurring?
• Is there an event happening or about to happen that might affect the
frequency?
• Value: What is the cost/value of the transactions/documents affected?
• Workaround: Is there one?
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Very High*

High

Medium

Low
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When assessing the priority of a message, a partner can also consider the following factors to evaluate
the business impact to the customer:
• Volume: How many documents or transactions are affected?
• Frequency: How often is the error occurring?
• Is there any event happening or about to happen that might affect the frequency, such as end-ofyear processing or financial audits?
• Value: What is the cost/value of the transactions/documents affected?
• Workaround: Is there one?
In the examples shown above:
• If the customer cannot add invoices this severely impacts business operations
• If the customer can add the invoices but not print them, then the impact on business operations is
lower
• If the wrong account appears in an invoice, this is directly related to the G/L account determination
and a correction can be made with manual journal entries. The problem only affects one document.
• If the system will not allow an update to an invoice, the problem only affects one document and the
issue can be corrected by changing the master data, and the impact is restricted to one document
Note: If Very High is selected as the priority, you must enter the detailed business impact of the issue
in the incident:
1. How does the issue affect the day to day business of the customer and what are the consequences
for the customer?
2. How is the customer handling the situation currently?
3. How often is the process executed / how many transactions are affected?
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Incident Tracking Summary
Partner Fill in
further details and
sent to SAP
Support

Incident status : To Partner

Customer contacts
the partner/ logs an
incident

Solution
provided to
customer

Partner conducts
L1 & L2 Support

N

Need
L3
Support

Partner confirms
by clicking ‘Close
the Incident’

Incident
Forwarded to SAP

Y
Incident status : To SAP

Issue under SAP Support
investigation
Incident status : Partner Action

Partner provides further
information using ‘Reply
to SAP’

* PCC survey
Proposed solution resolves
the issue reported by Partner

Incident status : Partner Action

SAP contacts Partner for
additional information
Incident status : Proposed Solution

SAP provided solution to
reported incident
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The incident tracking process progresses from the customer to the partner to SAP support:
•
The customer contacts the partner with complete details regarding the issue.
•
The Partner does the initial analysis of the issue (Level 1). If the partner finds the solution (Level
2) the partner suggests the solution and the customer deploys the solution and confirms to the
partner that the solution delivered has been successful. SAP support is not involved in this
situation.
•
If the issue cannot be solved through documentation or SAP Notes available and after conducting
all the L1 and L2 tasks, the partner reports the issue to SAP Support using the Support
Launchpad for SAP Business One. If the customer created an original incident this can be
forwarded as long as the partner enters the analysis details, documentation search and approach
to researching the issue. The incident status is “To SAP”.
•
SAP will further investigate the issue and if needed may contact the partner for additional
information. The incident status will be “Partner Action.”
•
SAP generates a solution and/or creates an SAP Note for the problem. The solution to the issue
is sent back to partner via the incident reported. The incident status will be “Proposed Solution.”
•
The Partner confirms that the issue is resolved by applying the solution provided by SAP and
forwards the solution to the customer. The customer deploys the solution and confirms it with the
partner.
When a support incident is ‘CONFIRMED’ by the partner, he/she is prompted to complete a short
survey. Positive Call Closure (PCC) is a direct feedback channel to SAP, allowing customers to
express their satisfaction/dis-satisfaction regarding a particular customer incident. The goal of this
feedback is to improve SAP’s process for handling incidents.
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Key Points

Know your maintenance
policy obligations

Provide support
guidance and s-user to
customer

Research incident,
reproduce and isolate
(L1 and L2)

Support Launchpad
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Implement RSP – send
SSR
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Here are some key points to take away from this session:
• As a support consultant you need to know the SAP Business One Maintenance Policy and your
obligations. Support level 1 and 2 is provided by the partner, and SAP only gets involved at level 3
when there is a software defect in SAP Business One. SAP is only responsible for Level 3 support
after you have isolated the problem to the product itself. Incident billing may apply if you do not fulfil
your Level 1 and Level 2 obligations before contacting SAP.
• A new customer should be given an S-user, access to SAP Notes, and contact information for your
support department.
• It is an obligation to install and use Remote Support Platform (RSP) for customer installations as
outlined in the Maintenance Contract for SAP Business One. Once RSP has been installed and
activated, the first step is to send a system status report to SAP support.
• Before logging an incident with SAP support, you must research all available resources such as
documentation and SAP notes to check whether a solution already exists. You must also reproduce
the problem using the latest patch at both the customer’s version and the latest available version.
• Support Launchpad for SAP Business One is your main interface for supporting customers. You
can access documentation resources, SAP Notes, download software, maintain customer systems
and licenses, and create incidents.
• When you create a support incident to SAP, you must select a priority. The priority reflects the
impact that the problem has on the customer’s business operations. For example, you should only
use "Very High" priority if the problem has very serious consequences for business transactions,
resulting in serious losses with high business impact.
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